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N TR AL R AT

WARAEHTE N, WRTLMER] SFC B s SFC 2888, Ibiny, AR n] 5 524 A A S )
e THEAT DRAE -

AR EHRSE?

TP P T 2R G SEVERE 2B SRR A IR A AN IESE . e T ERAT I, JFiE—
AT T AR, Bl

* JHBNHEHL

* JTIFI

M—AD R — AP Rd Rl I C o KRB RE A R A e, il
o mECILE

LINNAIVE

N
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4 R MHERE 2
W7 R Py ol A LR A TR, e TR Bl A 15 Uy, 5
o RPN
L S CRERci IR g
o HHIRALEEH T

FEMIFERE 1) )8 B 26 AF AR E R AT IR R P (RS s o IR e A B B
FRI TR 20 B o

WP R g R DA AR . RIS P E B E RS, Rk By
FERIRGA TR, RIFIRALBNERE T (44 RUN =TRUE) .

R P42 il ZR 4 P AE AT 4k 2

42 ) 2R 6 ) LR 7 ] S AR AL A I ER R R Ge s al ) T T
YRR, i, 3E47.

o JHBINISC AR

o TR

o AR DIHCRGS

FLME R T RGP R 4t -

o BEEHIL (Bl FTITHECE RS AL

o PEHIZ (Bl sERLEL B IASCE S0RD
o ALY (Pldn. BE. BEREAS . UERCRE BUH VAR
o 1) % GRRILHILIBHE (Bln T ZE) WFRD)

SFC W& IHIHERT A 22 b, i AE LIRAK AT RER ZEHITE, Bril SFC JAE 1
N ER AR ot R v/

PR
SFC %t a2 HI TG AR A5 R S8 i) T -
FEASCR AR B R SORESFC I DUIRACIEIAR . R Sl sl 445 o
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NRE T

3.1 SFC T1EJRE Mk

THERH

SFC E#

SIMATIC S7 ) SFC

1. WTLAE SFC s A A B TR AP FEHI R S8, A 2 MUK SFC iocs

NN RE P b o Jo i FRUE W WA B i BRI IO TR B, R e S 4L
BeART5 1

ARG TR R R MR 5, ke SFC. SR DA 1

g JEE, IR E AN R . 4135 T 14T
- SFC M TAFZ

— W RE Y IR s AT

- DEhfE

- HR R RS

SR R, ] SFC i i il AT HLERACRS, SRS KL T EE] AS B, JfER] SFC

T Th REHEA T o

WRMAAME T SFC gfitds, Wihfse N SFC BRI IR, hitk, THE T R8T

o

QU A G PR BN R S
IR ) R GEAE AS Hhan e TAE
U AERNRAE R, AP P R g P A - P 4 (e R BT ED
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3.1 SFC L1FIR# L

SFC Z5HIF SFC =4

EZ P

22

—H TR T ] SFC KRR SCOUR BRI RS, R4 AEH] SFC MM SFC 5%
Blo R AT LAGA SE PO R4 AR G0 IR b S & TR EAE 55

SFC RIA SFC Sl I TR RSN H . A SFC BE&N, W LAE %
THRTAE, K4 SFC EZ W] LIS BN A SO FRE S EA T4 . T Bk

i SFC 28, fml DALIREAR (1 72 2 B S5 s B I E SR U4l R e, i BA SFC 26
ARl LZ AL -

bti)m, B SFC siifl, MEHGEM THRPEN s E, JF RS HEAR AL g,

N TR SFC SEBIRIEEA B NUATE, 2R T SFC RAARIER 1. rTLLY L
B LRSI F R A, B 2 R I H R N R B D SFC SR KHFAIL.

BE)e, giEREre, RILREE] AS IR SFC Sifil. X UK I SFC R4,

ARUETFEREZHEL, HSHEUFEH
A% SFC &3 (1t 23)

(i SFC PR (17 26)
Bk SFC 2 (5T 29)
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A1
3.2 G&# SFC X1

3.2 fIE SFC EHER MR
%D BRA P2 2 SFC k.

1. BTN H 41
£ SIMATIC Manager i 35 H 454, 7EML45 M 417s CFC/SFC K%

ARIETEEZER, 5%
AT G I 2544 (08 77) ¥

2. FREREM
] DU SO BB (CBRR. EARNERS) |, BEus T S 500 B A

W& EIZITSE, e )Pt 2T, e (Fahfas)) o P
HIREEL (T O. THIC %% LA EPATIEDN (JEMEEE. IR EE B3 E
g1 .

FERIR R E, AT AR ek 24216 3 OS (K2R ik 1t

ARETEEWEZEL, E2%
ap Tz R B PE (5T 101) #6823

3. BITEM:
SFC KX Mz T EtEds e 7E Hhn ARG EA S5/, 3k SFC B Wl ix A 2IFE 7 4b
B P2Ih. WTLAFE CFC 74wty & 1 B S0z AT )@

ARIETEEEZER, 2%
SFC iz A& (v 174) 7>

4. BIEEIRIEREFF

HAIE R SFC O fdE T — MRFEFAT (RUN). 1] DU PREESE PR 1 i % 1 It
PERE R B I b B ARy, 5 A SFC PR BOASRR b A2 I IUA AR o
ARIETEEZER, 2%

G S Z ALY (U 124) 55>
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3.2 B/#& SFC XM S

5. AXIMEFEF B M

PR NRERE S, W A R S 5 0F DL RPAC PR AR B s A Calide) ,
Rt &, LT 47 OS k.

ARETBMELHEL, ES%
QAT BN R P e P (0 146)

6. BIIRZREF KA b

£ SFC G i NI 4 A\ — > B2 SR P 120 A RS DL SRR 7 28 I 5 22 14
TR, MR ST 4L

ARETUEZER, 2%
Ap AT B RE 90 Fh 254 (00 123) 87>

7. AFL FENSBEHEITHEF)

il Eh . SE A B A AU b B8 IS R e A L s e
SFC & MEH .

ARETBEZER, 2%
Wt (U 148) &8>

8. WEHYB (FENZBHEXHEET)
THIE e R P R 2 A1 LA R R 21 & 30
— Je 110 VLR ik 8
— BATHEIE SFC BIFRKPRA (it Bahici) .
0 AL R BRI 4, WIEAT SFC IR — AN A8 A5 R B R4 4
PAT
ARLTEENEZER, 1§5%
W AR RS (U0 162) 34>
9. HiIFI THESF

FEG BT RSO, RGBT AT R (i g ey, Bl
Je ] LR IRy R 38 H s & 48 (CPU).

AREEEEZEL, WSH LU TR

G 1E P RN SR (T 255)

anfl R EFR R (UT 263)
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A1
3.2 G&# SFC X1

10. PIRFEFF

FEGR A N e, AT AR R s s 36 A o KA. (EH] SFC ikT)
E, AT LAE & Bl AR BN D 2 R N s AT P i R 4, I Hoal DURAUATE 2
CPU it IEATLLREN CPU F i & E A ERAEA (Biltn: STOP. KR/ AL
LA RUND

ARIETENEZER, 2%
M AIYT ] [ A B3 A2 (00 311) & 20

BiH

FEHEZHT (55 92) , XT CFC BRI AN, wAHIE SFC Bk SFC
S (SFC M) [AMBALIA .

ARIETEEEZER, 2%

SFC EZERAIAM B (5T 41) 585>

RANR R AT REN A B

e Y/E“SFC [, {fifsEHi4“SFC FE"(SFC Library) >“HLf1#4% " (Blocks+Templates)
>}t (Templates) 7] LLiJj ] “ChartStates”SFC . ZE&KCL 0 &L ETRE
AbFRNGT 4 ) R G MR o AT UAE 2% B R R FL R VR S

o UL B S A T ) NG 4 o R g B AR R G D R, WA AR
ANHATAAT B B RTER T gmict. T ORI “ChartStates”SFC K3 (a3 Bl i (1)
SFC E%) . Tl b SFC ER. XA, nILAAEMRRBL 8 FH vl FH
IR AR SFC R AL

o TRk SFC ERAE Hahtb KRG ab#A TP, AR5 SFC ERME 7T,
B, #EF“OB32 T4 . 76 SFC th, HEF3H M ir 4 IR (Debug) >“Mik &
B (Test Settings) Ji-7F Ik 1 B FP e 484538 1) W A0 307
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ALTHTH

3.3 t# SFC B/ s
3.3 Al SFC RAIMR
fej s

P&

26

IR IR IR 4175 SFC 2R

1. QT E 451

7E SIMATIC Manager 14255 [ £5#, W 7E 2125 CFC/SFC EF M SFC 2471,

ARETUNEZEL, H5%
AT BT H S5 44 (VT 77) 7890
E:

AT LAFEFE P ) SFC A,

2. iz SFC 1

7t SIMATIC Manager 4R EIH, 78R SO A —~ SFC R IUAE Kyt
%. 1% SFC MR A CFC HH H k.

¥oR: {E“SFC i, A HZE My 4 “SFC FEE"(SFC Library) >“H A1k

1" (Blocks+Templates) >“#4%"(Templates) 7] LLijj 1] “TypeStates’SFC 2%, 1%
SFC B A5 LR, XL oK H 1 1n) PR A AL BRI 42 1 R 4
BT LIk #“TypeCtriStrategy”SFC 2554, "B AL KGNk [ THI 1) 478 1 S5 s A L 11 Iy
BEHIRRRINIERET . ] DU X Seitk, e b T ok, fEA 3 Am=K.

ARETUNEZEE, H5%
125 SFC 2RI (WL 87)#B 73 (1de 7

3. Bk SFC @t

ATCL O B I (SRR 1EE . B4, FB 'S FIVER) , BEGEITS 5L H ik
A o

W REEITSH, WIRRPER RS NAT N, e (Fafash) « P
HR (i, T Oy TH O) DUAH/EHATIETT (I, AG3EAE. IR ek
HEEE)

ARETHEEZEL, H2%
apfTE SR e PE (5T 103) 76 53
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A1

3.3 t)# SFC 2B/
4. flEEO
SFC EM Ok — MhrviERe 0, WH LU, LU T SFC Sz 5 A [ 5)
TR H3% .

W {E SFC 7ELE HE BN LR % 4 40 R 3 243 K.
SFC M bR [T (52 191)

T N TR (0T 201)

AR (7T 204).

5. Wik: ABIFME
R IE gmaE oS, X O3 T T2 ERHE gnas T, vl DUE SURFIE DL A
NP . WOE S PR el 2% .

ARIETESEZER, 2%
SFC KM PR (UL 110) 8 7>

6. BIEUEEF

STIF SFC M., BrfIEE (0 SFC DLl T—MIHAAUT (RUN). 1] BAfl b
S S TN L O R IR FR A, sl SFC e (oA A2 )
IR (SIMATIC Manager). i BASZHICEEHERT, IR 1 2L 75 35047 S B,

AREEEEZFEL, E2%
WA Z A EAET (0 124) 75>

7. AT R

P REMRERE I, W AR S 50 DL PAC B S AR BRI 2 A Calide)
it 5, L7 OS k.

ARIETEEEZER, 2%
U AT G B NI R Y e 1 (0 146)

8. RIEMIZREF K $H

£ SFC Z 454 P I 40 A\ AN B2 AN RE 7 128 AN A LA SRR 75 20 3E 22 1)
JLE, AT R ST 413

ARIETEEZER, 5%
A AeT G R 90 Fh 2548 (00 123) 57>

9. A (FE“%15:J8 M (Object Properties) SifHEF)
Hle S . shE S T SFC 2R B i N E B .

ARIETEEEZER, E2%
i gwAE 0 (U0 148) o
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ALTHTH

3.3 G & SFC B

10. AAHB (X% )8 " (Object Properties) XT1EHER)

TR AN SFC AL M4 H rh IS 1/O R Sbih AL i AR LR AR IR 2 1T
WTERAT SFC I K AP A 3 SR AT -

ARETBMELHEL, ES%
AT RS (0 162) 7870

11. fil#& SFC =4

ARIEESEZER, 2%
G SFC SEH (5L 29) k7

N
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A1
3.4 G/&# SFC SLHI1IEd

3.4 Al SFC S KMt

IR RN 4175 SFC 524l

1. #FTFF CFC BIE
FIIFPEAE b SFC sz HaE R A A Eh1L B CFC Bl %,
¥ CFC B H sk sFE i) SFC KA IR, i A pli—A SFC S24

ARIETEEEZER, E2%
i G SFC SEHB (5T 83)EE 7

2. 858 SFC 4Bt
76 CFC 1, MR Y SFC 92l 4 /@ i B . (CARRFIVERD

ARETEEEZEL, E2%
Ap Tz B PE (5T 105)#873

3. BB ITAESHMELHIETR
7t CFC ', #JF SFC A IF /e @ ¥ (Properties) XiFHE B TAESH. X462
HsE 7 AS HHIIIEATAT .
PR —ANIET, TLLIERER SFC M HE E M hil Sms o K ulk— 4N T SFC seil .

ARETEENEZEL, E2%
AR E S B E PE (5T 105)#873

4. 5yEZH0t HH&E SFC L6 # N

7£ CFC Pl X g @k, o £E SFC i HI*I/O™ 1 itk a5, A SFC L4731 S
.

f£ CFC , ¥ SFC SLl i A\ /it HIES] CFC Bty A/ ) sl 3L = a il b
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3.4 8 SFC SLPINIHESE
5 HiIFH TREST

30

FEG T RSP, RGBT AT P RE Y (G AR . R
Ja AT LR BERE Y R H AR R ZEH (CPU).

ARIETBEZFELE, EZH R & D

9 PE I RN SLTREIA (T 255)

Gpfl R (UL 263)

6. WA

FEGR AN N2 )5, T DA R e s e A R IARE . ATl aE, WA
FER BRSNS IR N ARSI B R e, JF Bl DU ALAME ot it
{H. EFTLLEZm CPU [ Z AR (4. STOP = RUND

AR EETEAFE L, 2%
S ) PR A B A% (O 311) 0o
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SFC E 5

4.1 STEP 7 33 T~ 1) SFC

HBIEE

SIMATIC Manager JI{1r A Hbs RGEMIETE A Friin, e FRBE T HRAx S, g
THAMEEE, JEH T eI M i H 45k (CPU. CFC/SFC &%) L33 SFC 2w’

WA

TNEIERT SFC i N+ STEP 7 Fil PCS 7 5%

SIMATIC Manager

PCS7

SIMATIC S7 1t SFC
G FEAIERAE T, 03/2009, ASE02113388-01

IAS

TH || EA [ | PO
CFC SFC
STEP 7 - Tool
STEP7

WinCC

SFC-
Visualization

|

L

2

31



SFC Z i
4.1 STEP 7 HE5 F iy SFC

B

a3 X

PH (Plant Hierarchy, T.)  |dFfE#HIRS: (PCS 7) K/
240

IEA (Import/Export
Assistant, A/ FHIIF
PO (Process Object View,
R R A ED

WinCC PCS 7 W fE i R4 (FEtA A T SFC I ¥k
R IR AL .
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SFC 72/
4.2 SFC A1) 52k

4.2 SFC f1T) B%

L BgHEH SFC
TJ 2% (PH ,Plant Hierarchy) foi//4% LA R ZIRUUHEZI A BRI R . AN EAIHE CPU
FIZATINA R, i IR BRI T EECT) e (Blan, HFweesisihl. bl
¥4l SFC K#£)
WK SFC BIRAMILE: T L 2 SCe, WL )22k M B A vs in 21 R 24 Rk o
U, RS H A ar DU IR i 4407 A S B 2 R

A
P SFC RALLHAT IR CNKE 206 AT AU BLI A B 50, FrAIANEERS SFC
RS L) R H k.

FEZEDS)
ATUAAE PH /RS B kBT T 2B E 2R .

4.3 SFC i ' HIr RS
SFC MIHEBIFE%

Ut 87 /19 SFC 3P KRS S7 HARRGMIRINGE R . A TRERAES TGO T
A XN A, S H AR R GETC I S b F T AN R] Y o 1) UM Dy E A H

o R laUR AR R
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SFC 25y

4.4 SFC 194 &R %)

4.4 SFC KA PR

SFC BB T HHAMH:
St dns
A~ SFC B2 (I A2 40 <8
A SFC I I A2 5 5 <32
FFANIE R 1 255 2-255
TABIE HTE A5 < 50
AN I A 5 1-255
TR R B4 45 <16

34
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SFC #47

4.5 SFC W #15) 55

4.5 SFC Hiff AT 6

4.5.1 47 SFC E%?

PRI Th At
SFC [ —FMF B RS, 3 Pl KA IR, o T ) PR X B
AR ERIAE 45, 7 BLZ L LB
Syt SFC BFEAT LR AN T P P A 53] SFC bR L.
WL 2R 0 4 W A E1 B BRI 5, T B RE T A

SFC CFC
\ /’/-V
-
// N

N TP RS, WA T IRAEEE SFC FINLEI L BAE AS IR T .

ARIETBEZER, I 2% U NS
AS H R B AR S (0 271)

Wit Fe 42 il R e i AT 4 (T 273)
RAEIRAS (0T 279)

SFC IM#AFIRASIZAE (1 280)
AT SFC (7T 292)
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SFC 25y

4.5 SFC 1t #1 )58

JBtE

=

36

SFC KR JE MG R oIeE:
o MR B INARR. 18 AR

o JUT AS MsiT54, XEMSHHHE T KIRA AS HINPATIEDL (Billn: AR,

DTS PATIETD

ARIETEBEZER, I S%B U NS
BRAER (T 274)

AR (T 275)
AT IETR (5L 277)
W45 i R G s A TAT A (T 273)

R AR E W LAfE OS kAT SFC EIRMERAE ¥ (R R RALIX F] OS JEAT AL
1k (Transfer chart to OS for visualization) &iEHE) . Kk, OS LFFE“SFC L L}

(RO
AL SFC R B @ PER I £t A 0B in s k.

SFC B Mbrife 10 & 7 s A, T R MESS
o {E AN R SFC IR
o FETABME AR i i SFC &R

£ SFC IR I AMBHLIE sl B 2R ) SFC EIRAZ .

ARIMNBREREZAE R, 5%
SFC RIS B (5T 41) 57>

Kk SFC BIERMEZEE, S HALT W)
SFC A ks L (UL 181) 77>

SFC |[E & b v+ F1H i A\t (D2 182)
1% 1132 73 2R 11 SFC R [ Am A i (7T 190)

SIMATIC S7 1) SFC
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SFC #47

WA 7

SFC k#!

SIMATIC S7 ) SFC

4.5 SFC W #15) 55

A PR 2 1 S5 s RO P42 T R B
SFC KR e Vrin 2 4135 8 MR, JHLUE B BITIRE (B Oy K EOMHERE") .

A RMEREFEZAE R, HSH U &R
H AR ? | (T 43)

2 & SFC 2EAYSFC 5l 2 | (5L 37)
Eb#2 SFC [EZ A SFC 2574 (1T 40)

4.5.2 f+4 R SFC 2KEI/SFC 541 ?

SFC R — MR TR S, WA R AR 7 X3 R s osE 7 X, 3
ThEEHE S S USRI B E WA TR KA o Bk, I SFC 2R nPR- 6 &
Gead SRR B, Sk e G ek, —Haldz s, WarblhEd M SFC
KM SFC S, HAE 1% SFC A,

SFC RS —MhrdEfL e 0, F R s AL T BUE R B8 Lo SFC 3E4T#461,
MEAZZIE 32 AT HE B RE AR CAREHERE) o P el Ly e
ZE I (E B KA S o SFC RN [ A, Bkl /E R SFC
SR 5 2 2 AL
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SFC 25y

4.5 SFC 1t #1 )58

SFC 5245

SFC 9B\ SFC A HRA M A, HIAG RAT ey SFC SRR PEARR] . 7l LAAE
CFC m SFC S AR5 i FeAti A7 B S 2 SFC 5. A /ER: SFC Sifil by 3eait A 5
MBI 5 T3 5 A BEhAT P P2 R 4

SFC 27 [———— | CFC 1 + SFC 524 1
CFC 2 + SFC =2 2

_+ﬁ E

SFC K#IF1 SFC Sz 18 it

38

SFC KRIAN SFC Sl i) J M A F A1 D Fliid PERE iR A2 B AN e . SFC SRR AT 2

P BB s e VR TRAFIRSILL A FB 5. X T SFC 28ALH1 SFC L4, Hyw]

TR T AS MigfT 24, REESH e AS TIIHATIOL (Bltn: BRAERE. PR hli
AEHATEID -

ARET TR R, W SH LR
BRAERIA (0T 274)

DI (I 275)

PATIETN (T 277)
I35 1 28 G R3s A4 A (0T 273)

R DL R M ik i 3535 2 SFC 2RI AN SFC S22 755 SIMATIC BATCH A%, DL
Jot R —A~ 52 sl Sems B T SFC 28k SFC sz, £ TR gk, nrldls SFC
KA N SFC S A 5 AT BRI ks .
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SFC #47

SIMATIC S7 ) SFC

4.5 SFC W #15) 55

f£ OS LATLIMEH] SFC sl (kA fE: “/2"(Yes)) , FrLAAILIE OS LAf#J1]“SFC ¥t
WA, X SFC Sl hAT #F G s WRAVEAE OS _EAE] SFC Sfil, I H 241
SEA] R0 5 S L R nT LU OCM?”(OCM possible) &2 EHE .

SFC SR brus D ilfE BB, W REf £ SFC Sl P i A/ i, 51
GAETFBE NI P T I SFC S ff 44 53 I 45 B 75 I B N T

I RPER TS R, IS LU E

SFC AR AR L (3T 191)

N TR SFC Sl 5 REA B UANE, T T 2y e SFC M. ik, W RAH
i) SFC SRAL 8L LA IET A A\ M, B0 B SFC SRR T ZURFAIE BTl (K15 A\ Vi
o BATHERE LI 5

AREOME AL, TSHLT

TG 1 Z 800 i (5T 202)

TR TR (0T 204)

i N R (T 201)

A PR A2 R 1) S5 s RO M P42 T R B

AR EZE R, WES%
2 MR 2 | (51 43)#6 5

N T AR RS, LAUT AL SFC HIFLHILL K EAE AS IR o
AT RAZERL T #8703 BE 22 A3 SR I 2 R

AS HH R AR 2 (T 271)

Wit PP A A Ie AT AT A (0 273)

RAPIRAR (W 279)

SFC AR S (UL 280)

AT SFC (71 292)
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SFC 25y

4.5 SFC 11t/ A1) 5E

453 th#: SFC ER 1 SFC K8

FE AL
SFC K# M SFC EALAAT AL FRFIL -
o bR, TSNS SFC (Fai/HB
o RFEREY, JHTHIE SFC HEHITh
=57

SFC K51 SFC KAAG LA T % 5+

SFC E#* SFC ##!

IERILIE ¥ NPT Mz U7 1) AR E Bk
HEe i —x A A2 AT

A DAAEA HhREA T8 B A AR AT B
B R BeIAT LAY R

2 ] LLAZS 8 M Fe 7 2 T DAL 32 AN FE 7
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SFC #47

454 SFC ER SN RILE

|

km
N

4.5 SFC W #15) 55

SFC KIZRIAMEHLIEILE CFC B SFC EZRF ik . AT 5 CFC Ptk
IRE R, SMBALEEAR 8T 47 “SFC K3"(SFC chart) Klfx [EE.

I SFC(1) (External view) - 57_1018_Prj\ii

SFC(4)

@— B0 AUT HAUTHAM EO
B— B0 MAN IODLE EOQ
B— B0 ETAHET STAETIMGE EO
B— B0 COMPLETE EUM EO
@— B0 HOLD COMPLETIN EOQ
B— B0 EESUME EEEOF_COM ED
@— ED REOET COMPLETED EO
@—EQ ETOP HOLDIMG EBO
B—ED EESTAET HELD ED
O— ED EEZET EEZUMIMG EO
1—E0Q EMETART EEFEOF EBO
@— B0 LOCKCOMPL HELD_EEEO ED
@—EQ LOCKHOLD EEZU_EEREDO EO
@— B0 LOCKABOET AREORTINMG EO
@— B0 LOCEETOP AEORETED EO
@— B0 LOCKEEROE STOPPIMG EO
1—|EQ ECT STOFFPED EOQ
@— B0 ZCT_TAC QEXT _EEE EO
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T, AR, AEEFRICR AL RS 16 74T

W S s 2 AL 2D sk B, WATLUE B T HRR, Boniw® 16 Mm%
50 AR .

1E SFC H b, ¥t RSl A MITIAL BE LA L Jo AL BE ¥ R 23 IC S 40, mT BLYjTR) SFC
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REFRRIZ L)

AR — RN 77 g LHiEA) -

ey CFC YUl WIS Bel # 3L = B s kA, -
Setpoint temp:=100
XYZ.pump.on :=TRUE

o JHJHEZAH] SFC sizAT4l, it
SFC_1.INTONOFF := TRUE
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W)
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5.1 ¥ F SFC 44a 5%

SFC 4riaas
{fH SFC Zwiss KL T R e aERUDAERES A, DL P iH R4 . SFC 1t
ZAR ] e B BCE AR RE P . i R W W A B W IR LS TR S
N B AASRE AT,
PL— RN FUE R M GNP 2 5, " RARSEZ1 2 SFC. fsfe) . DRIEE
BringEtt. 4l SFC ME TS5, SRR 1A 84 AF LT I B/ E R L 1) 20 A

e P
A2 IR, (1] SFC HEEMHIATHLAES, KL 45 CPU, JHEI SFC Mishfigs
EHAFRIL.

5.2 W jE5h SFC e gs

f&iIr
ATLAE B A CFC gniE#sakiii il SIMATIC Manager i f .
1#iT SIMATIC Manager J3 3
S EFT TR SFC B L B4R .
SFC Zmif#sts e 5, TR,
3BT Windows [ 5 3h:
PRSI X BTG SFC KR I Ebx.
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5.4 71 SFC 11341

5.4 7E SFC d &4

5.4.1 wfa e SFC H1 -2t
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AL LTS SFC th S
T EE R
o EFLIFHAMASZ—: “BLE"(View) >*45H"(Zoom) >“THK"(Zoom In)/“4E/N"(Zoom
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0
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R RE S,
AT LI L 7 2 K A
o EEHK
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TEN 2 7[R Y] e
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A SFC (EIREESEAD WM. T[4 SFCHTIFJLANE Ho HiI st i & -
KIS I TARE o IR TRA s A IR 2 W ] T 1
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PEIR B 2% WAL 55 T HIRAE B 3R AR R 7> 1R BEAT DI R FR B T
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WA SFC e KA A A5t o, W ESRAN TR TAE S b igs, AR & I
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1 PRI A 0 35 2 767 1 PR s A
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SH

TIF—A R
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SFC % H s A IR R SR E bR A 7. IRAE2 1547 SFC #TJF, A PR AF K= .41

I
= o

o WIREAGIIF SFC, MR s 23 gnis X A 11, FL3E Rt ¥ 3 o pR gkl DY A
(SFC. “MLE"(View). “EIF"(Options). “FEBs"(Help)) .

o WIREMDG A SFCHTIF, WA 4 i bR ) 58 BES FLA
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o AT LR g PE" (Properties) X iHAE

o LA LIAMNITIEAT B " (Properties) X i HE

TEAE R B bR R LUK A 3l b o e d RN D g
MR A (K AR AS,  SATAERR & 5 8 T n] AR iy R b BT -

UERAE B FR AT IE T A 1 B bR EIFHEAE DL, MBI L TR, IR
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A UAE S EREEALE B d8CE THARTEAE, MR8 % /2 Windows H—#f. A
IR ARG AR 2o, ARJE R R IEBh BIPT i L B BRSNS 282 A T T,
A NFEET R, HAARIAL B E .

AR TR ST TR E AL BT TAE XA, B B i 95 117 (Close) 44
A0S T A o

WGP T AP IeER:, Wn] i F 32 .y 2 “FR B (View) >“ TR £2"(Toolbar) 5“8t
&l"(View) >“7C &L (Element Bar) T B/t .

WREFALT SFC & L ML s, M1 B — 2 H 25 5
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PESEMATL IR > Bon i fE &, WOTR AT g . AN (B, Bon
CPU AR, JFHBIE S R (40t = STOP, £t =RUN) .
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o XA WiliP .
o H3): k#E SFC LR IHia):
o SHINKENG: L SFCILE, RJaiift Ctrl> JFitArEs)
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WA MBI T K2 BN TIRE. ARIETEEREZER, E% U N
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16 FETRRE B 2 S SRR i ) (3 B8)
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5.7.2 SR & P
SER A 4 i bR
S <Alt> BRI A 2 ok P 3 M i 4
P ITHF DT i
o <Alt>
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o TR BRATRPA FRIZLINFRE (B, <Alt+S> W] i FH“SFC™S 5 - dn sg sk,

SFCE)

AT

o TR AL TR T RIS RE (B, <N> RRSEHRAar 28 E"(New))

RPN K ) i 230 FUE T,
SRR T BEE$E T 58 IS i 2o

RATIPR e e, R L B, HEE

BNREER ) I — DN PR R, B aPITiiam 2.
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KB md PR
SFC > ##d (New) <Alt+S+N>
1ETH (Options) > HE X (Customize) | <Alt+O+C+C>
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S BRI

5.7 fEHIEH T 1F
5.7.3 SR A& PR G
S A& R R E R
HE AL SCHL Thie PREE G
T SFC QI — B R <Ctrl+N>
{177 FTITIE%R <Ctrl+O>
<M KK <Ctrl+F4>
(A G o P A S v B R <Ctrl+Alt+K>
— Pk
i 1F 2 T 1 e SCAR e R L 5 <Ctrl+B>
T FTENEIER <Ctrl+P>
B Y B SFC %dh et <Alt+F4>
GIR7)) G BIY) P 4 <Ctrl+X>
kil SHIPTIER S <Ctrl+C>
Fili <Ctrl+V>
R /B DT 0 5
IS T3 P 3z %) 4 <Del>
RO R Y BHID IR IR 5w 1 <Ctrl+Shift+C>
R0 5 e T TEA R PRI T HIIX % | <Ctrl+Shift+V>
Jm
ik R I P R 5 <Ctrl+A>
Ak % SFC i % <Ctrl+F>
K5 FIF B IE - Bl <Alt+Return>
(Properties — Step/Transition) %
THE
B, R s R Bk 38 4 IS R P S <Ctrl+PgDn>
Fr Nz
g, E— I BB 381 24 S R P T <Ctrl+PgUp>
Fr Nz R
AT T 247" (Run Sequence) | <Ctrl+F11>
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JH BRI

5.7 1/t 11F

66

H R FH ite REEE
Ve % Rt TF A I FER <Esc>
OBhr2e R #53k)

B+ R NG+ He R <Ctrl+1>
N SN

AT 33 h AT WP <Ctrl+2>
N SN

e S Spried IRl e <Ctrl+3>
CN Ry

(s HAE B <Ctrl+4>
AR

Bk h B O <Ctrl+5>
AR

SUAHE h SCAHER <Ctrl+6>
i A

R ( CPU ST Ip I % <Ctrl+L>
CPU

B fE L 7R CPU [FRR s <Ctrl+D>

HRAERIA WoRIE L CPU K <Ctrl+I>
TR

MR Wi S T S DU AR X <Ctrl+T>

(Debug)
HEA M bk E I AR TN <Ctrl+U>
(View)

EREEYS e Ll Jo BB 4 T ) <Ctrl+Shift+U>
WoR

O ON N TN PN <Ctrl+Num + *)>

A5T0 i /N /N s I RT <Ctrl+Num - *)>

818 RSE PLIEH RSF (100%) &R <Ctrl+Shift+N>

SIMATIC S7 [t SFC
Y PRI AR, 03/2009, A5E02113388-01




S BRI

SIMATIC S7 ) SFC

g FERIHEEVETIE, 03/2009, ASE02113388-01

5.7 fEHIEH T 1F
KAy S Thee REEGE
CS <F5>
WE - T~ (Settings, || 2E7 FIT4ii iy (Layout) X} ifHE <Ctrl+Alt+E>
Display) (Options)
SEGINERE FIIF B S %5 (Chart <Ctrl+Alt+R>
reference data)
ReEw IR TR <Ctrl+Alt+T>
Hel - B 7 H JA& <Shift+F5>
HEA1 - UK MBI -4 i <Shift+F2>
HEZ1 - o) A B4l <Shift+F3>
RSO i WA 2 BN B, A | <F1>
RIS A2, ARG 3 By
FRSHT . AR H %
e
*)*'Num +"/“Num ="~ e B E /s
67




JH BRI

5.7 1t/ 1.1F

5.7.4 Ao P B A AR BRI SR B A 3 O

st PR B A5 7 S BRI SiE BAAE v ) B
Thee REEE
F 5 B <F10>
P2 25t e <Shift+F10>
AL TR X ) <Alt+X>
FH
PR 2 S A Tl T RIZE

THF

e — R AT </ k>
FH— R <A k>
A S < k- #ik>
AR <F#Hik>
PO P S R <ENTER>
TRUT A P B i ] 38 S AR <Esc>
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S BRI

5.7 ft/ i 11F
5.7.5 A5t P R £ E o T A 0
A5 PSR BLAE X T AE P i T
Tk PREE
BN —A g A HE <Tab>

SIMATIC S7 ) SFC

FEMNZERAT . N EZ)R BT

B3 E—A G4 AE

<SHIFT+Tab>

Bah |~ —17 <Ctrl+ | i k>
%3] L—1T <Ctrl+ | #i3k>
ik <Ctrl+ /A= Fi >
NNk
AT D TR O A AT I B Mk . <Ctrl+4 i 3>
T N AT
HErp T EA BT GRS AT <Ctrl+%5->
N1 G IR R AR sh 444D <PAGE DOWN>
T G IR R P R B R AR 8 4444 <PAGE UP>
B R —ANEI R <Ctrl+PAGE
DOWN>

¥ah 2| E Ak

<Ctrl+PAGE Up>

B 5 — A Mk <Ctrl+Home>
Bl J Nk <Ctrl+End>
WG T 8 (B 1) OS VR <Ctrl+Alt+% 7>
B RS MR X g iRe <Alt+X>
TEEFEYIFR PR B ohs 7 S

TP — ALy <Alt+ R k>
HEPERI R FES IR P — AR5 <>

N AT R IR HE - (R 2" (OK) 424D <ENTER>
KPZXTUEHE, APRAF T 2 <Esc>

(“HLyH”(Cancel) 441D

g FERIHEEVETIE, 03/2009, ASE02113388-01
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JH BRI

5.7 1/t 1 1F

5.7.6 i F B AE SCA 3 I

fatt P AR AE SCA R
Thee REER
AT B SCAA AT AT I < I #ik>
o) ZER B — AT
N AT B SO LR AT I <F#Hik>
W A BT
o) AT <A k>
) 2e 1 — AT </r i k>
I AP — AT <Ctrl+ 47 & 3>
) fE i — AN <Ctrl+ /i k>
FTHIE K <Home>
TR <End>
B 1T <Page Up>
BN 11 <Page Down>
BT IT K <Ctrl+Home>
AR <Ctrl+End>

SIMATIC S7 [t SFC
70 G FL A ERAE T, 03/2009, ASE02113388-01




S BRI

5.7 (L84 1 1F
57.7 fE B ERFECA
ff AR A
Thee P gk
) A7 B — A1 <Shift+ 4 §73k>
W] e PE— A1 <Shift+ A %7 k>
) A7 EHE— A7 <Ctrl+Shift+47 %7 3k>
i) 23— A7 <Ctrl+Shift+ 7 i3k >
BT H LA SCAS <Shift+Home>
FUTRBISCAR <Shift+End>
] _b—4T7 <Shift+ [ 573>
) F—A7 <Shift+ F i k>
2 F—11 <Shift+Page Up>
'~ 11 <Shift+Page Down>
STk <Ctrl+Shift+Home>
B AR R <Ctrl+Shift+End>
5.7.8 AR T R A R
AR R SR A et g
o < [ik> ®EHINFH I E—/ SFC Jt &
o < NHEik> R H I — SFC JuE
o </efisk> BRI KRN A SFC L E&
o <fiHik> ERIT K IR AT SFC JtE&
SIMATIC S7 ) SFC
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JH BRI

5.7 1/t 1 1F

5.7.9 i AR B FT T 5 B

I D)

Zhee

REER

FTITH 8.

<F1>

WA AT LR 3G Bl — NGRS Ry
A, WA ) 4TI AN, K iosH
WiH .

5 4% B (Help) % 11 3% [0] 3]
SFC %t 2%

<Alt+F4>

5710  FXHAORX

R O X3
Thee REEGE
) b PR B 1 X3 <Page Up>
In) ¥R BN T X3 <Page Down>
) A PR B 1 X3 <Ctrl+Page Up>
) /e VR B e X3 <Ctrl+Page Down>
B 1 T <Ctrl+Home>
B 1 <Ctrl+End>
B 1 A0 % <Home>
B E AT %% <End>
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S BRI

5.8 Ml Zits
5.8 NN )
5.8.1 BRABR
BN E
(fd FH 3 5.4y 4 “XE T (Options) >“ B %€ X "(Customize) >“Biff..."(Colors...) T SEX LEER
WIKE) &
HPE R
CMSHID IR (] 4] YEN
LA SHUIN D IR (4 K] A
LSEIWL I [ R] F
TS HIE IR (4] )
LIRS [TTRE] ayah
CIEFIE IR (K] A
ACTIVE IR&HIP K] 3t
ACTIVE RZ&HID [ R !
EXECUTED R [X4] M 4 £
EXECUTED R&M [4475] H
HELD REIE [ 4] P
HELD R [4K] LR
ERROR RA&HIH X 4] AREN
ERROR IR [4H4K (0,
FALSE RS [ 4] AR GIEN
FALSE MRA& M [# K] I
TRUE R&MHF [X4] I &Rt
TRUE R [44F4K] A
Bl SRR KA
HERAIA AREN
TVEBE BN K E
A LE [ g
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JH BRI

5.8 Mgt
SCAHE [47K] CyEi)
INACTIVE ARA I [$14] ")
INACTIVE ARAHD [4 4] “)
INACTIVE IR IHF 4] )
INACTIVE R [44FK] **)
Windows BRIA K B :

CFESLT A B A S AT B2 “J@ " (Properties) > £.75"(Display) >“¥™
J&"(Extended) >“JT&: FrituE"(Element: Selected elements))
AN AR IETR 1D 1 5% e
*) Bt R IE PP B e AR, JF HJGE
) B S AR IERE R IS E A R, JF H G

SIMATIC S7 i1 SFC
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S BRI

5.9 SFC it i I % 75 17

5.9 SFC 4a#E 2%+ HIBHE & 10

5.9.1 SFC 4wl a8 SRS 10

SFC %4 KR %40
E. SFC 4itBa% kAT 1 BT A S8 AR S L B A, PRIIEAE SFC i A JL e IRAEIE T
A Ut oIk P I AN DR A R 5% AT Gt R 8 R BB AE SFC Gt HH 2B AT 1) B
AN T R PE AR s DR A . AEIZHEHE, T LG

LA, R SR ARSI . ZJE T AREIN R IH A . 3 m) B
A — R R A 413
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JH BRI

5.9 SFC it it 1 HIZH a5 17
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BRI H 451 6

6.1 A T B 451

Al ISR
1] SIMATIC Manager 75 H .  SIMATIC Manager H ) LA R %35 m] i -1 a1 H -

e PCS7 T
i) PCS 7 [ 3, T DLAE L) AL A4 ML G s o H s 2 I H o BRSERS
WHZ Ak, ZI0H S 8

e STEP7 &%
et I, ATELEIEERAT FAIJCE N STEP 7 T H -

SIMATIC 3k

- CPU
S7 ¥
ek
o CRIMA

i i 2, af LB B i AT 5 B 4L
BATVEPATEH PCS 7 MSHILHE CGHE1 D, BT ENR, BRI,
A LL{E SIMATIC Manager ', A HI=% 5.4 2“4 0" (Options) >“¥ &....."(Settings....) 7t
“I] F"(Wizards) &I~ L E“PCS 7 157" (PCS 7 Wizard) 5(“STEP 7 [n]'7"(STEP 7
Wizard).

/A PCS 7 [ FAI&DH
1. i Sy & SO (File) >“Hr & 1t H "(New Project) 191 % )1 5) PCS 7 15 (nR A
HEE3D .
2. IR T P BRI AT R A
PN K5 7 35 H A8 FWREE XS % 2 "(Which objects will be used in the project?)
1, “AS XI%"(AS Objects) HEH I BRIA T E & “SFC KEI3K"(SFC chart) L.

AR E A B Az, AT evf T PCS 7 (1) CPU R A ]

SIMATIC S7 1] SFC
S FEATER/E T, 03/2009, ASE02113388-01 77



BIEITH 5

6.1 Lt 6y I H 477

78
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. AFMEE SFC 7

7.1 . HAMEE SFC ik

37
7] LLZE SIMATIC Manager 1 SFC 2% A B i R AR AL, T et dnts,
PLA S E . HAEZE SIMATIC Manager H &2 I RIIN R &l & FIZE A, fEA5% CFC
2 A RN % S 451
SFC K& LALLM ETE R BostE CFC A, MimAe it CFC % H SFC.  AMiB
P SFC o AP ERE, e, HAaERA.

BlE SFC EBFF1 SFC BAY ) E Sk

SIMATIC S7 ) SFC

WA Ze4r SIMATIC Manager H @il gt 75 (1) T H 2544 (02 77) .

RSB AU I B R B R AR e e il — DN ERIA AR, DS AT DU S K. R e 1
B, RESRALUORE LSS AP CPU M — . ZrRCAFRIN T R L R
Tt .

® SFC BRI 2 il LM E 22 74T

® SFC RMWZ ML TS 16 Nyrt. RE W UERIEHRA 24 D74, HE)
S R SRV 16 ST

o MAIFRFRARER: "%./\

ARV FRASEB RS B, S H LT
T Al SFC EE (T 81)

il Al SFC BRI (77 82)
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LIE. HEHE SFC

7.1 /e, AEFEH SFC M

B SFC LI HIE K
ALLE L SFC 28R E SFC 5. A2 2 T 412K :
LA SEBIAE IR SFC SRR T2 S7 Ry iy IR SOk
FHEILR I A SR T HIER) CFC BR E4TTT.
AT 5 SFC RIYAAIR ) fir 44551, EXF T SEfil 28K, HAEMH 16 74T,

AREESLPINTEAE R, 5%
T Gt SFC S (5T 83)

A RAB RO TGS, HSHLU N
anfr iz R B P (5T 101)

B A s P (9 103)

e el e 1 (52 105)

HHIAF ) SFC EFK (7 96)
A5 SFC LM (1T 98)

S HIMFZ 5 SFC s (1T 98)

Wi R SFC KA SFC 2R (1L 99)
WiHer IER SFC 545l (L 99)
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. A REFE SFC

7.2 G SFC K%

7.2 fI% SFC E%

7.2.1 Al SFC BE

faifr
AIELH AT 775 B8 SFC R :
e {i SIMATIC Manager HJ*Z 1 HLEL “ ) R sl #n G
e {t SFC #itiash
#£ SIMATIC Manager H8z E %
1. £ SIMATIC Manager [“41" ¥t 2EREIH (SIMATIC 5. CPU. S7 #/%) Hil
LRSS
R AR T RGeS P B R S B b e 6 H A2
Gk
2. (AL LI T I B R SO AT e e G R 2 SR
3. i3 i 2“4 N\ (Insert) >“S7 ¥ {4"(S7 Software) > SFC ¥ [K 3 #fi A 51| & % S 5
RS
REGNERIRE— RN, Bl SFC(1), AT LA % 448K o
7. SFC g h Al E R

1.

e

7E SFC Wik Hifir 4 SFC >“Hr..."(New...).
BT I " (New) SHHHE

LEAHFHE PRI H (SIMATIC 3. CPU. S7 F%) FIEI& IRk,

R IR T RSO, WIAE T LR el e R Sl B rh e £ 0 H A
R

4. FEXZ AL (Object type) HEH ) fz 41| R HEH L FESFC”,
5.
6

TE“W % 4 5" (Object name) HE Fh i A\ & % 44 %

. R " (OK)

FATTFR &% (AR, BIARAD MBI .

SIMATIC S7 ) SFC
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I, A HEH SFC
7.3 i SFC FEZHFIG)# SFC 1)

7.3 fIl7 SFC KAIFI6))3E SFC L4

7.3.1 g SFC 287

fa A
ATLAH AR J7 kB8 8 i) SFC 2R 4.
e /£ SIMATIC Manager [1J“ZH 44" ¥
e 1 SFC gufidsrh

#£ SIMATIC Manager H g2 %!
1. 1£ SIMATIC Manager 1) 24430 & 4] TT B R S0 32 .
2. RS HAar A 4N (Insert) >“S7 2k 14"(S7 Software) >“SFC JE#I"(SFC Type).
SFC K MLK 4 N B S fEgerp

£ SFC iR as PRI KA

1. PS4 SFC >“HiE"(New).
AT T B 8 (New) X 1T HE .

AEXTRHE I E I H (SIMATIC 3. CPU. S7 FiF) MEE 5.
KT 577 (Object type) HEH )T H7 51| R AHE 1 iEFE“SFC A" (SFC type).
FE“X} % 4 Bk (Object name) HEH i A\ 2 44 7%

B E " (OK).
RHATIFHAT 1% SFC RAY I FAIRIRZ I — DMBHERE ) 1) ABrdd

a M w0 D

SIMATIC S7 {1 SFC
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GIE. &N EP SFC

7.3.2

fai g

SIMATIC S7 ) SFC

7.3 b SFC B FIg)# SFC %)

RY N RBIREBINL R, i1 SFC_Type(1), LIS AFR. F— 2K FB 54
H3Ih SFC AR, JHH AR (FB 247) HHI 2 G S MHSC . IXFemh
ARSI AT SRS, ALY B LUS AT LATE S G P 1 A
FB 5.

R SFC M, AS g i MIAT Pl (R Bofs KB 24 iR, 2 JRfE ES
BREH. USRI IZES,

PR
FEL) PLEF SFC REULIE D BLA R H AT, POVENTA S HHATER Oy Asift
ML REAER R -

g SFC SE4

KIS ] - Y SFC KA o R7E CFC ShH . AN BLss AR50, W
PR TP A7 B (All blocks) HsgERR S H A, & W EATH AT H & B (Other
blocks) HH.

LR (i, SFC JES TR Hda A ) (1) SFC A A 2] CFC K&

7 CFC 1, B H e M % Ky SFC 2RSS £ CFC &+

SFC S 3 LA CFC SEBIHARML. AR ¥EcAT AW I3 (R & SFC SEf], 2
BN B QRRKGHICP LA o Ke M sh 2B+ 2 WAL E S,
JRBYe RS N IR H

" LA#E CFC B3y SFC SEfl a4 /LS H L SOk AT iE
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LIE. HEHE SFC

7.4 & SFC F#

7.4 407 SFC B#

7.4.1 4% SFC ERMZEA IR

o
AFEmMEIR

84

7 SFC ™, HRARES FAT"SFC &R KM L SFC KA G R, SFC KR AT
il TE SCARE VR B S AR BT 75 A REAR 5 oK € SO IR St I 2RESm 1%
SFC K3, MR MBI IZER I B R L+

Ak SFC BRI Rgd T —MEH, 3O ifi M SFC BB (Pt @SFC_RTS)

TRAK bR AERE T, X275 SFC BRI M AbiR M SFC R i RAER. BTk

A PGB Prodn.

AR MR PR HERE ez . AR BRAER LI c R . W RAwEYIaA(E . T

R

AR, PR VO M 7 KBS 5 R R os 24 i sl ¥ S a 8 4641

TR, 38 n] AT SCA H%E

KIt, SFC R T LEMAN R4, JF H AR~k WRAEREL(IHiZ% SFC K

&, W% SFC BRI AT B, A8 & N A, KA Birfd HY il R4

T L AR T AT R

oA SFC BIRMEZIEAFE R, W2 il SFC KR (1L 23)#4r .

A LAYE" J@ P (Properties) i i HE A 152 & Bl 5T 2T 41 45 1 :

o WM (AFR. M. R OSTERD

® “AS iz17Z¥"(AS Operating Parameters) (ERIABE: “ " (Step control
mode). “BfFERiA"(Operating mode). “fy4#itt"(Command Output). “fiI 4
{£”(Cyclic operation). “BJ 8] I 4" (Time monitoring) A ahikmi: “H /A
#))"(Autostart). “SFC Ji sl i I BRN TA/EZ 40" (Use default operating parameters
when SFC starts))

® SFC E&AE OS Lt il (] - HEAT AT DA 42 (R A% 300

SIMATIC S7 1) SFC
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GIE. &N EP SFC

7.4 418 SFC K%

N T HEATIN AR A B RGP AT SFC KR, KAEIZAT BT i A SFC B3
ARIET B TEAE R, 2% BATIENE (50 174)#87) .

HE
A LATE SFC i #sh o SFC ERALE LT EMANNE (a4 SFC >“H
H.."(Message...)) . SFC KIRAGTHEMHILRTHWNE (&N EBREMIN, 5
— R MATED

AR B TEA{E B, 1527 SFC A1 (W 107)" 857 .

ALl SFC EIZRALZS T (nlik)
AR TR TENE R, 2255 U (0T 334)"#77

2. Bah. MEx
Al LL7E SIMATIC Manager 1421, #3hsuilfx SFC K%,
A BALE LR AR 23 b R 31 B 2 A R A A5 R
S AR 5)] SFC B3 (UL 96)
anfal IR SFC EZ T SFC 2EAY (1L 99)
SFC E&rH & rE (i, S7_m_c) CHULIRE.

ZRIFEAT &
FE G R P A 4 7 SFC B, SRJSAE" T3] CPU A i R iR .
A RAAE LU 823 P B B 2 AT R A A A R
e, SRARISC ] 2 PR AR (1T 255)
ot R (0T 263)
WK

7£ SFC MBI, ARGl SFC HIHATAIASAL, Al s Th BEXS %A T 52 i o
AR TR S, 1HS2% WK BB A SRS (0T B11)E87r.
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LIE. HEHE SFC

7.4 & SFC F#

7.4.2 SFC FRHTHASTFEK

i
ALATE SFC EIR T B duh s CPIERIT . B Hbx) sRASI PR . Rt
PETEERZ G, A SR
O T E, ATRARE N BORBEE IHERE e B s IR 7 I i 2845 ] SFC
K.
R B s R g T IEAE AR B SFC KR, thn] LUBEIN 3D RS 41 27 1 5
FEARNZE: SFC B H A S AP PR I7E RUN A5 Mo, XL i e
REFEHT T AP R 5 HEAT

i

FEME S G, B IFIE T OS, LAHLR OS a7 s i .
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LI, AEREPE SFC
7.5 418 SFC 5 F1 SFC L)

7.5 207 SFC 2£#IA SFC L4

7.5.1 SFC HZSHEY /S

SFC 2KAIF1 SFC SE5 ik

SFC V6.0 15| A\ T REYSEFIMES . ZBES I 5 AEFFRERNS QIR IXAE — L8y i Rk
W, ST ERON CFC BRI A i SFC 524l

SFC RAAG LT, HINREHIRIMIML, AU SFC KA CFC K3 H USRS
PP AASS IR S (FEREE DL SFC 928> o kAT SFC Si4l, SFC AL SFC
BIHHS N R A AL ARG

ARIEEB I TEAE R, 1i52% 44 SFC RM (1T 87)i 7).

7.5.2 4075 SFC K7

faifr
SFC [ 7 ff“SFC BRI R KA, HFSFC RKAX FHRM, SFC HKAAVFE X
AR E N KPR R S8 SFC 2RI 12 4 I T SFC RAMH 1 /0. 1K
Wt SFC RMTIEVT M TA R 5 M S P, #E1X— i b SFC BIRE 2 i x5+ .
SFC RE A S Hd

SFC kA5 SFC EFRXF N M#E . Apk SFC KA A%, ¢ SFC
R ERE 1, %3 @ N SFC RABR“@SFC_TYPETEMPLATE"(FB247) JR‘E 1M
Ko 1E SFC KA 1 ibfefit SFC R TyRE (il HAER. IB1PRE DI
&) I, Al AR R .

T DAFEAE 11 G 4 st 1) bR VS0 B8 22 A0S A A T AR L R s U TS I B 2
(RIFAE -

HE:  SFC B AN MR BRIy 800 4.

ARFFILE 25 R, W 2% TR AL 45 45 A D 944 (00 109) 873
TCVERS S s B bR AERE VB AL o3t . ATRUSE SR (e TR L
AT DURR A 7 20w aC R K e SR AT 3R A
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LIE. HEHE SFC

7.5 418 SFC 2570 H1 SFC 34

AXHB

AR

G iEI T

88

FEALZSIYIA],  HAEAE Al D i AR IE D o BC s 8 S R ah 4 fF . IR, 7 e el a1
B GR 2457 R RNt e AEIE, BT DAIEAT SCARHIE . PO S Tl 1 i
1TH) SFC FMIANEVTIn), BTLIX RS SFC AT 2RI,

A WRR BRI 2 SFC 2RALH T i

o TEEENRIERAER
PeFA: SFC A RMGRLAEE N, HINRKI el UZ1T, B2 KA THRRA)
SFC 2%,

o FENIHARIEAEHR
P i TR 2R AT A, DRI mT DASZ RS Aont SFC M HEAT ) & T
CiEE

ARETEPEZER, 2% WTag SFC KA (1T 26)#77

SFC RETALMBAT L, PO E ST MIATIC R, SFC BN REIH A B 17 Y
H.

ALk SFC KRB 25BN LA AR B H AN THE AR R . SFC JEAUA & 75 25
RIATHIE (BN ERAHE MR, SIMATIC BATCH 548 10 MIRAHED .

AR T TEANE B, 12750 SFC A1 R (W 107)"#855

LA EEAS SFC B & Il

ARIEE B VEAE R, 1527 U (T 334)" 73

FE G FERE P AT 4 5 SFC R, SRJSAE" T3] CPU A i3] CPU.
ARIEEBITEAEE, W SN

B RIS G FE IR (T 255)

T R ARAERY (U1 263)
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. A REFE SFC

7.5 418 SFC 5 F1 SFC L)

AR AT REN A B

o /E“SFC JE v, {fi I3k Hiav4“SFC FE"(SFC Library) >“5t + #1%"(Blocks+Templates)
>“WEHR"(Templates) nJ LL$k#“TypeStates”SFC K., ZEE O L& LML TIRE
Aab BRLF 42 1) 2R S8 IS RS o 38 T AR 21 G048 DA i1 SR g 3 ) b BRI 4 1) R 4
[1)“TypeCtriStrategy”SFC 2814, W] LU HiliX Lot , JFxf Hak T ok, A& H A
O KR

o {1l T SIMATIC BATCH 1) SFC AN, T Id Al T 4144 s

- 1E SFC A “JE@ ¥ (Properties) >“iz1T7Z4t AS"(Operating Parameters AS) ',
TEIEPE A E B, K SIMATIC BATCH [ff% il dr ¥ AR (i SFC
SR .

- {“JB " (Properties) >“#E1H"(Options) 1, Wi &“EOPE*EPH" S —, 75
SFC KM% SIMATIC BATCH {/34R“ASHa] ",

— WRANEAE ] SFC LA, ML B At ENASTART=1 il
SELFCOMP=0. 7E2 A Mil4% A5 7 1K) J5 8 45 N6 2015 1§ READY_TC Hi A\ /4 th
CFIFEEH] T SFC 5241
AREZAEE, W% SFC (KRS HEshER (5T 299)#57) -
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LIE. HEHE SFC

7.5 418 SFC 2570 H1 SFC 34

7.5.3

SFC AP HIHBTE KR

s SFC KA ER

Xf SFC BRI MBSO AL RIEIA S SFC SEfl. B e AR A ER 1/0 LA A 5
ORI W% SFC SRR T SFC S35 T AR FI B i AR 2030 1R 1 A H
SFC scfil, WA REAE AL RSN RUN #2501 M4k SFC M LSl MU REeHE
BAE BN R ZERI e, AE R EGE BUR BRAE S AIN R R sh Bl SeBIihAT S
DU TR RSB A 2 OCHR R 3&M)

i

A SIMATIC Manager Dfg“4n i Al N 8% %" (Compile and Download Objects)
17 Rk, JF AL ZERXT A5 H] SFC, W) SFC K AREHZEH . EXMIBN T, REKAS
PAT R, FESEHEP A —FERHE .

NI, ANREAE H AL RGP AL EE SFC Sii], AR CFC Hr ¥ BV In] SFC
Sl o

AILZER] SFC S RITT B iy 44 1/O AURFAL 2 B SO A PR Ao

75 SFC R P44t CEIERENUY . BbEE Hbn) ULED SR 4SS %
SRR T B A 2 A8 SFC L A%, T LLBE I £ S 5cbh 40 2 5 SR A A
Fro WA AR R b A B R, WA Z0HE B BT S AE HTi% SFC 5
file BIME HME RS HT IEAEAL P 1% SFC A SFC SEfl, tn] LLBEIN T 2onf 20 Ak
P AR B

WHASZIE, TEmPE OS LAtk OS & fof KA .

X} CFC 1 SFC S it

R T A SFC MY, i J& TR A L] L4 /E CFC R HTIT, A ZIAE 4 i A
PSR RO CFC LUK SFC et (] “YL " (View) >“BE#7"(Update) o F5) . ik
CFC REAEMGRE T, WA ZRAEIAT S0 2 AT IR iR

Xt SFC & SFC Szl i1 5% 1

90

WMARAH L SHA SFC KA, 1 HOLAE SFC AT I8 TR AU 8], I Hix Les )
AT, AE S %2R 2 BT 0B . BEAT SO PEAT R B

J5, WATHEE SFC S (i “AL " (View) >“BE#"(Update) 5t F5) . 5 Al HH

P
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GIE. &N EP SFC

7.5 418 SFC 5 F1 SFC L)

7.5.4 407 SFC 5249

fai g

AR A 2

I FHIR

SIMATIC S7 ) SFC

SFC 549l SFC JANRAE MK . SFC AL LIZRLT CFC i REHe A ) 2 di A 2
CFC K%+, [Nk, SFC LIk ar& NI HA CFC ER, i K %x G4k, SFC
S5 CFC sl R, JeLARifERBon; Wpt&it, 78 CFC Bl LUE B &A1)
s

i T H gt CFC B2 Xt SFC S dtAT -4k, Kk SIMATIC Manager A4 o
SFC 5245, ¥ CFC ERABE] L] JZHn, ook s SFC sEfl s mes) 1)

WITAE CFC B hicE SFC KA kA SFC 525, K CfFJe ) SFC K7 B RTE
CFCHVH W (Wi HA R AR5, WAL T“Brfa £ (Al blocks) #1251 3014k
W, R T e B (Other blocks) SCfF3H) o BRI LA CFC 3 (1 )2 Hddi A
SFC 2K/ (fllu1, SFC . FHIE) .

Al DL 2T CFC SEI ) 7 V4L &M E SFC 5241 .

{EJE SFC SEHff) CFC K, AR SFC 545l i) J7 ik M4k B CFC 5451 i) 7 2 AH TR o

SFC 54 iz 4T JE It &5 CFC RSBz AT & M 58 AR IR o

A LL{E SFC (fi Iz ¥idr 4 SFC >4 K..."(Message...)) #ll CFC (ffi 1“1 % &
P£”(Object Properties) X[ 1fHE) H1 24 SFC S

" LIfE CFC EIRH T IT SFC 545, SFC BEEIFTITIF Won s — MR . ol kit
PEREFP . AE SFC MR, RSP shsfe, nLIETE SFC KR AIH
(K37 SR AZARAT I 52 1
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LIE. HEHE SFC

7.5 418 SFC 2570 H1 SFC 34

il B3 MEx

A

92

A LI{E CFC ¥ 3&rh el CFC IR 2 [a ZHil/#5) SFC 4.

AILA7E SIMATIC Manager il CFC 2ty SFC 524, Sl ks CFC 1l )
M SFC =241

ARIEEBTEAEE, TSN
S HIAF ) SFC SEf] (7T 98)
i HER SFC SEH (1T 99)

5 SFC &HUAHLL, SFC *HF SFC sSEHI M ZSEIMBE N AR K SFC S A 42

Rz R A2 PLse 4 AR TR) 1 5 20O B 1 SFC 2R B s2 5145 72 19, BT LLIGTEX &

AT . (EE, W RARE SRR 8 S 8 1 110 480 (WIUREFANERS) &

TE“JE 1" (Properties) X i AE Fn] LAREAT R 4115 & :

o “Y¥H"(General) JETE (KPR, HE

o “AS iz17Z ¥ (AS operating parameters) (ERINEE G : “SEHIH R (Step control
mode). “EfFERiA"(Operating mode). “fy4#itt"(Command Output). “fiIF4E
{£”(Cyclic operation). “H[a] /5 #4"(Time monitoring) Al Ja k. “H)H
Z)"(Autostart). “SFC JH 2 FH BRA T/E S 40" (Use default operating parameters
when SFC starts)) .

o  TLIEAEMIE S T SIMATIC BATCH ke mi” (5], ARVFEERTES) 5 FESEaT L
Ji FH B FH At T S A1 11 L AL A4 il SR s

AU N ERAEAT E )R P (Properties) X G HE:

1. £ CFC ik SFC =4l .

2. FTIFBESE IFIE PR Ay 24T FF7(Open)
SFC szl RIZE SFC 14T F

3. kPS4 SFC >“EHE..."(Properties...)
“SFC 524 J& ¥ (Properties SFC Instance) XJ i HEBE I T IT .

SIMATIC S7 1) SFC
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LI, AEREPE SFC
7.5 418 SFC 5 F1 SFC L)

GIEI T8
FE G R P AT 4 B SFC Seil, SRJEAE" T3] CPU A o H R 28 CPU.
AR TEAE L, ATS% LU 7
G 1 301 0] A BRI BRI (DT 259)
e, SRARISC ] g PR EIR (T 255)
ol R (UT 263)
#m:

® W LI{E OS EAEHI"SFC AL B Ik, BAXE SFC sizfsl CRit SFC &) #EAT#k
PE . ErBHEH"SFC AL AT EE X SFC #AF S i FE )b B A1 D IR

1% SFC ML E 2 5 B, &% (S7 i SFC al#itk) (SFC Visualization for
S7) FHEk WIinCC 7E 2645 B if“ik 1" (Options) 3%

755 B SFC B A

Py
H1 ¥ SFC L@l A AL A IR, DRI AT LABEIN B 8 A SFC SeBil it AT AT S B,
B B 3h e R g8 4 AT IEAE AR B IX 22 SFC 54l

AT R

SEE G, I N OS, LItk OS v & 5 i .
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LIE. HEHE SFC

7.6 1771

7.6

7.6.1

i

AT 7+ SFC E&R B SFC %Y

7£ SIMATIC Manager il SFC Ziffi#s i #5 i LT JT SFC [ 5k SFC K7,

7E SFC w88 T JF SFC E & u SFC KA

1. £ SFC gf s ik $e5¢ Hiain & SFC >“TFF"(Open).

2. EFEITH (SIMATIC 3. CPU. S7 #Jv) & 24T IT SFC KI3km SFC KAL)
SRS

3. NERIEFSFCR RN, BRI FESFC KAL”,
4. FEXTUEHE R AT T 1 f ol BT T 0 B R B

5. HLi“ffiE"(OK).
4T IF4T SFC ¥R 8 SFC MK 1.,

B
“SFC™S KRR SEHIII TS (SFC RIS SFC A Sahsiiird. Wi
BTSSR A A A, IR SO 29T IT

7t SIMATIC Manager H'#] 7 SFC K& Ek SFC K24,

94

1. & SIMATIC Manager k#5352 “HL " (View) >“4H 41 E"(Component View),
SRJGATE ST Ry rh gk 5101 H A0 [ 2 Sk

2. JTIFEIER LA

3. iAW H Xt SFC K8 SFC K4,
SFC Zwffias i sh (WERFMAIRZN) , JFAE SFC Sifias i 1 iz EER s,

i H

WURI H A ECE 1) 2%, WER BLE SIMATIC Manager 1) 40 & sl i #5400 B
FIF SFC B, XFHEULT, FTIFHIEAE BRI 2 JC e i A & B 2R S0
SFC KA ELET) 2R, KWW T EMMIER, 5P IrEx.

SIMATIC S7 [ SFC
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. A REFE SFC

7.6 1771

7.6.2 Al 4T IF SFC 524

i
HATLUE CFC IR T JT SFC L4l

S&’
1. 7N CFC & ik SFC 924l

2. IEFE4nE(Edit) >“¥TFF"(Open) S H T4
SFC a5 m sl (I RILMAR S , IFAE SFC ks % b iz SFC S
BRI HASE SFC R kT

SIMATIC S7 () SFC
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LIE. HEHE SFC

7.7 X

7.7 =kl

7.71 SHIFM#3) SFC E*&

HHIMBhid

iif SIMATIC Manager & il 4, w] LURFIINGIE R 8 7 B Se B 5 A ) — A CPU &%
53— CPU, HEW LMEHA CPU AfLiX. WERMESCH RS —RE S, A5
AeFEKo

AMERT DU AN R, ] DU HLEAT B 5 B A T R A A BRSO e
W LIAE CPU Z M8k, “fE CPU Z IR/ 3 i oy o A& (45 EIE T T sl

1E.

£ CPU AR (FEBIRICAFIRA)
7£ CPU A B I R L 0L

96

UR RN BT KB, W) CFC EIERZIH & SFC 5 CFC &3 2 [H) ff) HIEANAZ
S ) R A

B AL BRAE — N BRSO P 2B ME— ), AT e it 2 B iy 44 S0 AT

il SFC RN 2R k% B LL T 5O

— Vil CFC Bl P RS HIB 1T SFC AR SFC H#A% 4 H¥ 4k 8205 il JR 4y
He.

— Vil A RS GEEFT S HR AT Sk KT SFC A SFC R A1 4k
By i) IXLE B

SIMATIC S7 1) SFC
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GIE. &N EP SFC

7.7 X

7 CPU 2 B B3
7t CPU Z a5 HlIF% sh i), w50 BA R 2T

Hi%E
PPN PEA T A M FEA SRR, BRARR RIS Ry BRSO AR
TR GEIEREY AT

B

AR Hbx CPU A T I BRI AR 5 AR 1 (48K B 170D, SINRAT = /A%
SHIIREN PR . D, AZE SR BIANSCHIM R H by CPU IS, IR
EATF AR H bR ER S CFC H.

f£55

HATHIFE A RS DRI R RIS . REARENA CPU LA HIF 4K
(K455 S b B BATAHR M@ YE . Wk H ks CPU _EAEAE BATHIR A4 R 55
MRS ERIELL . ERXFEOL N, BOASRAMFEAIIES. GeRHiR
REtie ST CPU, WIMESS 2 OB %5 5 & IEM AR B 0 ERE, JF HA
K

BIRAFR, BAHR
K CFC SRAAMRAE KR P2 ME—1Y), PTUAREEfEa . Hid, mRHEE
LESEE

LHIR2 5 SFC EIZR N k5] 25 18 1) F 35

Vi) A e Bt GRIEAFS5 2R AT S k) KTy SFC 1 fM SFC #eA% 2 A1 KV 1)
Hix CPU _EMAIFTEM . AKX L BHIEAE Hbs CPU _EAMEAE, efi14 A sl i
HIAHIE GEZH 30 .

ARIALIER AN E LR, HS% CFC U
A8 SO BE AT TAR R 23

SIMATIC S7 ) SFC
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LIE. HEHE SFC

7.7 X

7.7.2 HH|MBzh SFC KE

H | SFC 27

#3h SFC %A

55 SFC KAKIKAISAT I A R 24520 Y FB ¥ # L SFC 2B AL I [h]
B SFC RMAE BN, WIS — MR R HARSCIE A — A BAT S
EAMFAFRIN SFC RA, WIFERINE N 2 Ja Eaticini, I HIUAT R AT i 2 1k
#i > pefteidizy SFC siifl.

MBI A I SFC 2R SFC sizfilist, A nf LA 5N SFC 255, & SFC 25M%
ERIIEATIN REMN R W05, Wk Hbs SO h AP E— A B 52 R % FR I SFC
HKH, MEHIANE R G EasE R, I B R AT R 2 B A b AL 345 SFC
S

7.7.3 KBz SFC sLh1

faifr

| SFC L4

#3) SFC 41

98

SFC 9Bl A gl AT =MiEs: 74 CFC KRN . fEAF CFC KR H s
7t SIMATIC Manager Hitiid & il/#%5) CFC B M#EMBET. 76 SFC S5 2 il 5% 3)
I, L5 SFC SRR IS AT St b2 Bl st 5) .

I LAE > CFC &R siB 2R R S AR CFC Bz 18] & i SFC 54l
BERAEHA BRI W ] CFC B3R, I SFC skl btz 2. 5 SFC Sl Ik
BTGB R

UERAEA RSO 1) CFC &z 1) 521 SFC sizfil, sl R~ CFC IR il 21 5
—ANEER S, ) SFC B ok S

W ARAE R — BRSO CFC R 2 IaI#5 3 SFC 564, W SFC Sifilexbliz #3), KHk
s TR G R T oK

WRAEAN R RSO CFC Bk 2 IaI# 5 SFC k4, skt CFC ERB a2 — 4
KRS, W SFC M thox iz B Hlsiiza).
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. A REFE SFC

7.8 Wi

7.8 ill%

7.8.1 ik SFC EZRF SFC 257

Mk SFC ElRak SFC K%Y
HI7E SIMATIC Manager ik SFC 53l SFC 267

A7 SFC RIS SFC SLBIAFEAER, A REHE % SFC RALMIER .
WIERAFAE SFC SRR WA SFC sl M2 B 41 B 11X — xis

15 SFC R KHRIIBAT R G 2 B2 B

P
1. £ SIMATIC Manager [{I41 1141 € i k4% SFC %k SFC 27,
2. % <Del> .

7.8.2 A Mgk SFC S£41

Mikx SFC 341

Al LLLE SIMATIC Manager HilER#15% CFC KR 1) SFC 529, skimalMife CFC K
[ B R SFC 5241

55 SFC S KIR YIS AT X Gl 23 B2 MBS

B
1. {£ CFC £ FiLFt: SFC 4.
2. 1% <Del> %,
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LIE. HEHE SFC

7.8 Wi

SIMATIC S7 {1 SFC
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B ERR. RE LBl B 8

8.1 e E R B

fEjfr
EATAAAR IS SFC K (SFC gifids) sl HEAT SFC B4 (1£
SIMATIC Manager 1) MJ@tt. FEREE A LA EIR R HEF .

7T E R B XA

£ SFC 4l a+

1. 417F SFC K&,

2. PR a4 SFC >“/@1E..."(Properties...).
JE XS TEHEST TT o

7£ 7 SIMATIC Manager

1. £ SIMATIC Manager %4 SFC &%,

2. BEPEE Ay A gt (Edit) > 58 I..."(Object Properties...).
JE X TEHEST IT

SIMATIC S7 () SFC
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A FERRIL DI E T

8.1 A4 1

B

102

T AR R AR TR B X R m

# A5 R (General information)

BT RA] ] T AN BUE U R A RR . MEE AR, e TR A S R4 A
HERY G, siALid SFC B8 Bk M i s AT KL

21754 AS (Operating parameters AS)

FIESCIE TR BB R BRI

— REWUARSERAINE: B iHF " (Step control mode). “E{EHi:L"(Operating

mode). “fr2 " (Command output). “fiHA#E1E"(Cyclic operation) F1“m 1] I
#L”(Time monitoring).

- CPU H /15 SFC JH3))
I “VIa6tk SFC(Initialize SFC) B“fr¥F SFC [1JIRZ"(Retain SFC state). X
B, T Ll SFC A ILAE CPU 51 ERTAIEE A 8, 1B 24E CPU E )35
HRREATRILRA .

- BRI EEhEI:  “A30 85" (Autostart) F1“SFC JH 3 I # F ERINIZ 1T S5 (Use

default operating parameters when SFC starts).
oS

S R B F AL 1% 3] OS JEAT I FAL”(Transfer chart to OS for visualization) &%
HE, W] SFC EIH AT FxiEAT OS 4 4 H 3 £1% 3] OS.

ki 4s (Version)

AL AR B 23 ) BB EIRASH FIRAS . TSR ER, SHRAE S, A iRE
RIARCA 5 [FI A 0.0001 31| 255.4095, G EIRIGZ LIFA S 0.0001 THiG. BB 14
TARENT B ANMRAFIIRAS T

T “$ ¥z ik A" (Data version) 1 L3RR @1 & 1B 2 ik Bt B 8 A oA (1945 L

SRR KA S T AP A, TS K T BRI L R & E BT T
—ANHHEHE, L AR A (Version) 30 .

H A (Data version):

LR 7R B i B B R i T B A RROCAS o B A 5577 BB TE G . 4
P A B P > S s B 5 A 124 T RBUAS

SIMATIC S7 1) SFC
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& FERRIL P jE

8.2 Wit IE L 7 1T

8.2 B R E R

FTFERTETE
7E SFC gmfash, EFSK R4 SFC >“EE..."(Properties...), ## 7E SIMATIC
Manager 1L SCEJerh, ek e SFC RA M IEEE R dr 2 X 5 B E..."(Object
Properties...).
JE PR TEAEHT I o

IR

AT DATE R A3E I o s O A 1

o HH#H{ZE (General information)
BT R AT AN BB SRR A FR. 1B RS, FB 4a's FIyERE, v 15 H
SRS BHBHRY G, MASEL SFC gifias. FribgmiH o ol O 4 e o
AN B

o IB1TZ¥ AS (Operating parameters AS)
AR R AT R A A
— WHE MR SFC SERIIMIRASIERAE . Uil E=0"(Step control

mode). “BAERiA"(Operating mode). “fy2%ith"(Command output). “fifi
{£”(Cyclic operation) A1} [H] i #1.”(Time monitoring).

- JAHEZER SFC L) B ahikmi:  “H3)JE 3" (Autostart) F1“SFC & Bl A FH R A
12172 %" (Use default operating parameters when SFC starts).
- HJH CPU J5)83) SFC

XAFEYIEH 1 SFC(Initialize SFC) F1“fr+F SFC [1RA"(Retain SFC state) i%
Tie XA, BHUAT LA E SFC 2l FHILAE CPU 5 k1T % 5 8, & 2&AE CPU
G =T YA .
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A FERRIL DI E T

8.2 Uit 15 e g 1

e #£Ti (Options)

AILESEIE IR th AT T SR A

— 7E“ZJ5)"(Category) HEH X SIMATIC BATCH [#) SFC Mt 47 702k
“JE"(None): o2& (SE744% SIMATIC BATCH &%) -
“EOP”: SFC KA BRIEHRAL /12K,
“EPH”: SFC AU T B 2R 7y 2K

— SUVF OS L#AE D4R 4 I8 AR SO R AE P KU N -

— PEHISEmg % FE (Control Strategy Selection)
BEHEL S T o0 SFC RAASHI T A HI %N (% 32 1)

TEPEAR Y S ME AT AL B SFC S BRIA SFC SRR ISRNS . X — ik Fee N
FIH T CAFAERI T SFC 52 B8 BAE S B BRMED M 24
JE) SFC S o vl UBH R 5% S8 o2 1l SRmgs 26 45

— SIMATIC IT

fFH“MES #HoC"(MES-relevant) & ZEAE b e 11 3K N2 R iX 28 SFC sl (1945 BAE
EFANLZ MIS/IMES .

® |RA (Version)

AL G e bR e B R TIRAS . X ERY SFC 2K, ARHMRAH M, 1]
WE MIRRASJEH M 0.0001 3 255.4095. #H SFC KRAALLIRA S 0.0001 JF4f .
WE M9 AN T LM A S .

il “Hedia it A" (Data version) W] LAZRICE it PR I i PR AR RBCAS R4 16

WERTEIUH M8 M g T RO BIThRE, WIAE T e TR ARG & L M a2 A 84T
FF—NHEHE, A SRR (Version) ZET0

A (Data version):

TRIE I k7 B e B A R P I FH RV A o B FBROAS 55 77 i FRASTE G o B
FRAS B PERE , JF s B A M 1) 2 BT RO

SIMATIC S7 1) SFC
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B FETRISE B 5 1
8.3 Uiy SFC 571

8.3 e 58 BT SFC 88

EZTUH F EHr
TEZ IUH Al LR SFC KL, JLHTHRUIRY CFC He AU HURT A AR 7] .

2 ARAT B 2% CFC U Y
LA SEHT R I /SFC AL 7

8.4 e 45 S SE B R

FI XS HE
1. & R CFC A1) SFC L ik $e 4m 8" (Edit) >“¥T FF"(Open) iy 4o
% SFC sl SFC S4B s h ¥ IT.
2. 7F SFC 4w gerh, N TITITH SFC SLfil ke a4 SFC >*)8
#£..."(Properties...).
JE X EHEFT IT o
pri L S

A LAFE R AR TR & 2 SFC Sl k.
o H¥{5E (General information)

BEIE IR FH RS N\ BB O A Bk AR . P e @ dE (L SFC 287D n i {HA
eSS ERY (Write-protected) HiktEdi7s CFC B &M ASRY . WRANE
Ry, 48X SFC S ih KA H S .

e =TS # AS (Operating parameters AS)

FESEETR BT LU SFC Sl )iz T 240 (2L SFC 284D

SIMATIC S7 1] SFC
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A FERRIL DI E T

8.4 ISP 1

e #£Ti (Options)

FESEIRIR AT AR NSO SFC 2RI 1 5 3L -

- SIMATIC BATCH":7j]"(Category)
“I"(None): V&1 251.,
“EOP”: SFC KA EAERAL K.
“EPH":  SFC BB BRI 733K

— SIMATIC BATCH“ [t A #1F 1145 4" (Allow operator instructions)
WERVCE TR, WIRTYE OS f#AE GRS HE g AN Efi

— FEHISEmS (Control strategy) (Wi g H T EARY, WL THE SO
HEHEGL S T SFC RIAZSHI T A R Sng (% 32 1)

W B SFC BRI Hems s pize b o #n LU AR SFC 948 5 ORI 16 4% o
R LIBT3 1 SR s B H BRAT (14 23 P IE 46

T R SRS SFC S P Ak £, WXt SFC SR il S LE £ P il
(RIBI AT I 2 S SRR AN 2 115 A BN 210k SFC 51241

— SIMATICIT

“MES #1<"(MES-relevant) & EHER & 115 3K I A4 I SFC 241 145 S AL 26 3]
MIS/MES 4k .

® JRA (Version)

FEhi A" (Version) HERF, 2T LU 2 OCHE SFC RBLIIRAS . ANREAE SFC Sl h i
A o

H A (Data version):

IEIR 7 B i B B R P P T BT RS . B AR 57 SRR TE G . 2
P A B PEAf O > I S s B0 S5 A 124 i RBUAS
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HEHE 9

9.1 {7 SFC HAHBHEE

z—E SFC ':F'éﬂ‘u?'ﬁ;a
7E SFC iy H ik HE a4 “SFC > JH A..."(SFC > Message...) il 41 &7 & .

"L B SFC EIR/ISFC RIY/SFC Sl 4 A FAARITH B SCAS . mT LA SORt S HE ) 37
BICA Ctn, HF DO AN R R PR R RO .

HASPR
U REAS SFC IR AL W b B (i &
o LA EHRIAMIH R
LA AR SFC BB A4 SFC L 47 4 (v &«
o LN EHIARIH R
o BTN

SFC AR G T BRI AT FIE S (BN BRI R —ANE &, SIMATIC BATCH
B0 MIREWHED .
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9.1 4111k SFC 11217156

N ERORERSREZ CTiUE NN NS R
o “HHIa1T I [H]”(Step runtime exceeded)
o “PfE L R"(Operator prompt)
e JiIT SIMATIC BATCH 1 10 ZRA&WE (LR T SFC 2RAY/5241D
- “iz247"(Run)
- “E5EH"(Completed)
- “CE " (Held)
- ‘B 1k"(Aborted)
- “UES 52 (Ready to complete)
- “Bf511-"(Stopped)
— "t (Error)
- “F3"(MANUAL)
- “WA M SIMATIC BATCH %:4ii"(Not released for SIMATIC BATCH)

- SEHIZTHE”(Runtime exceeded)

8 4 P 34T I 1]
U AR A AR A R R R S, e B B B ALARM_SP i), [Alif
WA 3 AR RIRM-EATTHIHE (XFRT SFC JEB/51D RIS i LURE
LTI

PRt PR 2 AT F SR il 1 5L (SIG_2 ... SIG_8) i A/t JLrhfud& G
AUX_PRO04 ... AUX_PR10 (%X} SFC FKER/S41) .
R YANL TR IRS P 2 NSl DR C AN S K 1P By WU A E

AR B R
B TSR AR IR B, 75 SFC EF il NOTIFY 3 BHUR 1, e SFC
L NOTIFY_8P i ek .

7E THE (U1 244)(Messages) 1] AR R F - %538 BT H 170 IV R 384 o

L
AW ETEER, ALARM_8P I B BERE 2 BC /5 ZE A KH B 280
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p— 10

10.1 ¥ PRI 2 45 28 N 3% D SmdE 23

FPE G4 25/ O SR 2%
R G R s 0 SFC R N BT T2 %, WIRAE SFC WHTJT 1 SFC M, A
HE AU 1% 0 4 4% o

F N5 )7 g L SFC R NS«

o PIBE{ERE OGRS
(S8 B (View) "5y A/f 1" (Inputs/Outputs) 5 T bz 11 124t 2
o (LA T,
13647 4 “BLEE"(View) >*I{"(Characteristios) = 1 [ bt 1 1
B S L B R SRS . S Bk 2 A RN 2 ST S R L1 A
AT LT SCRE LRI

BiHA
FE3E T G e A R SCRN AN o R 1 A AEARR AR A e P9 2 SO At o, 3]
DAt IS S8 A A o P G 4 s AN AU BB /i, P DAAS BEAE G A PR S50\ /6
i

o, e SCRFHEYIA] 6 A e (B BN IOBUE.  AEIEE SO, Rl 2 2E il o
LA, XA AT TR iR e s, JF LR AL 2. AR
B gniRAs T, ANREE U IR AR 43BN 11O (RGURYE. WIHAEANERERIN) o

SUREAERTIE G 4 s A AL B At o TR G P P ADUSR A, 2 DUBCPRAS R JEL A B3 ]
KRR A 1 o3 4. OS uli B[R e MAL/ERAE S BIIT s (e (B, BoEqED
L5 SFC SRR MIHR il s, IFAER g as h A T4l

RPN 2R, W 2% SFC BRALEHL (1T 110)# 7>
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S

10.2 SFC ZEXH 94 FIF

10.2 SFC BRI AT

FFAE

Fril2 SFC KM M EARMIhAE, H—4UsMokaiig (Bl VO ZAK. BdadeM., 4]

S E BB

E B SR A] UG ] R FUHFAL -

FFAIE

X

1 S

2 1l SR T AR R ) TR 2k A et SFC 2BAY . 43l S m N A1
TEGmiEas Pl S, DMEEAUS IRy (ol 1 hndhaed
HD IEH . R SEms vy DR B A 01 B T s g R g (4
i1, SIMATIC BATCH) #HATWE . = HISNE & nl ki &
ARITFAGELE, HS%

F5 I TR IS I BB O R T (T 112) 3

BOEME

BOEH A2 SFC KA s 1t SFC A kA2l 2 A sk 1l
E.  BUEM AT LA #R A b1 80 B m o P dl4s (B, SIMATIC
BATCH) HEATHIE . BUEBCGEIEIN, Ehrfiss CAAE RIS
Mo R LA 31 B R A 4 A SRS 1Y 20

AR

ARREARE RS S (B, SR mAE) FEh SFC I8,

FEdilE

SFC AL P BIEDR I IS HE 4

ZH

SHHIRAE S SFC RRAT h . Biln, nl LAE ]S Bk £ 45 08 4%
90 SCBALES A B AT

(DRER R

PiAEff A 2 JE T SFC KU SFC SEl i A b A s A7 it s . Hdimy
LU I AA ek B, (I DUR R . Xl & BLORE oK,
TR o BB O 1k

T A

SE I A X G TAE SFC JEB rp 4125 LAIN TR GRS (U . 5 IR 2 X
GALAMNEE A AT T2 20, Fe 4R Bl el N HT 240
WiFERES e Eo BN IR S AER D R s L, IS BUR
AT EWFEHI I TE]. ATLGE s RABC (F, fikah

B, P RERKAP Y HOEGEIR A, RFFVERE AR Y DL KGRI

M) RABEOE I Y -
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S

10.2 SFC 7RI 1F
FFIE X
R CA HR AR T B 5HAT CrTRETE 2 ik Rt e

Bo FRESUARRTE OS [f) SFC M b, AT AEZAL ERATHIIA
ARETENEZFEL, §5%

A5 R SCAS A, 5 SOA (00 113) 57

Hefo 53 Pefih i ARRIEA B P P, QI s, 241 SFC AU
B A BRI A . 413 SFC SRR, W LUE
HIX Lk N\ M Bl )5 225 SFC S HIE B
ARETEMELHEL, ES%

FAAL RS A (0 114) 5

Pl i (5T 115)E853

(DACRIEN A B SCA T s SFC ST AT 3 B TIRES o LB SCA I,
/R{E OS 1) SFC itk L.
H2 5 RIES%

i IR SCAS R B SCAR (T 113) #8576

EZER
FEACISN TR AV
FrAE A A S (U1 114)
R JE T (5 116)
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S

10.3 FEHAME J7 BE 15 CCH T I

10.3

112

Rl R JR S U E R S

CLAE T ZAR D P A I P42 T SR -
* BN

* HE

o BUEMME

o iSRS KA

AN AERF AES 4 s TR R 5, IR S IR g . KRR ] T K
SFC B Z) 55— A SFC MY fy i A

PUAT N HS rh P Sems (R 5 AN . A, 5| XSS 5 (KU i) A D LR i T
I AHITE 17 5B AT

B
AN AELT A i 5 27 1 47 T SRS T s ARk

ARG RFRE RIS g T o AT RS G 5 37K 5o 27, PR S G 5 47K 5
‘3", KIS

U RANAE PR T A PSR , TE D IR AZAR ISR s T DURICE T3, il s iy
PO KA. KRR, BRI R4 5 A I RE 2> TR FF AL

B
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S

10.4 UITH &7 FE AR E A

10.4 TN AA] AV R SCA R B A

MAFBERER LA SR

1. RSO S A A, R SCRIY A ME 1G5 . QIEHZSORI, 4afR
WS AN g, HA] DUR g S SO EAE M 4 5 CLEEAERT AT
RO ME—)  (EVEH: 1 2] 32767) . %i's w] LIAESL.

7E SFC AR WoRTE B U Z T, WA IE A R A 25 Fh 43 e A5 AR SRR S
A5 ) OPTIPNO /0.

2. OS "] LIEGRTEEN N80 AS DL BERI R 8 OS JE i .

3. —HITJF SFC SLplfymt, RInrvEs MRzl SFC Ll CHIAR i) T B ED .
PATHH A AR 25, TS S s R SCAS

4. FRSCA T O™ A TN, Bl T s TR A SR A R T AE .

5. N TH#AE SERAE Gl 2 (Yes) 124D 5, OS Las/ERi—4 e, m
OPTIPNO fit fEBk o I 5247 407

S SFC KM A G A4 Wil 4y OPTIPNO IR K fil & M “X”E]“0”¥] OPTIPNO
AL, AT LA A %A A E R A

E: WSO B E R SOARIERE, WAL R, WON SR A FR

MAS B AL B SRR B
Kb PR B SCA 25 BRAN AL PRV B SCAS (K20 BRAE LR JLASJ5 T A B AN A -
o LI 1/O £ 4“POSINO”.
o LM 4 LT 5,

THER LU LA

o WORTERSUAFIN B AN SR E, WASURIMERG . Mk, REHTE
BESCA RIS SO BRAE T R

o A SFC AL Ut W SCARM B SCAT R HAG A BIAF K] SFC SRAURT, 22 FOfr
ST . WRAELD . B W A O] TR, s Ziiks i IX s
FFAEL EEN AT B AE
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S
10.5 FFIEHI At

10.5 RRAE P N S Y

RFAIE BT\ 5
RGN T I N PR T SE e SCRIBERT, T DUE SCRAE R4 1 S A\t 5170
JLH
“PETRISRNEL ERE SCARANL BE SCA AL BIT PR 1 B N B 1o B2 A A
SFC RAbriEE .
X RIRAE, 45 1/0 JUER A R ENAERF Ak LR 1/O A ARA— AN [ 5 7 50 2L ko

FZER
IR, WBELLIT 4
W O B RO (7 202)
W TR (5 204)
SFC A IIBRAERE T (77 191)
B (51 115)
FHAE TR (50 116)
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S

10.6

B

SIMATIC S7 ) SFC

10.6 G iy

T A P B ORI A Al AR R 5 SFC RAVELA LTI/
.

Jytt, AR HR ARG EE S OB 1/O B RS E TE“ST_contact=true”. RASAHN
HiHES PCS 7 PEN R L2, nlLUE ST (A rh i d N i, A S A BRI H
T

AN R IE I B fl S A SFC J5HY,

1t B

X T FAE SFC KA b B o5 (2870 1/O,  hp B it i 43 I sl o o5 H R e @ 1k

“S7_contact”, WIAE 52N SFC A [ Hedi A/ o

RS X B N T SFC 2R, v LA 0

e {t CFC H{fi = dir 2“1 T (Options) >“BkJEHL"(Block Types) T B B (i He LAY,
EFAWIN, RS TZRE AL sl

o {E SFC i FHl 3 ¥ iy A “ e TR (Options) >“Hefi 25" (Block Contacts) 5 #ibefilidi. g
B i A S X S N ] 1) SFC 28I 4 IR AT SFC S5

FERF LG 4 s b SC B s R R S BN S A NAE SFC SR rh Qg Bk B A
e HREHLR IN I/O £E SFC Ay OUT /0. B2RALH) OUT I/O 1 SFC K4
B IN /O, BZEAY) IN_OUT I/0 7 SFC KA 244 OUT 1/0.

XFE, ot ] U SRR L5 € CFC Sifil 5 SFC S iRIAH Mo At B3 . AT
AN B R SEBI AR 25 0 o2 — NI AR A I B K (1B (Block) —
BRI SRR . RBLIBIAAAE T ES i

M IX R, BT DU As . BRI A Bt b, TRk, SRT UKL T B
RS SFC M, FHAELURREL HIERIIEA [ 5 i
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S

10.7 #1015 1E

10.7  FEWEM

FHE R B
IR IR T AT HORAL SRR R JE T S X
FHE ' ke | FE = fifF | eSS | R |3 L&
- K& |H 2 (=1 # R XA |l XA
fE
=3
1
ZF% (Name) |x X X X X X X X X X
BB X X X X
s X X X
PiE X
iR X X X X X
NI H 4 X X X X X X X
PR
R X X X X X X X X X X
(Comment)
<& (> X
WL {E X X X X X X
IAKE X X X X X
Fa 1 X X X X X
LA X X X X
TR X
LB X
XA 0 X
A 1 X

SIMATIC S7 {1 SFC
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S

10.7 #FIERT G T
RRE 7= ke | i Z R | e (TR |k hrE
- e | fEH = (=l # fii s XA | fil XA
2
&S X
A X
WK X
e ID X
TFEE ID X
Wkl X
PRER ID X
B X
THR X
f£31% 1D X
FEETHEER X
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S

10.7 #1015 1E

BRI X

JB

X

ZF (Name)

PR FFIEE SR A E I, AR SRR AT R AL 2 — . ] AR e 24 A
75, JF HABEAL S A AR R A (BR T "), SRR 5300 110 Bk

WRPFGEZIEF N, AR OS I HALLY WinCC. R BEFH M iZ R B K s
iR

G

G FH R M — M bR UURH Y TR SRR AE

X kng, oS h RGEIATE R, RGN AR IR dwf 4 b 147 B o0 HE S5y
Be 1 2 32 ZMEE. X T <gi's>, RYifr SFC 284U SELCS I/O
SIELEE <O T-1> 7. WA NGRS A AR, A aEN . X T SFC AR
SFC 545, AV HIAH N 2 i g i, REBR A7 (IS B ir 21k 4% SFC >*J&@
P"(Properties) >“#£I0: 2|5k #% £ FE"(Options: Control strategy selection)) .
A0S TR SCARFIAL B SOA . E ] DU AT 2 5 5 i S
AU 2% EME— HAE 1 2 32767 JulH 2 M.

bt

“brifE"(Standard) 57 7E LLHER U (K10 2 SFC Sl I BT AR 47 Tl S s

Hm e

BRI VP8 50281045 BOOL. INT. DINT. REAL #1 STRING. %} T-# &1t
] DU B2 PLAT PO, BT 2 RIS ARE ANkl (Material) 1R i
ID"(Tracking ID) &£ ¥] REAL g . AASE AT 70 Fl 4 #di 252 DEST. SOURCE.
VIA Fil TKEY.

PRAARFAE e H B R AR ], e HE T B A TG R ol A e IR 5

110 2 Fx

1O A FRk A iE THHE AR O /0. 110 AR AR Ak . 110 & FK AT LU
B A0 T AR

BOE AT 2 16 NF4F

Yt B 10 ANTRF

FI IR : % 24 AR

QUERE T 1/O I, BRI AR R Z AN /0. 45 110 ZFRJG 4 Min—ANE4%, 15754 1/0
()2 FRHE—

/10 A FRI I KA BEI R T A 1 11O J5 e AT BOEEAE N a5, R G n SR
TEIRE 8 NPT W TH M, JESMKEEI T . e IEA SIS
8¢, IXKE 1O AR I AL 24 TR

R (Comment)

A DU PR R VR R R R Ik . VERE IR 2 T LIS 80 A4, JF Honf A SR AEAT
Rk 745 o
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S

10.7 $5 10T 1B 1F

J& T

& X

<BEAH>

BOEAHEI] TP SRRl B CRIERCE AR B — %1 XFE,

U T D I 3R AT I 81 RORE A (10 5 R G 263 42 T SRS

3 WO 2575 T SRS PR BEE (A7 AE R BOE LN “< BUE(H-/O 4 H%>_CS™I/0 o Gk s
55 SELCS /O #IlF); #i52, Zadiilshing <g5> /rHsh <4i'5-1> 0. WAL e
e il A VA TR A Y= A e B ) L N g A

BIUA e

PR ERE SR AE AR AF AL K S A EL N (R {EL. W] AE SFC Seih sl ok

SOAKE

X+ STRING Bl 2R, SORKEE SCT AR KK Cyarsl: 1 81 254)

i

X1 REAL. PI Al PO £y, 1w LT Bt WoRm/Nr (0 8 7) &

AL

XfF INT. DINT. REAL. Pl fil PO iz id, nfblw X—ANpfi. efE#E0 1/0
RSB ST _unit” {7 fif. 74 SFC 5247 5 itk Jg vk

FNAE N AL 5 AE ES B E B, v DUMEN L= A 2] SIMATIC Manager
AR AT A

RR

XITINT. DINT. REAL. PI. PO. DEST. SOURCE. VIA il TKEY #5248, W]
PAE SCEE TS R B IZABAF AL <I/O ZFK>_LL"I/O . AILL{E SFC s B ik
S Tk -

PR

%f T INT. DINT. REAL. Pl. PO. DEST. SOURCE. VIA #l TKEY %#i25%, wf
PLE SCBUEVS I R ZEAEEAE“<I/O 4 F%>_HLI/O . A LLZE SFC 245 F 5 i
s

&N

%71 BOOL %25, & 1 T48 5 FALSE {HMEFR RS . %@ MEAEfE A0 110 1
ARG @ ST _string_0". W {E SFC s b i ket Jm vk .

SCA

%} T BOOL #5255, & T8¢ TRUE (EMEAR RS . 2@ HAam b1 110 &
4 JmPE“ST _string_1".  AI{E SFC s o8 pie stk Jg 1k

M

X7 BOOL. INT F1 DINT #5282, mILArBCMZs . B e #0110 MRS EE
“S7_enum”. 7t SIMATIC Manager [#j“tt2 i e SOMEES . T RA S h 2 R AE H ik
PEIRPEIMES 2 HR . AIAE SFC S rp 5 it g 1k

bfif5, BIAI{E SIMATIC BATCH Al SFC (it 4 (1) SFC s fu 45 i M2 .
W WRAEH“S7_enum”, N|“S7_string_0"F1“S7_string_1" R 45 J& I 4 4k 2% .

BT =

MAZ T RIAERAES, AT IEFER<I/O A4 Fr>_AO™ it i) 4 B E HES 2] WInCC . A JHEY
HAEIE R . AT e SFC 9l A s bt e i
FEGi T OS 2> QU IR AR i, DMICRHZAA MR IX 2R

UURES

SEJE YRR ] T SIMATIC BATCH b/ 4 b i Tahillil (R 954) MRHIE.

SIMATIC S7 ) SFC
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S

10.7 #5119 /8 1

Btk EHX

BE(E ID 1D 4w 5 H T & R SRR A H ek . Wi ID KT 0, MWEE e i

M ID {EW o] AN FE R a0 RO AEAE 2 e ME— 1 1D 5, DU AT AR AL AE AR S F e v
[IALFE,  mI2rECIK) 1D SYsHEAE 0 3] 32767 2 ).

Ykl XHT PLAT PO B2k A, af LU AN — RS T

HREEID XFF PLAT PO B2y, mf LU —NEUF 1D SRAR IR KL .

e I A B R Bk i ORI (R A k. 4RI 1O JE, AF SFC 28R 4R H
AP, WE T 248 E“S7_contact=true”[f4 11 110,  He2EAB: 11 1/O (44 F7%
Ny JEER BN B Hefil 5 1/O BRI JE T . HeS Aty A DL R NS ol SEC 67
Mt . HRSEARNFHrH il SFC 28R H N .

THAR FESE T LLIE$E SFC TS E b AT B BRI 2 5.

f£i% 1D It ID J& SIMATIC BATCH & FRiRAL IS IRME— ID. ‘B LIt (Hdsaiy
TKEY) H—#84r, B MES NFREF4E

FRIET A BN R o8 SIMATIC BATCH AL 25 BAFIPE A B IR A . o AR (B 2y
TKEY) H—#84r, B MES N FREF4

FZER

120

AR NO ML 25 E, WS LUR %50

PR RE D Z 00 i (0T 202)

RN RE R (0T 204)

ARAGEIEMHEZER, WZ7% STEP 7 /e P LU T 873
B i RSt ok
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HEMFERIRA 1 1

11.1 AT S R4 ] R 4L

2K

i

gifa ID

SIMATIC S7 ) SFC

BARWPEH RS, BAT A CFC /s STEP 7 TR G LA KIHEA B 3hkT)
AEo [AIN, EEAHAAE SFC & SFC M Jr #4H 1K) AS Bbit,  nl LURE & 24
I AAE R BEThRe, R 1E SFC A .

MEMFEH RS (SFC KK SFC 288 I, Mgl D BT

o QA AT P A AR R P AT 5 SFC IG5 A0 Jm) A P 46 4 4544

o {E*J@ 1k (Properties) XTHEF, A RF G B4 TACBEALG A2 .
o (@t (Properties) X iRHES, AR B BIEMSAE.

WY P R LR BAEA PR N 2 B A A RIE . i, PR RS R
FERBLE T I B A CRABSHD s K E” (ERBcSH0 , Pk s o i
.

1 FH =2 ¥y 4 “XE TR (Options) > H & 3”(Customize) >“Biifa..."(Colors...) F LA %EE i G
FUERE AT WEE T 5.

TIPSR PERT, BAAT R4 H FBEIR IETR 1D B bR uiHE TS S, i
A AR R, HER 1D W1 50K Windows 57 J& 1 B 1 & IR e

CLESLTi b Sbs A 8. )@ (Properties) >“ & 7~"(Display) >“¥ & ”(Extended) >“7G
#: FriEsiE"(Element: Selected Element).
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HENWIFIEHF S

11.1 TSNP R

XABE
WIAMER T V5 SFC ) CFC B, WX L8 ks i 41248 0 SCA T IE  CHuhE (R SCAR B (5
i) .
— H AR RSO e s FRT T, St T LASE R SCAR HOE . ARG SO IR R AR
B AN S BRI L
BSOSO IE, IR a2 1E T (Options) >“#4T U A H i%E"(Make Textual
Interconnection) m# % H“%i i%”(Compile) X FAHEH #)“HE4T SCA 3% (Make textual
interconnection) & ikHE.
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HEWITFER AT

11.2 GIZWIFEFE 7 7

11.2 ElfEA e Ry SR 7oy

11.21  WT R IR R R

NRFZERE PP 7

WITER

AR

SIMATIC S7 ) SFC

FEAIARIRZS N, OB i) SFC W& —MWEREF; (HER LY 2R % 8 4> (SFC KK X
32 /> (SFC R MR Y. BN NAE B O AR O P ald. e

JEAR S AR TAR R DRI NEIUR . kiR Bon TR P4 F% (B, RUN

o SEQ1) o HJ DU HI IR L8 3 U145 2 4 A AR o

Bl R CEfar 2“9 (Insert) > FEF"(Sequencer) > ...) & LIRS
N SFC W R E, EXFRRE PR Hyia0 . e f b4l k.
HRUEMEE, HSHLUTES: WTHAZNIERET (T 124)

WHRAE N R NS B SFC Jo 3, WA s S AR T AU B B A8 4k . 3K Sk )
PE T ICEZMIMNIBG . SRR 1Y R BOE R SIS . Sy 21
T5i”(Options) >“¥ B"(Settings) >“fi J7..."(Layout...) 7] LA I} 5T S50 S84 = 00

EIIREE S E Gy b o W e BN ke o VAV W IR U RS ) P RS  ) G 5 GTAAN
DXt o X EEARAY DA 4 5O 0 52 1) 71 73 A

R ER) SFC HAS NI NICE, THAETCHEA k£ EAVE A P f s R A Kb

TERR AN 17 kAR A HAT AL P IR B s R R B T B AR Y LR
WA ALLE R Fopbrid. ABPNRAME. MAKICER RO
Zi

I RE A0 0t 2D R RS NP AL Je MR P4 SM I FEATIN S . 2D (S) fh i i e 20
R (T), ¥R G LA —A 0 (. S-T-S 8l T-S-T) . ifidss A5)iM
SFRE R .

L1

UERAEMZ RE Py B RS FOD Z TR — NI 0 30, WIFEFFAT 20 STzl Z T4 A 34
A
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HENWIFIEHF S

11.2 GIZWIFEFE 7 1 7

1122 WTAESMIRF

i

—A SFC mfULE ZA T T AR A H IR . g€ AR R sh &1, a
LORHRS SE I RE e s HEAE R 8 S AE A e R 3. ilun, W DON RERPERATIRZS (i, 228
P WSS EEE ) BURER RIS (s I P ANERIRIKO 7 AL AR K A R o

A

XF ARG 0L, RO T H0E SRR . IX LN R PSR ] N “SFC
ek .

A AR XS, IR B S 2T B

RSP & e— MR

124

WR BB AT RS UL IEAE R OB K IEAE MR RS I AR BG4 A 69357
A R — AR R, ik SFC 1 RUNHOLD #i A\ % % 4 TRUE.

WK RUNHOLD % & 4 FALSE, DR P 8 50 L AN AR O i e Jeik e
15, R)G G B30, RG4kE:) o W RIEAT RGN B B4k S8 4T (K I R 2 R
Ol ik, W2 Bon— AN PATAY R (EXEC_ERR).  IXAER L0 IFH A A TS Fik i
.,
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HEWITFER AT

11.2 GIZWIFEFE 7 7

TR 5 R P 10 J 3 A

5y

SIMATIC S7 ) SFC

il

SFC [#5—AMi4F2 5 2 A7 “<SFCName>.RUN=Run" 4% (SFC K|t &
“RUN=Run"4ff (SFC A o Frasin i R4S Foe s R 17 (8 ) 3h 4 AR 1 i 23 11,
TSR L s W R VAT A ST, 5 @R 1 4 B R A B0 R A
BT 2 e W) A 200 1ok 3 Py 2 “ IR A2 7 )& 1" (Sequencer Properties) >/ 31 444" (Start
Condition) JEIF K& LN sh4 1t

T AT g2 2R Il 2 2 N IR B0 4 I L, BT CART AR S B iy & IR A2 P IR
¥ (Sequencer Properties) >“%# #1”(General) &35 £ 4 & 5 FLF 0 BEAS R L5 % (I
. 1 3] 255)

M R PP 1 JR B 451, T LU B IR I R PRI FAE SFC A TN IR AS
INE7RERES U] IIE 0 b P S LNAIRON RS 3 I ER R (i e S O

AR BN FEAERL RS A SFR L B o

ARETETEAE L, HSHLL R &)
Tl Fe F I 25 (0 165)

i 2R B B D LR (DT 166)
Ul S R Y OS ERE (1L 168)

S 1
A MIEEREY, HRshZ A i) SFC i —ME BN . Flan, KLk
“QCS=Heat’. Ik SFC T & I I ilskimg, MR P2 Hdr, Mt SFC AR

S 2:
MM 8% A*<SFCName>.IDLE=Idle” I MERE P . an R4 AR a5 H”, Wi2s
PAT IR o

S 3:

JA BN A A T B BRI FIR A

Jit, HidRRREHIMEE S “LOCKERROR” (SFC [ A) Hi%. HILA @R, SFC
SUMHE AR . B LS — MR R A B — 08, a0, A shactth
“<SFCName>.ERROR=Error AND <process status>=1",
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11.2 GIZWIFEFE 7 1 7

S 4

VERSER 3 — A EIETT R, ANESCRA W DUHMTH R . ik, TEASE A

51 N “<process status>=1"[{IERE T, I H T AN Y sk B,

RS PATIEANMIEFR ST, A TAT I F2 P R 56 9 T Ak B bt i 850 ) I R PR AR 4
Pl FEXFMHM T, AE T RIRA S“LOCKERROR M HLi%, A A i% Bk 5 1)

BB HAERA

BL
X TEER, Sifeibh<SFCName>.I/0"; X 2841, & /0.

WA B RAEAR T ?
CIR>S B U NG0B R e VN M SV S Y AN S 2 EAp D AR T VA SR e

“WBN"(Insert) > 2" (Sequencer) >“7& X4 i 8 /5 2 7" (Before Current
Sequencer)

o
“WEN"(Insert) >l 52 7" (Sequencer) >“FK EAb”(At End)

W BN/ R AR ?
A UAAE—A SFC % H W S B RIERE S, SRJE R Pl A B e B .
FEZHET SFC & D ABBIKIP B

1. PR oy 2 YmiE"(Edit) >“B 3= F..."(Move Sequencer...).
“B iR (Move Sequencer) X UEHERAEIFT IT .

2. Kyt inkE P B Bl A7 (Create copy) SiEHEEfoRE T (BRUINWE: RLHERIL
SADJN

3. MBI Pk PSR L AT T A TR S SRR e AR e, B AT eSS R
&) "(put at the end).

4. e’ (OK)

SIMATIC S7 {1 SFC
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HEWITFER AT

11.2 GIZWIFEFE 7 7

FE4ET SFC & O WA IR PR

1. PR a2 i (Edit) >“B shIEFER..."(Move Sequencer...).
“BNEFE” (Move Sequencer) X iEHEBEETFT IT .

2. kbl FI A" (Create Copy) HIEHE (Hikbrid) -

3. WA bk £ L AE SLRT TR A P SRR P Ay, SOEFRAT OBHES R
4b) "(put at the end).

4. e (OK)

FIT S I R 0 A B F v 4, LM SFC % L s R P M B FRan & —. Wi 4
RIS E R ey, WE e n, 004 Fea < i — A2 Wy

RN SFC & NP R

1. ERCSE R A A “gmiR"(Edit) >“&HIIFHEFE 5" (Copy Sequencer) 1 “4#48"(Edit) >*BY £
27" (Cut Sequencer).

2. V)] —A~ SFC % I,

3. MEFEE A A gwiE7 (Edit) >3 AR5 (Insert Sequencer).
P S BS D) I R e BE R E A 44, PN ST R R I

iR
LR/~ SFC & H ik i LAGEA TR B . I S/ B U) (0 iz R P B B A T i 44, T4
N 2 LA R R I IR

AT B BR R AR P 2
AT LAE S DA A5 RN 3% 24 i M A <
1. P4 A g (Edit) >“ IR 2 5" (Delete Sequencer).
2. Hh“E"(Yes) i R

SIMATIC S7 1] SFC
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11.2 GIZWIFEFE 7 1 7

11.2.3

THER LR LA

o DRI I AL FRAE ] MR N AL 2500 (EAEANR] AR 3> b mT LU F AR TR
IR

o WAL REAN IR P A AN ERAE . R NMRAE S LU
- PbE: AR R A . D RS A BT DT T IR 3R A

- JGACE: AP RS A B S AT IR . X 2 Ak, i
A] DAHEAT POUT A 3o s e I A T 45

X0 P92 N AR 5 A5 ) M (Sequencer Properties) S HEH T4 A 0l

HE g B HR AL T “TiAb B (Preprocessing) F1“J5 AL FE”(Postprocessing) &I, H.450) 5

[P A BRI BEAH AT B

AIRIE SFC JTREMR

#HA/EIEE SFC T&

128

18 FH 32 B 2“4 N (Insert) >“35 /%5 #”(Step/Transition). >“3£474»3¢"(Simultaneous
Branch). >“%#%4>32"(Alternative Branch). >“f§¥"(Loop). >“Bk#”(Jump) & >“3C
A"(Text) IEFZAHAMN SFC JuE . JhrlSMS A, FHUIRBHEARIA . 1FhRR
A WAL T, 3BT AR Jo 3 A v (A B L

WERPUAEARS B8 BIEAE P _E7, SEhsiBAR S fi7n TR L a2 R REgHh N, BB
I SFC JLREINAA <+> B, AR NZEIEFT S KR

W SERE SRR TR ST BE B B R e h A — N e VR T, R R S KPR
FEFHAT O XN (FE LB R AT 20 SCINIED . A SERE LR /R EAAm A —
TGP o U RAE A MUY 5548 N — DI FE S5, MIE I IR 52 % G —AN B hn
&y DURFFEVEIER . WERAERNUP S5 5N — AN IFAT 032, AR 1T A 25 %5
AR .

NG, FridA M SFC Ju# LU A5 o,

SIMATIC S7 1) SFC
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11.2 GIZWIFEFE 7 7

11.24  WfTEIE T

k]
AR, SRR 0 R B A -5 U (TS) S-SR UT (ST) (B F
i)
o
©)
1 ::::I::::::::::i
— = ©
(1) TS Jliif¢
2) ST i
e
W L )
2. BRI 2 1 (RER RS2 ) RO I T f.
3. WK R A BT N SV A 2, 2 I G (K T2
4, BRSEAE SO IR, it B /e R TR B S
TR SRR (STITS KB ) #5375t S rfE A (e
%R

AN & G LY i VA 8

SIMATIC S7 1] SFC
A FERVETET, 03/2009, A5E02113388-01 129



HENWIFIEHF S

11.2 GIZWIFEFE 7 1 7

11.2.5 WA HAT 0

i
QAT 72 SO, SRR, RN P RS AP RAEREA SRR, 21—
NS QBB INRIFAT 2 SR I sA T, DLORF TR IR IR

SB

—_

1. TR R P T4 3 B 2,
2. WRJE HLTE AT 4 L T B

I NI AT bR 2SR AEUY e R (Bbaboh S5 ) S6) HJH FlHt th — &R, W
FIThsic oo 2R A8 D B AR I FA T 00 S /e MR (¥ 53

EljT3 C>3 T3

I I
| oss | ! S5 s11
I I
l #jml #jm
| | A
| S6 ' S6
| | I
|

““%:“Tg_ I :;:Ts

BRRA T HERE,  WUPRE SR — AN DRy (MAbTy S5 2 T5) A4l (120 i
Jr (BEAET S5 £ 86) , HI TR IR, oA AL TN b B AN
(WEhtShy 810> , FEIFAT ISR B MR (MRS TO)

|:|:|T3 :>:| T3
i i

S5 S5 S11

H
H

3. WEREY R —AIFATH3L, VISR MR AR (i, E8n30 , JHELET
3 SCER BT ALE 5 7 b s T it (R A

SIMATIC S7 [t SFC
130 i AR5 T, 03/2009, ASE02113388-01



HEWITFER AT
11.2 GIZWIFEFE 7 7

G IFAT L
ATLURE BN S IF4T 93 SCERGEFE 7 SCAS B — AN AT 32, 38T LUNER e T80k e 1]
FANEN AP ] EAEIFAT 70 SCA RS S B0Rs FOAS 3l B AE e (AR e
REE CORFARIR I SZBRAN ) o WERMMER T (RI8C AN, R R 2 fi] F
JRE A ISR b, IFAT 2SRRI 2% o

SIMATIC S7 ) SFC
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11.2 GIZWIFEFE 7 1 7

11.2.6  WfTRIEMEEEFES

i
QI NIRRT, RIS AN . IRGERA SR,
o HAEIE B SR B3I — A2, DURFREE IER

+

1. T E A IR S bR

2. WRJa i AR N LR ST AL
URAZAT SUbR A AR DG 1 A T OF— R, WXL ICE0R A N R IE #E
SCIR AT (B 5

3. WUEREY R ANERD S, VISR MR AR (i, IR s, JHELRETR
3 SCER BT ALE 58 (7 b s T it (R

P&

E o

GRABILEFE X
LUK BRIy 5 0 21— AR SCERMIER AT, 38w LUK EATHE A B R AU
R DAEIEFRE 70 3 WA S Bk A s 3 B &b AR S e A . dn RIHBR 7 {80580 —
AT, DU A R 5y B 2 £ s 30 )[Rl S Ry s B0 SRR K%

SIMATIC S7 1) SFC
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HEWITFER AT
11.2 GIZWIFEFE 7 7

11.2.7 WM EIEFH

k]
URRIRERI, 22t P M B B3 O R — /T B 2 8
-
S
1. e e LR,
2. st TR T G O TR Lk
3. R BB AL, (T4 R B T T P T
T
R M B R TR o o 2 W 25 T 2 I R A S VAR I T 25 BV o
.
B
IR MR, SR LA M E 2, (R BRI, AR
PRI B 2 1
ORI E R

FE LR S SOR BB H AR, TEIERERT SR DO K2, FE bR Zc i, F R s 2%
PR R G s AT BERE A DR TRV IR AL

DR A Sk B BRI A5 BRI RS B 4 s it AN 2 # s IR [ EE H Ao

iR

o MEIAABEREASGE IFE R SCHOFAT 3. I TIPS Sk i g e, DR A
W R BEAFAEREA R TT R (WSR2 STHIFT 2030 -

o —AMEMHR AR ] i H A et & — M

SIMATIC S7 1] SFC
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11.2 GIZWIFEFE 7 1 7

11.2.8 TRl gmEB

i

7

134

AP, SR FL I E AR AR H bR R
|

i 7?7

:lj

1, st e 2R ks b LEE],
2. FEMFIOTE B2 -5/ (5 1 O 2

MU, RSB FRR, % I T E

BRES IR O0RE . B A7 S i 2 (222), BT L e H A

— U SREG A O SOk H ARk, T B UR 1m) T 5 A4S
BRI . 2D I A IR N BB H AR

— WIRERIEAT A 2 A B H AR B, TR Z sl
A
o A EBEEE H ARSI RINERIG AT 51 A KBk 2 AR R 3 3o
o WER—ANHIEBEEE H AR D A RRBE IS B 2 WP 5 U ERIBkE: 2 B 3h i

?go

3. Wi Bk#E H bsfs Ko
BT TPk BBk H 457 (Select Jump Destination) XJiHE. Bl F B Tk aa 8 SN BT

R R WoRAE SR AR
4. AP B H b, JF i i 527 (0K).

SIMATIC S7 1) SFC
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HEWITFER AT

B E] H 5

illEN e

SIMATIC S7 ) SFC

11.2 GIZWIFEFE 7 7

1. PRk .

2. EPPBEE L &% 2 Bk H #7”(Go to Jump Destination).
il B EAR WO Eakh.

I A AE G A AR R A

HEPEB - I 1" Del i -

A

SRR I ST IAT IR ST HIBRRCI SR AS PRI T e 22 (L5 R
A R 1) U T R4 3 SOWU IO IR Il /Lo e - AN RO BE A A 28 5| P A P 1)
AT SR . JeR A AT ATEOL, JLE T RINUR 2 GRS b B
MREBENF AP EEE, SNZR

o AFAE— B E) WU AR R ] Bk A

&

o i BT th B B TR

JP RN T ke, RS BRAL IS5 R, LU S AS R AR AMIEATAT 0

W T A SR TT AT 20 SOk

A FERVETET, 03/2009, A5E02113388-01 135



HENWIFIEHF S

11.2 GIZWIFEFE 7 1 7

11.2.9  WfTEIE MR SCAHE

i

i

ATRCRESCAHES A - MIBR SHRIAS ) 2 B &b AT e AL B ASREREHI B REAE
BIR 2 [MR Bl SCA R 52

1. Heti e 2R gy se A [abl]
2. FE 5 O b P 1 P R SO AHE 1
SCAHE IR ABI G T I, AR TR R A
3. FESCAHE AR A SO
SCAAE— AT R AT
4. BLJE, Wk SCAKE A, I AR R I 0 P SO AE
o
SEREI, TR S ARERAT B FERAMTT 2. R T IR L, AR
AR R AT E MR T ME CENZD . 08 P e 25 .

B BSCAHE B A

BB CAHE

136

LR AR N R SCAS P9 20 A PR A AT s DX, MR AR AN S A SN T2 SO RS vl
WDk w] AT BN SCAHER KA, DA AN SOR AT W I RS SR (R 98 5, 3C
AATIKE S ABHE.

PER:

1. Bl SCAHERS HAT T

2. HIChrIE T BA R LR IIAAE,  $E5)SCAKE,  H AR 21K/,

S ASCAKTRS S EVB F WIS G, LR BRI T

1. R R SUAHE,
AT IFSCASHE

2. JHYEARITE SCAME AR _EARSSHE Won (F s R H Atz 208 1 I o5 — M E .
SR SCARNER B B 53— AN B0, U5 1L S s U4 AN SCAHE o i 1420 BR 45

SIMATIC S7 1) SFC
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HEWITFER AT

11.2 GIZWIFEFE 7 7

B I V) H AR A A HE

1.
2.

TR SCAHE

SIMATIC S7 ) SFC

FIIT SCAHER PRFES

MR LR ) SOAKE, LR a2 B Y] SCAHE" (Cut Text Box): A R 2 il SUAKE,
e 2 “E I SCAHE"(Copy Text Box).

DI P i H
SRS FUa] DL ) — % 11, ] DUBHERR P 55— N

- FTIFIRFESR IR L PR iy 2 H " (Insert) .

AT AR FERDILIFH A RS, MBI R A A2

RIS ME TN DA

SCAHERE A B AR AL

. AR R SUAE.

PREESEBERISTIT

- R L 2 “HIBR SCAHE” (Delete Text Box).

AUHERERIFT T, S SR A T IR A

" (Yes).
SCASHE BE R o
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11.3 &7 SFC 1%

11.3 % SFC T&E

11.3.1  #%F SFC t&

11.3.1.1 W@ s s ar gk T e #

HLi%

E b

138

ATE I BL R D5 A T I ¢ -

T e D MRS B LI

R LU 2B AR 2 TR T ELAORIE R . WERBEIUP ANFETFAT 032 &5
SCHAmIR 2, MR FEAEAN IR o

A DA ey 5 BT S K ORIE PR .

A DUGE I R AR R U5 KT CEFRAEAIEIA) s f iR EOE LR
CRBEFEHAT B IR P42 RIEPENRIA

CIRYSTBURL R v/ 2 Ei0Y G o S P L N Y VAR B R 29 s A D E NSRS G vl 2
POk ARIEFEBEL . R HARE S, MIMERI R B 2 gk .

NS R B B AOD Y I T FE L T DL SR AN I R Y o
R AN E, WS BUHE XN S T e o .
U R AR, R SRR AT AT S i & A PR A

WEREEFEZ A SFC JuE, i BARIIE 14T <Ctrl> $. X R+ i) SFC T
7, JFHASBUHES LT ocE. WMARALEPEE 7o, WERLAE <Ctr> f#
(1 [ F P i 6 2% B A BT X e PR B

AR AR TN, R AT <Ctrl> BEIF it iAo R, s O X A
JUERMILERE, IMTEEANIEFEL R EAUAR K T X 2 AL e R ik .

SIMATIC S7 1) SFC
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M7 H R
11.3 &7 SFC 1%

11.3.1.2 el ff R AT IR 3

P #E

TEATLUTBEAL A < Bf k> <FHk> . <Z2fik> A <A k> J7 kit $E SFC JuR
(L) o BEFEESREGR T UHTTEICER . WA TR IEE AR SFC JuR, WH Iki%
NG, SRR L LR

o < Lifisk> HPMUF ¥ L—/ SFC ik

o < Nk> WEEMT R —A SFC St R

o <JEifik> R LMK SFC JuE

o <ATiisk> PRIUT AU SFC i E

WUR R NEFAE T <Ctrl> 8, WE$ SFC B ASHUEN ke # ik H: (2ik)

11.3.1.3  WREHERBITIER

EHERBTIES
U RAZAT: B b 2 S TR N 3820 BUbR KR TOT — AR eHER . REBUZAIN, Sk T o8
AT ERAMR SFC LR, WIRCIEFER SFC IURAERLZAN, M HUH X E ik
o
R A2 R T <Ctrl> 8, WIFELEFE SFC JT RN A HUN PSS RSN Lk T
WEARAEFAT <Ctrl> B[R, HZhERWE 4 ELCHNREICER, WBUH ik
JURINESE, Mk REITTER.

SIMATIC S7 1] SFC
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HENWIFIEHF S

11.3 &7 SFC 0%
11.3.1.4  WFREEFESAER D H T4

REREP RS LI KRt 1T 4R
R LA I DA D G A0 R AL [ 1V -
1. Wili— AP,

2. PR A YmiE" (Edit) >“X 5 8 1..."(Object Properties...).
BT I 2RI R HEHE . TR T P2 5, T4 DU 25 SR 4 48 Bin 14
R 2

3. Sk HE T L $
L N D)

H r—romnn)

L

(KBNS RHEE )

= mnmsRES )

4. {£ SFC i i (20 B o

SIMATIC S7 {1 SFC
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HEWITFER AT

11.3.2  E#l.

11.3 &7 SFC 1%

B MR SFC L&

11.3.21 WKk SFC jtH

R IR
AJ DUEF MG R o 52 00 o0 254 N B ) — s B e B B IERI A &, BRI — (alAS
i) CPU LRylH— (BiAIED) SFC Hr) 5 — AN FE i P vk EIEMA S . W
95, A A E IR ITT RS BIAT A 5 R S E R AT
WIRAEANE CPU L) SFC ARG — AN S5 s S A, 0 SFA7AE 6 A ol 52 )
Xt % (B, CFC s i, #e)d eAHE,
SIS A EIE, B, AN AN

5 A =
B T “E %17 (Copy) Fl“kiit"(Paste) Sz iy A 4h, il LMl AR # SFC i & CUAKE
BIaN) .
DB
1. SR G E I bs A
2. [AI% N <Ctrl> .
3. BpEAL kRN B A —E a5 DR R BT AL, SRS R R b

FEHO -

WHRAS SRVFAE A BT A, WDehs ok 2R IERF S

KT E Ik = EH I

SIMATIC S7 ) SFC

THEREL R LA

o WUREHI—AMY, HUueaE B B H AR, WIAERA oA B b i Bk
B H AR o

o WIREHI N EEEL T, HBkE HESATE S HIIRTGA, Wk H AR AR A
fifisE (?27).
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11.3 &7 SFC 0%

B SCAHE
F V6 T A H 025 Bk S A SUARAHE «
1. FTIFSCAHE PLgiE s 5
2. EPEHISCAHE"(Copy Text Box) i 4.
3. VBT .
PEAF AT DU A — 3 1, ] UG 1 5 — AN .
4. FTIFIRFER IR P i 2 A" (Insert) .
FhRAB T HIR (FEB VI G a0 %, R A% .
5. {EFIT 7 (0 A A B Ak s A
SCAHERIAT AN B AR B
i
AR RIS 22 AN BRI SCAAE
B x5 8N

% SFC Juzsh, I AR I ME X 5 m ik

ARIETEEZER, 5%
Anfr 2 1 SFC ou s KX BB IE (0 143)7 7

SIMATIC S7 1) SFC
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HEWITFER AT

11.3 &7 SFC 1%

11.3.2.2 W E# SFC TR Z B

BB RIS A
MRS MR K A R E e, IR SR A e b MR b, IXWIE R shb gy
S8

SIMATIC S7 ) SFC

R

CIEFEE RN R BN SFC JuE

FEPRFESE i, PSR A 2R X 58 1" (Copy object properties).
WP R T I S B P SFC T,

FEPRAESE L, ERESE L Al AT R B £ (Insert object properties).
F I — 5 B PR R B AZARAE

et (Yes) Hiih .

e E i) SFC JCF KR B AL o0 G

i

PAT A IEANBAE TR S Bz B 2k LU A Eos 5 87(Do not show
this message in the future) Ht, I ECKAST R .

11 :¢F SIMATIC Manager 1 # Fi %3 (Options) >[4 52 X...."(Customize...) 3% i fir 4
FIFF B 5 X7 (Customize) X EHE, WAL " (General) e o HHTIGS % R G0
518
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HEMFE ARG
11.3 &7 SFC 0%

11.3.2.3 Wf#3) SFC TH

Baiid
T B D) R 76 BRI  — WER W L IERIRORCRE, s (R
CPU Ll — (SRR SFC i) 55— MR S L WA . R,
FE SR TR TR AT, WR BN & RIS I O
SN, SR BRI A5 oK 3 IE
P BARULAT B 3)
BT S A BT b (Cut) PRk (Paste) 4b, ST LU EBRES S SFC L. A
SFC e, WHHETEH £ Kt He FE B DRI
HR
1. RT3t RO L
2. HAERAREE, S ROUPFHER BN R F A6 80— D
PR IRRL (EHO .
WIS SOVFLE A B BTS2, MG o AL 5
B

FR A CAHER S 2B ORI e B, 3L P BRIEAT

1. ZEBE i SRR
T IFSCAAE

2. FDOGHRAAE SCAHELAE RS Wiyt o HHES B0 % LN ) — A&
WREGZ AR S B A — N, 5L R P ERET

1. FTIFSCAHE [ PSR

2. IEFBIY)SCAME"(Cut Text Box).

3. VI
A DA DU R 1, n] DU R 5 — N8 o

SIMATIC S7 1) SFC
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HEWITFER AT

4.

5.

11.3 &7 SFC 1%

FTTTAREESE I F L P i 2“4\ (Insert) .

TR E TR (FEBIUIZ IRl fi S 5, AER M Ja AT+ 54 .
AE P PRI AL A PRt

SCAHERME A 2D CARAL

W
ANRE IS 3 22 AN 5 1 SOAVE

11.3.24 g SFC &

M SFC &

SIMATIC S7 ) SFC

A LAERAR R Z G BRIE € 1) SFC Je3R . AEAE T AU A FIRE IR AR 1«

ARETE MR BN P B A0S . WRMER A 3020 s 408, RN IX L0 7 i 2
HOmAZE SFC JTLHEAH

R BONTEL O ER T A oos, Wl MEEEA N Fo s KR
B, EASDESH. ERRE MR TSRS HE

ABEMIBRIFAT 70 SCR MUY i feJa— 20 o SEMBRBLAE R A5 A Y, e SR %
(VS SR BB AL ENG P (NE RS /i@ ek £ 5 105 o

X )RS T 5

AT A AR S PRSI B rh L N BR SCASAHE” (Delete Text Box) i MR S
AHE. SEPFZASCAE (B, (EHIEZRD » WIEFEH A5 b s
LLEFE KR (Delete) tREESE &, Wit m] LUIMER 2 AN SCAHE.
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HENWIFIEHF S
11.4 75/ FEX] i HE i i 47

11.4 R EXEEF SR iE

11.41 WIS IR 7 8 it

FI IR AR

1. PR iy 2 Ymig" (Edit) > FEF B E..."(Sequencer Properties...)
4;?‘@3&@7@ PR RIS R PP 48R b, SRR IE R AREESE B & IR B
£..."(Sequencer Properties...). B F7 FFiZ IR P g 2 16 T AE .

2. W RRIE AR SRR E TR

“J& 1" (Properties) XU HES> A HANEI R, H T g s R 7

o “H"(General)

® “JHzI4AF(Start condition)

e “OS i HH"(OS Comment)

o ‘T4 E"(Preprocessing)

e “J5AbFE”(Postprocessing)

“¥#”(General) &£
TE“H " (General) I+ H s SRR I A KRR . “i 5" (Number) HEEL & 1 SFC
AR S . ANRERE S gn . FE“U 5B (Priority) HEHT, A LU IS RE R 4
Bi—AN 1 21 255 thsedh. Hd, 1 ARRRARM e, 2565 REEmMMAH. £ SFCH
JUAN NG R (R I A2 I8 s 4 AEI, AR5 g vk e Ja s A AN I F2 5

“IB 341" (Start Condition) £k
A LATE BRI R vk SFC ISR /S8 AL e SUIRZ FE Y 5 Bl R 44 (48l
“<SFCName>.RUN = Run"£:7% SFC B T I8 17 8T IR 3 ST .
BT (3L e g D SR S R S A I i D SR E A . AR ERINE R, 155

%
AT AR R2 25 (0T 165) 07

SIMATIC S7 {1 SFC
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HEWITFER AT

11.4 75 1EXT 1T HE T G 4

“OS 7ER"(0OS Comment) IH-F

SRR ) G D RS G AR R MR 1) OS VEREMIA]. AT RIE EE R, WS %
AT g A A2 K OS TR (0T 168) 7).

“TAbEE" (Preprocessing) F1“/5 4b 3" (Postprocessing) X~
FEIX ST Rrf, W LI SFC KIZR/IZRIAA T 5 501E
o RN Y U4 I SR D RIEEAS A A 312 i (R RN A A A BE BT B0 (Tisb D) .
o (EILRIEHAS DAL 5 IR FIA EHAT I SIE JEAED) .

SRR v ) G D TR RIS (R BT AT D R g sl IF) o A3 SR 3 ) BE 24
Ko AI 2% Wi gnd (00 148)#) .

SIMATIC S7 () SFC
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11.4.2 L

11.4.21 W 4miET

TFF 2 1“ )@ " (Properties) XHEHE

T I XU G R 1 0 B i 5 1D B RS Ay 2w (Edit) >“X 58 ... (Object
Properties...) K37 IO FAE .

F AT DAAEIZASFT IR0 TEAE F 2 48 e P MR 301
O TRHETY Ay AR DYAS TR -

o “¥Hl"(General)

o  “YliH1L”(Initialization)

e “4h¥E”(Processing)

e “ZI-"(Termination)

“H;#0”(General) 3£ &

148

FEVH " (General) 3R 1, ATLURABCESCE 2 AR 84T E LA B A OS R .

FEE RGP I SFC S ML B S, Ihd S AE R RE e rpfE—, R H B, AREE
o G5 IR L, AATEbE; B, WRmER T, 2R XAiA N,
VDRSS BT BTN AR R 20 B0 i 5 20 L 45 1% 9T 2

AL R IA " (Confirmation) SEAE A 1% 0 id—AMrid . AR ICHE“T/IT 5 O™k
0 AS HATHARIMAT N . A bR & 10 2 5 G 4R A AE LA 1S 200

&, I H BEE RN FA S REGERES OFHF M), RE5ET 5 O"EAR
—Ff. WREAXERL, WS &A—BE, e EH T (51
TR .

5/ "(Minimum:) BT LAY B D AR FRE SIPIR A 1 s INF ], TIAN S S5 k3 A% 1 4 1o
ETREZST i

fHH 5K "(Maximum:) 0] LU I ) B B o — AN 1), PR AD ORISR ZRE 1R S5 A i
[H]

1 ER” (Comment) F1“OS V1R (OS Comment) HEFT, A LA SCAS, 156 %51
fikA . SHER S w2 80 NMFAF, 1 OS VRN LI & H% 512 AN

o OS R TSP AR D,

SIMATIC S7 1) SFC
Y FEFIHRETH, 03/2009, ASE02113388-01



HEWITFER AT

11.4 717 HEXT 1T HE 1 9 45

“V1a54L" (Initialization). “Ab#E"(Processing). “#¢1E"(Termination) 3£ &

XA IR

SIMATIC S7 ) SFC

ARFERYBE (B AI“wIgh4k” (Initialization) . “4bH1”(Processing) F1“4 11-”(Termination) i%
TR AR AR AT Jmy e AEBCACAASTE R, TR BRI AR B L 5 R AL BN
2 AL PRI R BAT R B A

RS TAAHSRAT A (SERRIC) , SRR EETE AR OS VERER .

1 FH 32 2 i A-“3E T5"(Options) >“4x %8 OS v1#%..."(Edit OS Comment...), =] LR & 764 i
HE R F5 78 REAS AL BB B Q] £ ] OS VERE

o fREFAAR

o {EHIPTIER

o AEAAEATIE R

A T AR BEOGH A P 45 52 W 2 6 OS 38 BT KPR A AT i 8 -
o REAEER Ik

* AR

o ik

ALl BEHAMPEE, Wi s % % & PE"(Object Properties) X AE H 1) “FT
EN"(Print), mIRASRARP R HE, P Rea Xyt Bt 8 v S s A s S

WIRFEHOE A (AR, FER. OS R, Bk, o) , NFamEs g (SFC
>“UiE..., JoEl: B’ (Compile..., range: Changes) S Hifiy4) Jf7E CPU 4T RUN #i
ST F 3 (CPU>“F#..., FEMEX: ¥ i"(Download..., Download mode:
Changes)) , 1M JCHOH IS 241 SFC.

ARG TEA S S, WTSHE LR &5

i gwiE L Hh R S 4E (12 150)

Wi w20 Th R R (U2 152)

i 2l SFC U= B R w1 (1L 143)

iR /E T, 03/2009, ASE02113388-01 149
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11.4.2.2

S

o1

150

nfr g P P 301k

FE— S AL B TEAE A SR AT o

L
i, SFC RMULRED) i)' B CHE L, T ANBEVS ) Sh X 52

TR, BATLCHRASERIRIR 2 50 4B, A IZEXTRAE & B H 1) 10
Ao WU TR BN 46 AR T WL )

BN AT R A0SR 4

o AT ST IERAT I AL

o JITIEFERIMEN OS R I

o JUT& CGHE—A Mk, IBHEFFMA CE A Mk g,

T UME R AT TR A A B P e — 250 1), DUME R IR 08 ) slE 2L i 1 A\
Jear R BIMERy . EPRRHLE, RV AT R A B U ) T KSR 4

EAREREIATH, AT LU “E #IkS MEE/E”(Copy/Paste Action) BREESE iy 4 5 il 58 3
HERITER], SRR R 7 —ah e . Bldn, @k Fp s = nT LUR 2 5 N Yl is 46
B SIS R ) 2 1 B A

SO B T HOHERE R, P 5ok SR g ) 28 BT 7% 1 Th RE o

HA®EOY S SCARGIH T CEA AR PR S (Bt B3R
FEAT4)

ZHI A CAREIE, R EAKE LR A7, AT LM S 5 A 2 “1E T (Options) >“i3
T 3CA H %" (Make Textual Interconnections) &7 SCA H %,  SCA HELEHUIEAT TP LABE
O SR, W TR T B A A T A1 LA I SE b B AR R T SO I, Al
FAAHFI 5 2os 7 5K

SIMATIC S7 1) SFC
Y FEFIHRETH, 03/2009, ASE02113388-01



HEWFEH R
11.4 75 1EXT 1T HE T G 4

i PEIN 2 RIS IR S I SOR 38 . H SR 2 AN S, DR A\ AT AR R
AUATE. NP ARV AR ORI,

]

WERTEN H AR AME— (RVEEMAARMBL T 200 WIEEE L HE. ROl b g
WA SO, I GRS,

9B SFC XA RS DB 7T 5 44 A A .

RS IEZER, WEH U NS
AT g 450 I HBIE (5T 152)

AR R (T 173)

SIMATIC S7 1] SFC
A FERVETET, 03/2009, A5E02113388-01 151
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11.4.2.3

Pk b

152

e G 8825 P I Mk

A
i, SFC RMULRED) ) B ORI, T ANREYS ) ShEEX 52

I TR AR G B BAE B (R L
A IR I Gt b O A 20 o5 R B A\ P 1 R A 2 A

e ML DR AN, BInSOE i €N S . AR O
N, AN T BN aT A SR, ST AR 170,

2. HEM CFC B R HLbm A th 4 2 bk AE o

3. ki 5" (Browse) .
BT T35 (Browse) $iHEHE

“W " (Browse) X 15 HEAT PUANAS ] [P I -
- “T) #KE"(Plant View)

- “YIfFAL " (Component View)

- “21741"(Runtime Groups)

- “KE#5"(Icons)

FEREN S Can L) SRR T i) CFC B3R I, ik B Bos R ST By
RS E
A LU e e (Filter...) FRAEEAAm iy X8, A5 T4 MR
A A 2 Bos. AREPEZER, IS% LT g AV (5T 158)#8
I3

4. EFEPTHKIERR, K5 N HIEFEHA 1/0,

5. BN (Apply), 7RG SR HBMERE R AR FE (e LR b HED .
MPUHES RFFATIT, EEEAE ] 1" (Close) #4147 3L i 3% A B0k T 4 )
P£”(Object Properties) % iHHE

U A Y (Browsee) X U AE B A I R A1 N CFC IR HEATIE RS, WIS 4% H &K
BE L) JZHMERE (WERIEEARAAAE) o SRR R AR XUCRAL (\) 22 TF.

SIMATIC S7 1) SFC
Y FEFIHRETH, 03/2009, ASE02113388-01



HEWITFER AT

11.4 75 1EXT 1T HE T G 4

o LW[LAYEAHR CFC IR By CFC Htiviinl. H2, B SUN BT 55 ik
HSFC Uil i, K Bsha gt 110 Gl <Alt> + HE750 .

o EZIA AR (CFC HI SFC) [t S AEM (. W, PP EERN 2RI
PR i o

Sl FTITAISCH SFC BIR

EFEBUER R

GmiE ik

SIMATIC S7 ) SFC

if11)“<SFC_chart>.INTONOFF := TRUE™#ifi SFC 3.
i #1)*<SFC_chart>.INTONOFF := FALSE"X /1] SFC [EI4; RIFEZ 1k B2 fif A BR 45

ks
A

FATEEARIRTFRERSIE SFC oK, IEEFE“EIN"(Options) >“ B % X ”(Customize) >“fi
J&..."(Layout...) SEH a4, SRIGAEST FFXIEHE R IE S 4 BUEMR N (Parameters:
Value identifier) & 14

WERAEHHEAE FP i — i A B AR R O /O, WHZEUEAR IR R S A R4 ()

HohEAE . WERBE /O A7 A BAERS UIRT, W] AR A7 b AR AT R A A AR A 1)
FIZRHE, I T a0 by e bk 5 P 75 R BB AR AT

FEMEATSCA AN, AR FR— 8 AR5 R P AMAAERIRT S (B0 Bl 5 4 i 44 19
FIMATS) TikAegas bk, JF Hapos 8 A TIE,

o ATEAIN, K AT — Btk A, DU OREE R SRR R . B, Rk
PP A S MR BRI S AR A

o fEMuhbAR, W RUAXT CFC B A/ i vr i), B ERIHLE CFC R Sefrdf A
AR, IXEEA) WoRfE R s (0 SRE AT, O BN SO E

ARXATIEMNEZELE, 7Z%CFC W i)

A SO L FR 73

A FERVETET, 03/2009, A5E02113388-01 153
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Bk 24

AR E A A IR S ROCHR A EH AR T 85 i Bb AL £17(Go To). KT ITARR
M. Wkl CFC BN A B Y, WS H A RER I 1/O. Ik ] A
e IR X R A S BT A

Ak, Rz iEAE HW Config o 40, WSsBkEEE M. 0, 2 BoR—5%
BRI .

‘B 2)”(Go To) hRe iz Tis17 4.

SIMATIC S7 1) SFC
154 g R AERAE T, 03/2009, ASE02113388-01



HEWITFER AT

11.4 75 1EXT 1T HE T G 4
11424 FHHEAHHULE
Ze it
SFC E%
7E SFC &+, RIS H T H T2 bk
e CFC EF A
B <BERLFRN\<HRZFR> <10 44 F5>
e SFC K& (FIHF/EHD
wk: <KERZF>INTONOFF
® SFC/CFC % (HOEER SFC K& #1110
Wk <BERAFR>.<10 LZ2F>
o IZATH (JFR)
Evk. <44 F>.EN
o AVFE VNI bk
Wik <fF5ARR>
o VUAH%E
W <AFRETA> 1
K AAEAERIT R AR CnREE 1/0 FIEED
o 4ify
NN ZEM: <I/O #¥x>
THEH <I/O ZF>.[<T-45M>.. . ]<T-&if>
ol A <I/O ZFR>[<TF&5k>.. ]<Jc >
SIMATIC S7 [fJ SFC
A FERVETET, 03/2009, A5E02113388-01 155
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SFC %7
7E SFC Kb, R34 H T H Tk
BOotE G, 45k, T4 RRgeE)

[ERFA WAL R <I/O 4 Fk>
Hik: <I/O #Fk>
THi: <I/O ZFE>[< T Hikly>.. ]< T Zif)>
Zik L <I/O HFR>.[< T &> |<IuR>
o AL
Wk <fEETH> 5

P ap: b1l

X AEAE IR R ARSI R Gl 1O a2

7t SFC K&, T4 H T T4 ik
SFC E%&

156

CFC K& ey 110
Bk <BERATA\<IATR> <10 HFR>

SFC KIZ& I/
Wik <KRAP>.BUSY

SFC/CFC % (H =T SFC KIZ%) K41 1/0

Bk <EFRHF>.<I0 B>
BATH JFI5

Wik <df14H>.EN
et

Wik <frg5ak>
MAHE

VM <TETH> 5

X AFAE IR R I ARSI CAnRIBE /O (a2

SIMATIC S7 1) SFC
Y FEFIHRETH, 03/2009, ASE02113388-01




HEWITFER AT

o =N
¢

WA AR

11.4 75 1EXT 1T HE T G 4

YT 427 BOOL. BYTE. INT. DINT. WORD #1 DWORD, [ T 4% ${E 5,
AT DARE ENTAT SARRAT CBUERRIRFT) .

o il
wik | 450 <I/O 4 Fx>
T4t <I/O ZFR>.[<F4ik>.. J<T-&if>
Y AP F <I/O HH>.[<TFEH>.. ]<It >
SFC ##!

75 SFC KM, N4 H AT A A it
o FZInE UMM, Sk, TEMMEITR)

Wk | N <I/O % H>
4k <l/O %>
THiH: <I/O ZF%> [<THiky>. |< T Hilky>
Sy AP F <I/O #FR>[<THily>.. ]<Iu 3R>
o UAHIE
B <ATRTR> 8

X AAAAE IR B R AR5 ] Cln B 17O [RE7%)

SIMATIC S7 ) SFC

g FERIHEEVETIE, 03/2009, ASE02113388-01
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11.4.25 G s s N5

W
TE“ %" (Browse) X iEHE“CFC [ #”(CFC Charts) k3, w] LUE g ek H &
AR5 M HURERE S A O DS IR /O, #E“REJE S — 1/O”(Filter — 1/Os) XHiFHEH, W LAY
SESCAE AR s BN R BT B IR I EE 1/O

puRiE s

N EbREE T AND B E AT A G el

R i X

FIRAE

R AT AAEZ N RAE A A SCAS, T30 11O A4 FREL 1/O 1R

TR EARRERRARE, B2 RA LRSS (EATED .

76 CFC BIERF T [y N/frh At CFC Rl W s RS A7AE, (BRI

W, (S7_visible := 'false').

<>

Ca CCHH R A XY /O (JETE: ST7_edit ;= 'param’ & S7_edit :=
<prfi> 'signal') 1] LLZE SIMATIC Manager ()3 F 5t %40 B 47126 Hh kAT 4

B, MILT AT CER CRFL-dr 2 1IN (Options) >“id FEXT
%."(Process Objects) >“¥%£#% 1/0..."(Select 1/0s...)) .

PR G AR AN XL B AR AR OS LI 1/O (gtk: S7_m_c:=

i 'true') .
1F CFC W&+ H SEfr b, SFC HfekifE CFC rh HIER) I/O F T . Stk
% BN SV, WXLk B CFC & MH 7% 5

7 SFC H'5jinl: | SFC K HEEXTH 110 BT IR 'G4AE.  Blith, R E&xixet
/0 BEAT T B, AT LUK E A 1B

SIMATIC S7 {1 SFC
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HEWITFER AT

11.4 75 1EXT 1T HE T G 4
puRE Ji & X
RIEHE
N (IN) % ARG T HAZEME, WAL BRIk 110 A 1/0.
(OUT) H A /%
(IN_OUT)
INAER /0 “UNEIE I 1O R X stk (1) 43 BE 0 2008 A 06 55— Hhk 1y
(Suitable 1/0s Ao
only): S AR AN A G KA INT 19 1/0,  WIAESS
AN HEHE P A R R BE 2R INT (% 1/0.
HA WM e LT hEN A SPATILIE; Heh)iGul, kb g—
ANHEEL WABAT LR SR T 110, JEES T AR T-56 —
ANk

LU I BRN" (Default) 44 2 AT SO I BEE . FIRMERBRA B B <Prfi>
(<all>), Py EHEA BT o

SIMATIC S7 1] SFC
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11.4.2.6 W5 R &5

B
7“5 JE " (step properties) 1, FILLAIZSZE L. T DUARSE FATEILME S50 145
(AR AT
45K <l/O % Fx>
T <I/O %> [<T4ik>. < P>
SRR <I/O Z x> [<FE&5f>.. ]<ou >

ULV ERAE T AT AN DR B, B dl ) Y (Browse) X HEST A . E"H

0" (Browse) XF U AE, AT DLE XA AE T AT FH A BTt (R 454, vl DIOE I 2 454
SR Bl NI (Apply) B R P i “ LA 1/O”(Apply 1/O) SR . 745
17 (Structure) X IEHEH W 125 BRE F TG 5

1E“$E % B Y (Transition Properties) 1, R ASLLI L L.

KT SFC KAIFERHI
ASCVFE 1/0 8705 IN_OUT Wity MR SFC SLVFXF /3L, (HAESM ¥ S7 P,
SR R

EFELH
1. AE“ 5" (Browse) X HE L £ BT i HO 44 o

2. IREESE P LR iy 2“4 FF 457497 (Open Structure).
BT T4 K97 (Structure) SHEHE,
GERIAFRAEAR R PR o 2 UHE I A A0 7 5530 55" (Browse) X 1 HE 1) “1/O7 1
AR5

3. Wk #EAT, BER TN (Apply) .
FEER) . S R T R N 2 JE PE (Properties) X TEHE

TiHA
LER RN T S5 RN SEAE RS 10 @ 1 (Properties) X1 HE S 4 A

SIMATIC S7 [t SFC
160 G FL A ERAE T, 03/2009, ASE02113388-01



HEWITFER AT

11.4 /T XTI HE S
“GE " (Structure) X IEHE 31 %31 1) & X
2% (Name)
BB G R TR AR, Bl
var01_char
var04_struct
var02_bool
var02_int
var06_struct
var03_word
var03_date
var01_time
HyERA
WoRgitn R M HRZEA (BOOL, DINT 5t CHAR) M T¥45#1 STRUCT.
I/0

WIREE TR BT 5 110 2R (INL OUT. IN_OUT) .
CFC H.i#% (CFC interconnection)

AR EEMFE CFC B, WA b — M) kfan CEF)D
SFC i) (B ) (SFC access (writing))

WL — Ak AER N SFC B — Mk uREA (5) Vi,
B (Comment)

BoRER TR R, Bl “1=CPU DPV1 ",

SIMATIC S7 1] SFC
A FERVETET, 03/2009, A5E02113388-01 161
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1143 REER

11431 Wf%EBEHB

T EB R B "X HEHE
1. XUk T B PR e s B0k 65 B i A (Edit) >“X % )& 1...”(Object Properties...).
XFTEAEF] T

2. giRJETE CERRAVER « FIRIZAT R OS TR .
X TEHES Ay =AM IEIR

e “HH"(General)

e “Z/}"(Condition)

e “OS /EH"(0OS Comment)

“¥#”(General) &£
FE“H U (General) BT, A] DU N BRCH S04 FRAIERE

G 5 L RE A It SFC ZhBLHY, EAE BB RE Y e, BRI, AR G
SIUTFEATERG . WERMIER T8, G RN —SBER, W i iz
TR R A% (R 25

SIMATIC S7 ) SFC
162 TR FIHRAVET N, 03/2009, ASE02113388-01



HEWVF R AT

11.4 75 1EXT 1T HE T G 4

“% 1" (Condition) % i £

FE“%AF"(Condition) 1T, AL =B BU B 844 2 x 5 1 2 x 3 FAF4La 4 —
M IRAETE S

T I TITTT

“OS 1:#”"(0S Comment) L&

7E“OS 1R (0OS Comment) EIRH, AT DCHREAN AN SCAR . I SCACKE AR I R 42 1
WIS RTE OS Fo BRATEOL B A SCA,

A hd s CAEREB &M B % s " (Object Properties) X iGHEH1 1) “FT
EI”(Print), nJDURTHFELS TR HERI& S 5E BB H &,

SIMATIC S7 1] SFC
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XA

IR RIS (AR, TR, &F. OSVER) , RN a (SFC >4
#..., YaE: E¥(SFC > Compile..., range: Changes) =% #i#r4) Jf4E CPU 4T RUN
AR BEAT F 8 (CPU >“F#..., TEAN: F"(Download..., Download mode:
Changes) 54D , MG TE e BUE T SFC.

ARMEFEBNEZER, WISHLN:
AT AL AZ R 21 (UL 165) #6873

U] G AR B D HBIE (U 166)
AT e B2 D K OS TERE (L 168)
apfr 2 5 SFC UL X s I (0 143)

SIMATIC S7 ) SFC
164 TR FIHRAVET N, 03/2009, ASE02113388-01



HEWVF R AT

11.4 75 1EXT 1T HE T G 4

11.4.32 MRUEBKRLZG

fai g

MR

SIMATIC S7 ) SFC

e 211" (Condition) &I H 4 Pk i 1k D 14T

iR
VEE, SFC MRV H'E A O D, MAREYS M AMEX 5.

e S AR N — AR RIL L, BRI 2 x 5 Rl 2 x 3 444F (RixABO 4. M=
W BUFE AR IR R MR AL Al

A RIS AT AE B e R A dZis 54T, nR I AND (&) S8 “OR
(21)". HEAHANDH S “NAND B ORI U “NOR”, i s SEAF M . i
B R R R A IR R s A A

BABE: WASROURSHE - MEEAT L, AT A SR AT IR B, o ok T
P W AT /RIS SR IEF AT )5, R AN SOa S A

ARMEEBNTEZER, TSHLUN:
Gn e g AR A A2 R B AIE (5T 166)
A RCEHEIAY (W 173)
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11.4.3.3 W 9EEH P bk

Pk b

A LAGwAE b, EE I T R T P R R (DT 152)F 5 ik, 7R Y0 (Browse) Xt
HERE k. SR s PTAf CRSBEAR M — . I S =i, AT DLl i
JRCERAE R P N S N CFC B3R B a4 2 ik AE v

A
i, SFC RMULRED) ) B ORI, T ANREYS ) ShEEX 52

166

5020 R IE—FF, 3T LI SRS S A 10 A\ R PR SUE AR DR

U SR v (Browsee) Xt R AE S A HItE G A1 N CFC BIRHEATIE S, WIS A4 Hidks
E T R MEsAe G RIERARAAAE) o R MIE R AW XURAL (\) 20 TF.

BABOYE SRS H T CAN AR BRI G (SN IR
R T4

AR CRTIE, R FOEAKE L BRAEAE, AT DAYE G 136 39 ) B B A A FH S o
A“HEIR"(Options) >“HE4T X 4= H.7%"(Make Textual Interconnection) 5 /8 A Hi%, A
FOEAEHEEAT R DL O R R R TR R MR T B AR A LAY (9 SE PR HEAR
BT SO, HAE AR R 0 2R o

G PRI 2 RIS IR S SO HE . HAS 3 AN T, WP L e A 598
AUAHE. FHEPW AV ARG A HE,

SIMATIC S7 1) SFC
Y FEFIHRETH, 03/2009, ASE02113388-01



HEWVF R AT

B 24

SIMATIC S7 ) SFC

11.4 75 1EXT 1T HE T G 4

T AEARSG CFC IR B tiont CFC BRigvsil.  (HJE, BB IR+ HoFr A
ZSFC Viiils #E 2z, Ui R EHR 10 GH <Alt> + JEHD

A LAYT ) G5k, EALPR TE5MI03R . AR N " (Browse) ARAHE T, ) AR A 8 il
G, JEPEPESE i 4T FF 451497 (Open Structure) kAT IF45 1, SR Gk 2145
(AP

R TEE R H AR ANME— (BUIEM AR T 200 WA HIE. KI5 TS
BORNSOREIE, JFHIGEENL. Sl SFC X R AFFHEA DB A5 4 A1
[] o

BNGATIY, R AT — A A, DU RTEE A SRR IR . FFie ek iE
PR I ) BRI 17 A

e IEHE T D2 A . WERT BRI A L, ATLIE CFC R P H]
BRI, AR5 AR R PSS B 0 45 R A bk A\ BV RS S

AR AR WAL R RO AR BB IEARE R 5 F Bk AL 2107(Go To)e KT ITAHR 1)
K%, Wik CFC KR — Ui A sl i, WA /0. & nT LLid
REAEHIE XU R A B A6 A

XA, R AE HW Config Hh 2, M BbdE S HL, A0, s Bon—4
R .

“B 1"(Go To) ThAg LN TiaqT4l.
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11434 Wf%EEBTH OS

7E“OS 1HH"(0S Comment) JEI-RH, W UM REAN RN SCAR . I SCAKGAE I RE 12

M OS IR
WIRE7SAE OS Lo BRIAHOL T M A S AR SOA
FERT AR (1 78 73 ANBE S A K IE 54T s IR AL Tl AL BLA 1128 ie 5
WEARIERAT R T [& 455, WRERS 2 PF I SCARSE AR GERIABEED

e SFC RMAI SFC SEfilf) OS MR KIAIA. iRk SFC RIA 4> I/0 £ SFC 547
AT T, WS RR iz S A R A 2 HE, W B

—AHiE,
an R N\ B HE, W) SFC 2RI SFC S4B OS R se A1 .
Jus,
SE
SFC 2574 SFC 5241
oo RUN = TRUE chart\block.io = TRUE
AHIE RUN = TRUE chart\sfc_instance.RUN = TRUE

o INRIEEAT gl OS RS, MBI I T LSRR S A N e B B . 4TS
) CFC B Eain 44 &l BahFMIBRE, OS MR AN B sh& .

o IR T A H A P g R SO S A O, AR S BB Ui R
WA, EIXFER T, S AKEEHE, F7 N AR SO, AT DU i A E
W7 (Cancel) SR 7 XS TEAE FRHEAT 1) 5 24

168
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HEWITFER AT

11.4 75 1EXT 1T HE T G 4

o W LUI{E SFC gt Hilid Mk OS iR RIS OS Wik, MR HPR LhiL
FAFISCARRINE OS 1R, I HAZINZIEE, WERIEBA SR OS ik, MR EHH K
ZAF, OS iER AN B BB
BAERAE: A REES T & FIBRIN B B (Use Default) 117k A J5t4a 1) OS VERE

AT

o LIRS gniE OS ViR
S A “E IR (Options) >“4i# OS H#..."(Edit OS Comments...) ¥ TNk
RE, 7EFC b RT LLRR @ R el A OS T8¢«
- PREFAA
— AT 4T
I T LAAE SRR R A Fp R 5 ] 1 R OS VR T AR AR A] 2 -
— ARk
= L1SES
— IR R

SIMATIC S7 1] SFC
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HENWIFIEHF S

11.4 75/ FEX] i HE i i 47

11.4.4  JEEHHEAH REFE ISR

11.4.41 L=k

Ak

FHUHEEAE CFC/SFC KEIRAMMBIIER Ak . v LA I b AT e S v ). ¥
» SLERHERIUG RS (SFC i) sk s itl. CFC HitE 110D % A b
Mﬂ

ATLLRE B 51 (0 172) 88 gl (0T 170)JE st

\\\ EU]F% \i:t

11.442 453k

FRU
bk ] T4 -k
ST LU B

o bk ANREAL T oA gn e CFC KR idn 4 (“HETH"(Options) >“4ai%
&..."(Settings for Compilation...)) {48 ()X k.

o bk ANEEAL T AT CPU T AEAERIEUEVE R .

o HihkAZ SV 4 (SFC hif Ay s fitihl. CFC sk 1/10) % AL AR
Ko W RSN & HINT (PIW, Peripheral Input Word), T 85—/ 3% vk g 2K 80,

o Hun LR ARG A AHAEA /0.

SIMATIC S7 {1 SFC
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HEWITFER AT

S

LAR S5 T g4 5 46 FE Xt k-

11.4 717 HEXT 1T HE 1 9 45

Huik

apas

15.1

Vi 5.1

Q5.1

Vil 5.1

M6.7

Vi A7 fifi 4347 6.7

MW10

ViRl AR T 10

DB10.DW20

Vi e 10, Hidi T 20

DB20.DX2.1

Vil Ee Pk 20, 47 2.1

SIMATIC S7 ) SFC

g FERIHEEVETIE, 03/2009, ASE02113388-01
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HENWIFIEHF S

11.4 75/ FEX] i HE i i 47

11.4.4.3

%

=

"5‘

Ttk

KEEE

IS2d

17

il

2

WA REATR 5 T4k

AT 5T, e DO 2B AR AT S o AT S RBIEERT S R . SRR
T A “E TN (Options) >“FF5 &K "(Symbol Table) H T+ FFAF53, w DL a8 nslidm
%H.

TEFF TR s Hiny, 2474 STEP 7 415E .

A DU S o 4 B3R (Chart) >“f & — 3 fi .”(Check Consistency...), {542 Hif
BTA % H AT IAER SR T DAl 52 Hdy 2“4 30" (Options) >“H #&..."(Logs...)
BoR B AN HE.

FE N TS R AR 2L AT DA A 46 H szl BUR SEgiii W) 1 il 8 145545 5 b
fik

Huhk &

Limitswitch 1 an v 9] B AL
LERF 52 vh e it Mk

Recipe.setpoint | Vi n]— AN (Bl o R o T8It s
(ff) -

DB17.setpoint | [A] I, F & ol Bh i 4e 6t -4k

Recipe.DW5 A b, R EE 40 Sk

“5.1" i]‘il‘tﬂ%%xdj 5.1 FAF o S TG X [ 44 40k Mk i HE A5 5 4T Sk,
FR G5 R 5 5K

SIMATIC S7 1) SFC
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HEWITFER AT

11.4.4.4 FHHEIERA

AU E YRR

SIMATIC S7 ) SFC

11.4 717 X i e G #
5. SFC 1 A VFE F N 41 dhs S BRI B A R 5% A1«
HoERA A EHEBH
AV RVF
BOOL, BO & I
BYTE, BY Iz v
CHAR, [C 2 2
DATE, D B B2
DINT, DI i &
DWORD,, DW iz T
INT, | T v
REAL, R P &
S5TIME, T5 2 75
STRING, S I i
STRUCT, ST A )
TIME, [Tl i &
TIME OF DAY,, T 2 2
WORD, W 2 B
) A PR G5 T3
173
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B et En
11.5 71561751

11.5 BrEBITEMHT

11.5.1 SFC KT Bt

BT Rt
SFC 3 ul SFC Sl 1yiaty J& MEaf € Wi 4 SFC 5 2 CPU 148> 45 #ag vt [ A 2 1)
PATIIY Ao IR PR E T F bR 28 SR WS IR [ A5 I 1) 8507 T FRAT 0y, e
TSRS Cnasilmlig) ke .

FEBAT IR @A

A OL T2 524> SFC BIRAITA S| — NI4T irf . BT S, EREdIA T
S7 N HEA ALY (OB) X MRS 1. 1 LUK SFC EIRIEARIZ T4, M3
WP IsAT Al B (/D LER TR RS D

SFC RETALMBATIEIE, PO E ST IIAT IR, SFC JRBARESR A I 47 Y
H.

] CFC [RI2 47 MR G 445 G B2 A TG o
BOATEOL Y, SFC SEfldd A% CFC BIRMisiT4lH.

RIS IVE LR, WS N
AT S A IS AT U (0T 175)

e 4 SFC R iz AT w1 (0L 177)

SIMATIC S7 1) SFC
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AW F 4
11.5 75 &&= 1751

11.5.2 WG EIEATIF

GmAEIBT T
A 2RI T SFC EIAR/ISFC SelFastr Y. 1847y tudE SFC a5
IPACOAC RV qi B 4 E == Y v i 1B e 0 e N = vk S L U VA P 2 A

FYUEATIN T
1. TR (B
o
Y “gm 48" (Edit) >“iZ24T M FE"(Run Sequence) 3 Hdr 4 .
¥ %) SFC 4T 9847 )F7"(Run Sequence) % 1. WRAE SFC 4T IT 7 Ht,
AL LU SC A
2. fEAE DRk PRA S BT ) SFC T4 .
3. i&F SFC, RJGiEF“BIY)"(Cut) ThEE.
FEIBATIFY (B4 BT 5 BT 5 ) ik PR B AR i #4di N(Insert) .
WHRIE PR EATS, WIS TEATS5 T 3L SFC.
WHRIE R RAT S P IS, WIASAER % 51N SFC K.

T BV Z A, 3 mT DAE AR SFC A —NTIFIESS P sh 21 55— AME

»

5

4

o

FEHELFTHEA SFC
A4~ SFC (EIER/SEH)D W Ziidd N2 22 /D ANMES
e i\ OB 100 LA i itk
o JHA—AMEH TN OB (fflhn, OB 32) rf LAFEHIIHFFHAE
L
REEAER LS 2 RAEA R A SFC. AmH—A> SFC A 2 A A ITEAE 4%

i, RO AT RE S SR AN T T AT . ANREAE LS AR B I 45 h i\ SFC (OB
100 B&4M) .
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HENWIFIEHF S

11.5 #7E 1T /B1E

MAEZ-FHlkx SFC
TEATS HiEPE SFC, ARJFIEPEE iy 2 “HBR"(Delete) 3% ~ <Del> Bk SR
FEMAE NG, B2 MES kR SFC.

AREZFEL, 2%
B 4IA SFC iz AT @ It (W A77) 70 .
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HEWITFER AT

11.5 75 &&= 1751

11.5.3  BT4 R SFC HEiT B

fai g

R IBA T B A YE /N L2 RS A A S g v, T AR R i N SFC. W] LAFEIEAT
A% JEME (property) HH i B IX LR (attribute). SR G IEATALI AT A R0 H AT M)
FR“45 7N G SR RN AR S o

WA EIEITA

AT LA IRCR 2120 BRAE IS AT U 20 48 b v A2 s 474

1.

5.

VEFE i A “Gm i (Edit) >“124TF..."(Run Sequence...)
E‘Z oa

st (8] g

FEISAT Gy Hh Ik e AN E

PR T 2 W (Insert) >“IZ21T41..."(Runtime Group...).

A RAE BN IS AT AR AR A A A PR 5 R . 3B W] DUAE AL B 4 /N EE
FORARAL AL "B AT I BOA R E (%30

B " (OK)

AR ARR (5 P S E OB AT B, E RIS AT IR IR B TPk RIS AT AL, SRS IR A A G
&"(Edit) >“X1 58 4" (Object Properties).

A

SFC AN FZT A 2 Ja v LEEA R AIAMAT S 1817, W T EMBERE, XFEgmT
I S U M 22 HEI H 254, WM AE BT 20 285 00 SO m] RO HR e (459 2 2% T 7 11
BTED .

SFC BRIt Re)a 1

fif

AeJEtE (EN) J5 H (EN=1) 5i25H] (EN=0) SFC Kl MHAT. HZLEN #xE N 0, W

AEHEHA T SFC BEIRAA AL
AR R TSl aS . BRI, Bdarth I EMESOD B R PE T SFC IR i #lAb L

SIMATIC S7 ) SFC
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HENWIFIEHF S

11.5 71561751

BATHRZITEM
T LIS AL BE 8 P 0 IS —AMigqT4l, X5 SFC KR —Ff.
AREHHR T A B PES L4 SFC KB, Ml ik K B L Ad NI AT 41K AT 73 i«
LIS U
o AL
SFC 2 iz AT A I @ M s A
—MNEAIEABIZITA SFC HA FHIBRINRE
* “4i/NH# = 1”(Reduction ratio = 1)
o “HIfiff#% = 0”(Phase offset = 0)
W R A B AE CPU i AN R IS AT J@ PEoRkiz AT SFC, I ZIUKE X 28 B 34l A BIAN R )iz
(i
o HHEE
/IR 0 B PATAE S5 N AL B SFC B RIE S AFHAT n IRAFRS5 4 Ab 3K
ity (=2 g 0<st<=15) o BEERAE S AR B
L4 -
PEE KT (OB 33) HysEA R H: 500 ms
ZRRGNER T RER AP 1s. 2s. 4s. 8s Tk 168 %5,
R A EREA LR BATH D, WIS 1, fe52, FREITN
500 ms) #F4bHE SFC K%

SIMATIC S7 [t SFC
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HEWITFER AT

SIMATIC S7 ) SFC

11.5 75 &&= 1751

o AW
IR A AL T g4 CPU YA 0 fi. S HL S0 (/MR BeAEH . 178
‘IR E R AR SFC K2, BERAC BRI IS “m M4 R WA . “m N aE
%, M 0<=m<=(n-1).
SEB:
AW SEA . 500 ms
gi/NEb#: 16 (H SFC K %4 8 s AbFE-—V0
MW 3. 3. K, 45 1.5s. 9.5s 8t 17.5 s 250} A B 5 b3 SFC E % .
W ANERBAE 2R AN BT A, WY 0; B, AbEE SFC LI LA
PF% o

A

VUM S5 00 PN AT I0AE 55, 0BtAEtE RITED IST AR5 s M L 2
HIRLVES . AEFTAT IV (B2 P AR A AL, 5300 T LRSI E 26 SR
So AEME, ABIHE BRI B B A=A =0
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11.5 #7E 1T /B1E
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RS DA 1/0 1 2

12.1 SFC EIRKFriERE

12.1.1  SFC ERir#EE O/ H

SFC BRIt O

SFC KIZR I brEr A5 ZE SN Aar - T AT R e el e o 43 1 52 42 A R
kil SFC Kl

A0 MELEH, TS5 RS
SFC & fIbRAERE T (72 182)
Fe T 25 2K 1 SFC RIZ i A (97 190)

SIMATIC S7 ) SFC
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BrERE TR /O

12.1 SFC X FritEFEE ]

12.1.2

SFC ERMtrERE O

SFC BRIt D
TR RS T SFC B R hRuER: N .
HREHEANLHBY, 155% RENARS X (5 189)#7>

182

110 & X HAERA | B | KA | 0&M
(=l
ABORT 1 8l fiy 4k BOOL 0 |
ABORTED HERE TP BOOL 0 |O
ABORTING BARRAS“ELE R BOOL 0 |O
AUT DiEl A3 GEREED BOOL 0 I
BA_ADDSTATE BATCH: ik DWORD [0 |O
BA_EN BATCH: i figiij BOOL 1 | +
BA_ID BATCH: &4t L/ =45 |DWORD |0 | +
BA_NA BATCH: #it4:" 4 %5x STRING | | +
[32]

BA_STATE BATCH R&F DWORD |0 o |+
BUSY W& BOOL 0 |0

(= RRETW “B5¢

s ek, AR e

1B
COMPLETE 1 B iy 258 HL” BOOL 0 |
COMPLETED HAERE T B BOOL 0 |0
COMPLETING BAERE B BOOL 0 |0
CONT BURSR TE BOOL 0 |
CPU_RESTART FH)d 50 CPU BOOL 0 |O
CUSEQ MR ) G0 BYTE 0 |0 |+
CUSTEP MHTE )9S WORD |0 0
CUSTEPACTSTATE TS R IRE BOOL 0 |0
CUSTEPCOUNT N SIS BYTE 0 |0

SIMATIC S7 [ SFC
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BrERE T RIEZ /O

12.1 SFC FZ19brilt# 1]
I/0 aX FARRE | B | KA | 0&M
fEH

CUSTEPERRSTATE TP AR BOOL 0 |0
CUSTEPHELDSTATE | 4l e 15k BOOL 0 ¢}
CUSTEPMAXRT T IR 8 KA AT I 1] TIME 0 o)
CUSTEPMINRT D 1) N E AT I ] TIME 0 o}
CUSTEPRT D )is AT N 1A TIME 0 o}
CUTRANS TR IS WORD |0 o)
CUTRANSCOUNT s AL 0 BYTE 0 o
CUTRANSRESULT P W SR S AINERE S BOOL 0 |0
CYCLEXEC TEHERAE (LEBIEF) | BOOL 01) |
DIS_START_STATE JA BT R DWORD |0 o |+
ENABORT ot 1P it v BOOL 1 I
ENASTART “IEATIN A Bl AL RE i BOOL 0 |
ENAUT “UIe 2 5 37 ()AL fie v BOOL 0 I
ENCOMPLETE “SE R A e BOOL 1 |
ENHOLD R IRAL fe d BOOL 1 |
ENMAN Y14 3 T2y 148 BE i BOOL 0 |
ENRESET S A e S BOOL 1 |
ENRESTART “ L 2" A R i BOOL 1 |
ENRESUME PR ISAT AL BE i BOOL 1 |
ENSTART “Je By A R i BOOL 1 |
ENSTOP 5 LIRS i i BOOL 1 |
ENTARGETSTEP “BeE H bR 1A e i BOOL 1 |
ERRG Yl R BOOL 0 |0

(EXT_ERR | OP_ERR |

LI_ERR | S_ERRG)
ERROR BARIRS A BOOL 0 |0
ERROR_ COMPLETING | #f{RA&“ 4 (IEAE5E BOOL 0 |o

D
EXEC_ERR IBATHIR, i, BEHR | BOOL 0o |O

SIMATIC S7 ] SFC
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BrERE TR /O

12.1 SFC KZ I tritt L]

I/0 & X HHERA | BN | KA | 0&M
(=l
EXT_ERR AN BOOL 0 |
HELD BERES CEE BOOL 0 |O
HELD_ERROR BAPRACHEES GHHED " |BOOL 0 |O
HELDSEQ CUE 5 IS R P 0 BYTE 0 o |+
HELDSTEP EAA P A TR WORD |0 0
HELDSTEPCOUNT CVE 520 ) B BYTE 0 o)
HELDSTEPERRSTATE | L B 5B AR IR BOOL 0 0
HELDSTEPHELDSTATE | C /{5 (1IR3 BOOL 0 |0
HELDSTEPRT LR i AT I (A TIME 0 o
HELDTRANS O S WORD [0 |O
HELDTRANSCOUNT CVE 5 5 B 1 4 o BYTE 0 o)
HELDTRANSRESULT | %—/N O 1E B4 BOOL 0 0
HOLD 1 3y i 2B BOOL 0 |
HOLDING BARR A& TR 5 BOOL 0 |0
IDLE BAERE N BOOL 0 |0
INSTROUT A (AESEAT) | BOOL 12) |1
INTABORT P Ak BOOL 0 [o)
INTCOMPLETE P9 i A 5E BOOL 0 10
INTERROR N B2 A BOOL 0 (o]
INTHOLD P9 i A BT 4 BOOL 0 10
INTONOFF W A2 Jd 8195 SFC”: | BOOL 0 10
0: XMl 1: 3l
INTRESET RS R =R A BOOL 0 10
INTRESTART P 4 L Bl BOOL 0 10
INTRESUME P i & I AT BOOL 0 (o]
INTSTART R S P BOOL 0 (o]
INTSTOP P 415 1k BOOL 0 10
IORES1..6 O B A A T BOOL 0 10
IRES1..5 DR B A A9 BOOL 0 |
SIMATIC S7 It SFC
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BrERE T RIEZ /O

SIMATIC S7 ) SFC
g FERIHEEVETIE, 03/2009, ASE02113388-01

12.1 SFC FZ19brilt# 1]
I/0 &X HHERR | B | KA O8M
fE

LASTSEQ s WO B R e (M o | BYTE 0 |O
LASTSTEP 5 J YOI )20 B WORD |0 o}
LI_ERR SHOM AT (Bl JE% | BOOL 0 |o

LN RS
LI_ERR_STATE SHAR RS T DWORD [0 |O [+
LOCKABORT AR ELA v b BOOL 0 |
LOCKCOMPLETE AR e R BOOL 0 |
LOCKERROR AR LA A BOOL 0 |
LOCKHOLD AR LA BOOL 0 |
LOCKSTOP ISR BOOL 0 |
MAN DI B F3) (BRAE R4 HIi | BOOL 0 |

i)
MODE b PRASE A BOOL 0 |

0: 7EfEFAr OB A1iEHF

Kb 3

1: {E/33) OB WALHE Ik
MSG_EVID M E45 (ALARM_8P) DWORD |2 |
MSG_LOCK BiE Y S BOOL 0 | +

0: WA E

1: JHECHUE
MSG_SUP i B30 (ALARM_8P) BOOL 0 |0 |+
NMSG_EVID MBS (NOTIFY) DWORD |1 |
OCCUPIED BATCH: “C\/H”ID BOOL 0 | +

0= 1=24H
OP_ERR P DL BOOL 0 |0
OP_ERR_STATE B AE VR IR T DWORD |0 o |+
ORES_BY DR B ALy A BYTE 0 |O
ORES1..15 O B A P ER AL BOOL 0 ¢}
QAUTMAN MHTERAER: 00 T3, BOOL 04) |O

1: A3
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12.1 SFC KZ I tritt L]
I/0 & X HHERA | BN | KA | 0&M
(=l
QBA_EN BATCH: ffifigii BOOL 0 |0
QBA_ID BATCH: #Ziit4:"%'5 |DWORD |0 o
QBA_NA BATCH: b4~ % Fx STRING |'' |O
[32]
QDIS_START ToVE a3 BOOL 0 |0
({5l 4m: LI_ERR A0
OP_ERR %, )
QENAUT “DH 3 H 30" 1A% e i BOOL 0 |0
QENMAN ) 2 F-2))” 1) A8 e i BOOL 0 0
QEXT_ERR M 1R BOOL 0 |0
QFORCEMAN TEBATE RS 5 M5 T Y] | BOOL 0 |0
BB TR Y T )
Fa), FEE1AAHD
QOCCUPIED BATCH: “/5 HI"bRiRFF BOOL 0 0
Qscc KIERAE DA 2 AliBE - | BOOL 0 |O
QSCT KR I AL e BOOL 0 |0
QSCT_TAC KHIFR AR E I #4E 5 | BOOL 0 |0
NP di
QSCTAC K e F F BOOL 0 |0
FEE L (SARTINN
QSCTOC K VRS B D A28 | BOOL 0 |0
fiifE
QSTEP_NO BATCH: b4i% DWORD [0 |O
READY_TC e TE IR BOOL 0 |0
RESET [y i A7 BOOL 0 |
RESTART H 3l iy & F e 3y BOOL 0 |
RESU_ERROR BAPIRE EERE G BOOL 0 |0
DI
RESUME I 8y iy AW B AT BOOL 0 |
RESUMING BARRS IR BOOL 0 |0
SIMATIC S7 It SFC
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SIMATIC S7 ) SFC
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12.1 SFC FZ19brilt# 1]
I/0 aX HHERR | B | KA O8M
fE

RUN BAERA BT BOOL 0 |o
RUNCOUNT DI ERAE RIS AT IREL INT 0 |O
RUNHOLD RUN Jiii4% 882 /7“8 #5 4 | BOOL 0 I

() 1

0: BFIFERT, 1: ik

IR
S_ERRCA AT AP RNR ((NFEH | BOOL 0 |

BT
S_ERRG R PR BOOL 0 |O
SCT KR I A e BOOL 15) |1

UNAE BT
SCT_TAC KHHEB AR E#IER | BOOL 05) |

PNz et R M

UNAE A B
SELFCOMP SFC Hah W\ iz Pj#e 31l | BOOL 1 |
SELFRESET SFC MBI ML/ ikl | BOOL 0 |

CU " P4 32 R (A

FREA )
SFC_ADDSTATE B in SFC IR & T DWORD |0 o |+
SFC_CONTROL SFC #til 7 (D DWORD |0 0 |+
SFC_INIT ¥4tk SFC BOOL 0 10
SFC_STATE SFC R&F DWORD [0 |0 [+
SIG_2..8 "R A 2...8 (ALARM_8P) | BOOL 0 10
START 1 &y i 4 JA Bl BOOL 0 |
STARTING B EAE )R 3" BOOL 0 @)
STEP_NO BATCH: $4i'5 DWORD |0 | +
STOP H 3l 445 1k BOOL 0 |
STOPPED BAERA T BOOL 0 |o
STOPPING HAERAE B R BOOL 0 |o
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12.1 SFC K& 19tnittEE L]
I/0 =pd HImRE | BN | KR8 | 0&M
{IA

T_OPRQCA AT A R R BOOL 0 |
URAE A BN

T_OPRQG RTINS BOOL 0 0
“EER I TR HRAE AR

TARGETSEQ T &8 HbR B e | BYTE 0 (e}
¥4 5

TARGETSTEP HT & B2 2 %S |WORD |0 10

TIMEMON Il AL (A H B0 ) | BOOL 03) |l

TRIG_CPU_RESTART | CPU T# )i 8h)5 Ji shiifx 2 | BOOL 0 0
PR fih e 25

B

) | B T"SFC B IEIAS i T S UM R

) | MR T"SFC J&1E/AS iz AT S8 &
3) | HUIRT"SFC JBIEIAS isATZHU ) Al

)

)

I T“SFC JEME/AS 1847 S HUHRA R
INYT“SFC @ MHE/AS eS8 A4 HI B

SIMATIC S7 {1 SFC
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BrERE T RIEZ /O

12.1 SFC KL IbRHERE 1T

1213 REAEKEX

RIGHIAERE

TE WO F, MAEAL R E T &1 S7_visible ='true’s  1/0 7] .
FE RG] T R 948

—- 1=1IN @)

— 10 = INOUT Ui A/

- 0=0UT Uit

e B F A T R SIS

— “QFRNEE TJEME S7_link = 'true's  1/0 A LUH .

- ‘MFEREE—NMH T E ) MESSAGE ID (fflf11: ALARM_8P) . AfEH 110
SECSEG 1D i ER S 2SS .

- “BYRon ] R ] (DUl O o AE OS A TR 1O IS Vi . fE
CFC 4L T KR s o

TE“OCM™ 3, “+"FoRiE T JEYE S7_m_c ='true'. 1] A AR BRI AL 1/0.
FLIAESTEP 7 3 ") 22l | #2154 A R S8 MR 7 30
B RS R

SIMATIC S7 1] SFC
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12.1 SFC X FritEFEE ]

12.1.4  ¥FH®5IK SFC BIRME AN/ H

SFC EIZ&RrHm At
SFC A+ LA A AR 3 FC T 2328 9045 LUT 85 23 n EAREIA -
EAERSU (T 222)
i 2 MEAVEIRA (T 224)
PAT LI (1 234)
J1 5 + LN (92 236)
AL I A e A28 A (0T 237)
BATCH |Z%{ (11T 238)
G (7T 239)
AL (T 240)
THE (T 244)
P (UL 245)
RAT (UL 246)
ARG ZHL (L 252)
b (71 253)
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BrERE T RIEZ /O

12.2 SFC KA bR D

12.2.1 SFC RIFkrERE O

SFC RAIpkriEE: 0

SFC AL bt RS R (0 e 2 A\, n] HOROE

1, s SFC S AT HRAT S IR AL o

EZER
KTBNGHE AR, WS HLUN
SFC - | hpifEde L (W1 192)
38 0 SFC AL Far AW fan tf (2 200)
TRHIE R 2 g (T 202)
TR TR (0T 204)
1K SFC Sl g s il e AT F) (UL 308)
i A\ e (00 201)

SIMATIC S7 ) SFC
g FERIHEEVETIE, 03/2009, ASE02113388-01

12.2 SFC ZEZH bt 17

KL PR SFC 5

191



BrERE TR /O

12.2 SFC ZEZH 1 bpifEfE 17

12.2.2

SFC ZRRIFRUERE O %\

SFC RM. s BN/

NERLVFERIT A T SFC A bRERE 1 Itk N i .
ARBPFAFHIUH], HS % RN AR (0 189) 7>

I/0 &X HERT W % | 0&M
& it
ABORT F 3l iy 2“1k BOOL 0 |
ABORTED BrEREC P BOOL 0 0
ABORTING BARRA IEAE L BOOL 0 0
AUT PIE A5 G RO BOOL 0 |
AUX_PRO04..10 KA 4..10 ANY 0 10
BA_ADDSTATE BATCH: Btk DWORD 0 0
BA_CONTROL BATCH &1 7* (AFB#ED) DWORD 0 10 |+
BA_EN BATCH: {fifii BOOL 1 I |+
BA_ID BATCH: E4itE =45 DWORD 0 ||+
BA_NA BATCH: d#itA4:r= 4 Fk STRING " |+
[32]

BA_STATE BATCH R&F DWORD 0 o |+
BUSY W& BOOL 0 o)

(= BRZSN" “BoEps ok,

A BT IR
COMPLETE F B iy 4258 1L BOOL 0 |
COMPLETED BAERE TR BOOL 0 0
COMPLETING BARRA LA 58 BOOL 0 o)
CONT B BOOL 0 |
CONT_T “VELAE R I KIS AT I ] [8] DINT 0 |
CPU_RESTART HH1)jd 8 CPU BOOL 0 0
Cs F3): AE I HINE (N80 [INT 0 I |+

INAZED)
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I/0 aX HERE W % |0&M
& it
CS_HL P e R INT 0o1) |l
CS_LL P SN P INT 01) |I
CSP_DEFAULT Y6 (1042 1l SR s PRI 3 (1 INT 0 ||+
CSP_OP Fa): BAE RHER IPEHISRES (FE R |INT 0 0 |+
LI ISARED)
CSSPACCEPT I [l s + (i (1 AN | BOOL 0 o]
[ )
CUSEQ MR R g0 5 BYTE 0 o |+
CUSTEP BT BT WORD 0 o]
CUSTEPACTSTATE T IR IRES BOOL 0 o)
CUSTEPCOUNT W A B BYTE 0 0
CUSTEPERRSTATE TP A OIRES BOOL 0 ¢}
CUSTEPHELDSTATE MR RS BOOL 0 0
CUSTEPMAXRT i D 1) KB AT I A TIME 0 o
CUSTEPMINRT T IR s /NS AT I ] TIME 0 o)
CUSTEPRT P! TIME 0 ¢}
CUTRANS SR Ak TR WORD 0 O
CUTRANSCOUNT WOE S B BYTE 0 0
CUTRANSRESULT O TR S PRI ERE S BOOL 0 o]
CYCLEXEC e ERAE (LB ST BOOL 02) |l
DIS_START_STATE JE B TP S DWORD 0 o |+
ENABORT o 11" R A e i BOOL 1 |
ENASTART “IBAT I ) B AL R v BOOL 0 I
ENAUT PR H 57 1AL §E i BOOL 0 |
ENCOMPLETE “SE R A e BOOL 1 I
ENCSP YA TR (R ALl it BOOL 1 I+
ENFORCEMAN ik ENMAN = 0 )4 51 2 (¥ 487 RE i BOOL 1 I
ENHOLD RS e BOOL 1 |
ENMAN U3 T- 50 ()AL §E i BOOL 0 |
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I/0 &X BOERR | W % |0&M
3 it
ENRESET “53 47 F A A BOOL 1 |
ENRESTART “H e B A g i BOOL 1 |
ENRESUME PR ISAT AL B S BOOL 1 |
ENSTART “Jed Bl TR i BOOL 1 |
ENSTOP “f 11 PR A i iy BOOL 1 |
ENTARGETSTEP “BCE H bR AL RE il BOOL 1 |
ERRG YA IR BOOL 0 0
(EXT_ERR | OP_ERR | LI_ERR |
S_ERRG)
ERROR BARRAS A BOOL 0 0
ERROR_ BAPRA A GELEERD BOOL 0 o)
COMPLETING
EXEC_ERR BATHEGE, BN, DR BOOL 0 o)
EXT_ERR PANESERPS BOOL 0 |
HELD BAERE TS BOOL 0 o)
HELD_ERROR HAERE CE" S GRED 7 BOOL 0 0
HELDSEQ OB A5 A P 5 1 G 5 BYTE 0 o |+
HELDSTEP WEEEm AT RS WORD 0 0
HELDSTEPCOUNT VB 5 A0 ) 4 BYTE 0 o)
HELDSTEPERRSTATE | CL#{55 AR IR & BOOL 0 o)
HELDSTEPHELDSTATE | & {54 R4 BOOL 0 o
HELDSTEPRT BT A (A2 AT I (] TIME 0 o)
HELDTRANS TR AL (1 9 WORD 0 0
HELDTRANSCOUNT RAZEERFEAOE e BYTE 0 o)
HELDTRANSRESULT C ISR TR 2 NP BOOL 0 o
HOLD IF iy B4 BOOL 0 |
HOLDING BERE AR BOOL 0 o)
IDLE AR N BOOL 0 o)
INSTROUT Tt (AT BOOL 13) |l
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I/0 aX BIERE | % |0&M
& it
INTABORT W ik BOOL 0 10
INTCOMPLETE P iy e BOOL 0 [o)
INTERROR P BOOL 0 10
INTHOLD P iy BT BOOL 0 [o)
INTRESET AR R SR VAl BOOL 0 10
INTRESTART W T2 E A 37 BOOL 0 10
INTRESUME P A 2 IS AT BOOL 0 10
INTSTART N a2 E 8 BOOL 0 10
INTSTOP P iy &4 1 BOOL 0 10
IORES_BY O B LA A BYTE 0 [e]
IORESO..7 DR B LA A BOOL 0 10
IRES1..3 DR B Ay A BOOL 0 |
LASTSEQ S5 i PO R A2 R P () G BYTE 0 0
LASTSTEP B JE TS TR A2 [ WORD 0 o)
LI_ERR SHO A (Bl TRl E) | BOOL 0 0
LI_ERR_STATE SHR RS T DWORD 0 o |+
LOCKABORT MR LA BOOL 0 |
LOCKCOMPLETE AN e R BOOL 0 |
LOCKERROR AN LA A BOOL 0 |
LOCKHOLD AR LA BOOL 0 |
LOCKSTOP RS L 1k BOOL 0 |
MAN DIEITF5)) CBRAE A O BOOL 0 |
MODE b PRASE A BOOL 0 |
0: ZEFEIAH I OB PTG HFAb
1: {EJ33) OB WALFR Kk
MSG_ACK A 5 (ALARM_8P) WORD 0 o
MSG_ERR I EER (ALARM_8P) BOOL 0 0
MSG_EVID M E %5 (ALARM_8P) DWORD 0 |
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I/0 &X BOERR | W % |0&M
3 it

MSG_LOCK (VR EPSY BOOL 0 | +

0: VHEARBE

1: B CBE
MSG_STAT I ERA& (ALARM_8P) WORD 0 o)
MSG_SUP T 53 (ALARM_8P) BOOL 0 o |+
NMSG_EVID1 HE% 5 1 (NOTIFY_8P) DWORD 0 |
NMSG_EVID2 M E45 2 (NOTIFY_8P) DWORD 0 |
NMSG_STAT1 HEARZS 1 (NOTIFY_8P) WORD 0 o)
NMSG_STAT2 M EUIRAS 2 (NOTIFY_8P) WORD 0 o
NSIG_12..16 R 12..16 BOOL 0 10

(NOTIFY_8P)
OCCUPIED BATCH: “MHI"briRTF BOOL 0 10 |+
OP_ERR HAE DR IR BOOL 0 o)
OP_ERR_STATE B TR IIR ST DWORD 0 o |+
OPTIPNO F T84 S RS INT 0 o |+
ORES_BY1..3 D B A A AL T BYTE 0 o
ORES1..24 DR B A A8 BOOL 0 o)
PARAM For R AE g + e A BOOL 0 |
POSINO PSS INT 0 o |+
QAUTMAN MR 0: TEh, 1. B BOOL 05 |O
QBA_EN BATCH: filifEufi BOOL 0 o
QBA_ID BATCH: &4t E =45 DWORD 0 o)
QBA_NA BATCH: #tA4:/=4Fx STRING[32] | O
QCONT R BOOL 0 o)
QCONT_T SRR Y HT IS AT I ] [s] DINT 0 0
QCONT_T_ERR ji HH T S A ) d K I AT I 1) BOOL 0 o
Qcs I (R s INT 0 o |+
QCS_0 10 o SR BOOL 0 o)
QCS_1...32 10 YT RN 1 - 32 BOOL 0 o)
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I/0 aX HERE W % |0&M

& it
QCSP Y (1042 1l SR gk INT 0 o |+
QDIS_START TeVE A 8l BOOL 0 o)

R, ) S s R 4 (L 5%
LI_ERR. OP_ERR %)
QENAUT “D)H 3 H 3" 1A e i BOOL 0 o)
QENMAN “UIH 2 T3 (1AL fie v BOOL 0 @)
QEXT_ERR AP R BOOL 0 o]
QFORCEMAN TERA RS T I OL T )2 Fah i | BOOL 0 o)
GRS Tl T3, 1 AR D
QOCCUPIED BATCH: “ HI"briRfF BOOL 0 0
QPARAM Ot 7 sng + WoEM, HWIEM | BOOL 0 ¢}
QREFRESH BATCH: - IR HL B e fH /1 F Al BOOL 0 o)
QsccC K HIBRAE BN Al g BOOL 0 o)
QSCT KR RE BOOL 0 o)
QSCT_TAC KR RS 2 B E DA AR | BOOL 0 0
QSCTAC KR AR S A R A2 | BOOL 0 o]
fie

QSCTOC KR B DL A IR Al e BOOL 0 o)
QSTEP_NO BATCH: L4 DWORD 0 o)
QSTEP_T BATCH: iAisqT i) [s] DINT 0 o |+
QTAKESP 7 BRI FH 5 A BOOL 0 o)
READY_TC UL TE IR BOOL 0 o)
REFRESH BATCH: FR I BE (AL R BOOL 0 10
RESET F 3l iy & 5347 BOOL 0 |
RESTART H 8l 4“1 ) 2 BOOL 0 |
RESU_ERROR BARREEERE (A BOOL 0 0
RESUME H 3l iy & Pk s AT BOOL 0 |
RESUMING BABRES T BOOL 0 o)
RUN BAERA BT BOOL 0 o)
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I/0 &X BOERR | W % |0&M
3 it

RUNCOUNT “PEINERAE RIS AT IR INT 0 0
RUNHOLD RUN JI4 R 7 X6 8 57 f o 1 BOOL 0 |

0: FiFIFERA, 1. dbf
RUNUPCYC B A INT 3 |
S_ERRCA HNITE B ETR (UE B s ) BOOL 0 |
S_ERRG R R BOOL 0 0
SCT KR PRI Bl e (A H3) | BOOL 16) |l

S D)
SCT_TAC K H A% 5P RE € I3 DL A B s I8E | BOOL 06) |l

AR (A AT
SELCS A ) SR A i « DWORD on7 |+

55 0.31 f: FEhl e 1..32
SELFCOMP SFC HEN M\ &84T VI 2" IEAE 58 1 BOOL 1 |
SELFRESET SFC HZhM BOOL 0 |

“CLoE R Bk e

DI H” AET SRR
SFC_ADDSTATE Bt in SFC R&F DWORD 0 o |+
SFC_CONTROL SFC il (P DWORD 0 0 |+
SFC_INIT ¥kt SFC BOOL 0 10
SFC_STATE SFC R&F DWORD 0 o |+
SIG_2..8 R B 2.8 (ALARM_8P) BOOL 0 [e)
START H 3l 2 H 8 BOOL 0 |
STARTING BAEIRA IEAE A 3 BOOL 0 0
STEP_NO BATCH: D45 DWORD 0 | +
STEP_T BATCH: i K PIAT I ] [s] DINT 0 ||+
STOP 1 8l iy 44451k BOOL 0 |
STOPPED BARRE T BOOL 0 0
STOPPING BAPIRES EAE 1L BOOL 0 0
T_OPRQCA AT A I ERAE A 3R BOOL 0 |

AR BB
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I/0 aX BIERE | % |0&M
& it

T_OPRQG ZIETPIN BOOL 0 o)

LRSI R B DR

TAKESP 7 BN Ve fE BOOL 0 |

TARGETSEQ T8 H AR S IR 7 9 BYTE 0 [o)

TARGETSTEP T & B2 5 WORD 0 10

TIMEMON TR A (A B BOOL 04) |l

TRIG_CPU_RESTART  |CPU #3353 sz v ik 4 | BOOL 0 ¢}

USTATUS VSTATUS IR T WORD 0 |

CHI P T AR 5 ZEHEA T D
VSTATUS RET DWORD 0 o |+
B

) IR G A b P 14 42 TSRO B

) WkT-“SFC B YE/IAS AT S B R

) WPkT-“SFC J@YE/IAS a1 8/ &t
4) ykT“SFC J&TEIAS 1a4T 50U/ a] i A

)

)

)

Ik T“SFC J@PE/IAS a7 S BRI
B TSFC JEE/IAS iatTZ 8 45 Hilk L
I T-“SFC /32 1/ 428 1] g 1k 427
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12.2 SFC 77 bR 1T
12.2.3  ¥F®5I5K SFC RE N/ H
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SFC RALRES LKA Ay % L& 5028, IFAE LR 253823 I LAREA -

FBRERE (SFC [ A | (7T 222)

A MRS (SFC NI | (71 224)
AT RS (SFC [ NI | (5T 234)

S RIZTHA (SFC BN | (5T 236)
5 B I A5 R (SFC RN | (5T 237)
BATCH|Z% (SFCmNJil | (7 238)
VSR (SFC [ A | (7T 239)
AT (SFC NI | (52 240)

. (SFC A HD | (7 244)

Pl (SFCINIRTD | (71 245)

KA (SFCImNEITD | (7T 246)

RA B (SFC N | (3 252)

1R (SFC N | (7 253)

SIMATIC S7 1) SFC

TR FIHRAVET N, 03/2009, ASE02113388-01



BrERE T RIEZ /O
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1224 “BANEmHEO7 B

ESps kN

SIMATIC S7 ) SFC

“n N D g T DU TR O R ING OUT ATIN_OUT 43 I A /it A vr B
FI R AR

INPUT (IN 43 -

BOOL. BYTE. CHAR. WORD. DWORD. INT. DINT. REAL. S5TIME. TIME.
DATE.
TIME_OF_DAY. STRING

OUTPUT (OUT #543) -

BOOL. BYTE. CHAR. WORD. DWORD. INT. DINT. REAL. S5TIME. TIME.,
DATE.
TIME_OF_DAY. STRING

IN_OUT (IN_OUT #B43) -

BOOL. BYTE. CHAR. WORD. DWORD. INT. DINT. REAL. S5TIME. TIME.
DATE.
TIME_OF_DAY. STRING
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12.2.5

12.2.5.1

“RHIE" ¥ A 28000 i

"R D S35 i

“RRE" & D S50 i

HEEAL 5 SFC KA.
AT L 2 F B E S A
o NS (5T 202)
o IEREIA (5T 203)
o MIEIH (7 203)

12252 HFHE: “#HISRER"
“FE | SR AR E
AREPENFHBUN], 1S RRAKRS X (5T 189)# 7

I/0 & X BERE | BME | RE O&M
CS HEh: HEREEIREE (2 N IREEI . | INT 0 | +

AD
CS_LL Pl seng R INT 01) |
CS_HL b emg e LR INT 01) |
CSP_DEFAULT | #4542 il Sk ms i 4] 4 (8 INT 0 | +
CSP_OP T #BAE R s (FE R [INT 0 10 +

B H]D
CSSPACCEPT | N HI## i sk A1 B E M (1 AN I E)D | BOOL 0 o
ENCSP “YRE A% PR 425 T SR 1) A5 B i BOOL 1 | +
Qcs 24 P4 T SRS INT 0 o +
QCS_0 10 JoE i R BOOL 0 0]
QCS_1...32 10 S ET T 1 - 32 BOOL 0 O
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I/0 X LR | BiME | RA O&M
QCSP £ TR 4 1 SR s INT 0 o +
SELCS 25 ) S S A e DWORD |01)2) | +

5% 0..31 fi7:  $&iHIskmg 1..32

1) | DR TR AL G A P 12 1 S K
2) | HURTSFC Ja ML I A e FE

ARETEEZEL, WEE%
S0 SFC S s il S AR E AF] (UL 308) ¥4

12.2.5.3 TEBSCARIAE

ER AR
AES B P R SRRV SO S N, {5 SFC TR PY ) 22 G AL 03 S A
ATttt A FLIO B, 155 e 202 X (9T 189) 5

/O HX HmRA | BME KA | o&M
OPTIPNO PRAE BT RS INT 0 O +

12.2.5.4 (LB CARMIFFIE

(AR NIk R
TR N AL B SRS IN, 71 SFC B P B2 oAl M. R A7 1 SCAR
AREHEANFHBY], EHSH RIENERS X (0T 189)H 7>

/O #X HmRA | BME | RA | o&M
POSINO DB SR G 5 INT 0 o +

AREZELE, WE%
AT 2 2T SCAS RIS, B SO (5T 113) 87>
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12.2 SFC 77 bR 1T
1226  “RIE"EOT B
12.2.6.1 “RiE"#8OVE

“FHE DY R
FHIEAL S SFC JBIMIK.
BRI (KN AN CL AR BRAERR TP, R AT LUK 5 AT 21
BEAH (T 205)
LEFEAE (1T 219)
FERIE (7T 219)
ZH (7T 220)
NiArffas (UL 220)
IR 25 (7T 221)
Befid i (72 221)

i
1E NIFRFIER T, “name™{CE 1/O #FR".  IMiAFRIE ) 44 7K -
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12.2.6.2

“BOOL" %z 57

SIMATIC S7 ) SFC
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ARBGEERA A TEAE R, 5%
BOE (A A AT (0T 215) 7 50 .

A RB ARG H U],
RAF A X (W 189)#B 7>

LES

12.2 SFC ZEZH bt 17

I/0 & X R RA | BUME | RE | O&M
"name" WOEE H BhHA BOOL 0 I +
"name"_Al SUREL(EETTIN BOOL 0 | +
"name"_AQ TR BOOL 0 o |+
"name"_CS 2 T SR A 3 DWORD [01)2) [IO |+

55 0..31 7 = 2 5 1..32
"name"_ENOOP | Bf {04 /E R ya il ks | BOOL 1 0 |+
"name"_EN1OP | B (H 1" M54 s fil i sk | BOOL 1 0 |+
"name"_ENOOPP | #E#& 13 (0" i #4F 14z | BOOL 1 0 |+

i fie i
"name"_EN1OPP | #E& (¥ e (B 1" i #4F 5144 | BOOL 1 0 |+

i fie i
"name"_ERR E B AR BOOL 0 O
"name"_OP BOE (A BRAE DL BOOL 0 0 |+
"name"_OPP HERE I BOE (PR AT DL BOOL 0 0 |+
"name"_Q WE {4 BOOL 0 o |+
"name"_QP VR 2% 1) 1 o {1 BOOL 0 o |+
1) | B TR g SR DAY F 428 i SR B e
2) | MU T < > A T R o
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12.2 SFC W9 tritEF% 1
“INT"HE K3
I/0 & X HFaRRA | BME | RE | 0&M
"name" WOEE H AN INT 0 I +
"name"_Al JURELIELTIN INT 0 | +
"name"_AO I R AR i S INT 0 o +
"name"_CS 25 1) S A5 O« DWORD [01)2) |IO [+
%5 0..31 £z = =i g 1..32
"name"_ENOP T AR PRATE D428 T () AT i BOOL 1 10 +
"name"_ENOPP | % ) e (i I B AF D145l | BOOL 1 10 +
AE i
"name"_ERR WE fH AR BOOL 0 0
"name"_LL BOEMH TR INT 0 I +
"name"_HL v IR INT 100 I +
"name"_OP BOEMEIRAE B INT 0 10 +
"name"_OPP T B (B R AR DU INT 0 10 +
"name"_Q WA H INT 0 0 +
"name"_QP TREA% 1 R0 i A INT 0 0 +
B

206

1) | TR 4 s A 192 SR

2) | B T < AE >/ e I SR ) P
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“DINT”. “SOURCE”", “DEST"FI“VIA"4# KA

I/O HX BAERAE | BIAME A | O&M
"name" BEEAH H BTN DINT 0 I +
"name"_Al JUN =LA DINT 0 | +
"name"_AO TR E Far DINT 0 O +
"name"_CS 5 I SO A i i « DWORD [01)2) 0 |+
% 00..31 17 = ¥R 1..32
"name"_ENOP | & (H#EAFE Rl ffgess | BOOL 1 0 |+
"name"_ENOPP | #E4& 1 e i e 1E i ¥EH] | BOOL 1 0 |+
A GE Bty

"name"_ERR W HAS 1 BOOL 0 o]
"name"_HL wEE IR DINT DINT: 100, |I +

SOURCE.

DEST,

VIA:

2147483647
"name"_LL BEEE T IR DINT 0 I +
"name"_OP BB AHIEAE A DINT 0 IO |+
"name"_OPP WEAS I S8 (A N DINT 0 IO |+
"name"_Q T2 {H i H DINT 0 o) +
"name"_QP A% 15 S (B o DINT 0 o +

1) | B TR G4 s A (47 SR
2) | BT <R A > e PR o g ) e
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12.2 SFC B9t 11
“REAL"$#E KA
110 & X FERA | BUME | RE |O&M
"name" BOEE H A REAL 0.0 I +
"name"_Al U EE TN REAL 0.0 | +
"name"_AO AR E A REAL 0.0 o |+
"name"_CS 5 o SR ALl R i DWORD [01)2) |lIO |+
95 0..31 fi = #&HI5ns 1..32
"name"_ENOP | 15 & {1 #:F DA 42 il 1) 4 e i BOOL 1 10 |+
"name"_ENOPP | £ [ B¢ & (H 1 B4 i1 #hil{fiRE | BOOL 1 10 |+
i
"name"_ERR BT H AR 1R BOOL 0 o)
"name"_HL BT 1R REAL 100.0 |l +
"name"_LL BEE MR REAL 0.0 I +
"name"_OP BOEAERAE A REAL 0.0 0 |+
"name"_OPP | YE& MM B (E#RAE S REAL 0.0 10 |+
"name"_Q WO B H REAL 0.0 o |+
"name"_QP PR TR TR0 R A HY REAL 0.0 o |+
B

1) | TR 4 s A 192 SR
2) | B T < AE >/ e I SR ) P
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“STRING™$#E X &
I/0 & X R RAE | BOME | RE | O&M
"name" WEH H3hi A STRING |" I +
"name"_Al JUR L TN STRING |" | +
"name"_AO IR STRING |" (0] +
"name"_CS 2 T A AL 196 S« DWORD |0 1) 10 |+

55 0..31 {i = #2500 1..32

"name"_ENOP | BE5E {E#RAF 5342 1 i) A i i BOOL 1 o |+
"name"_ENOPP | #E & ) ¥ 8 H A D1 il g i | BOOL 1 o |+
"name"_ERR B R BOOL 0 o}
"name"_OP BOE HERAF R STRING |" O |+
"name"_OPP TRE2% (R B0 E (L ER A DN STRING |" 0" |+
"name"_Q e E fE A STRING |" o |+
"name"_QP 7R 25 B 0 R i STRING |" o |+
ER

1) | R TRFE S 4 s A (197l SR

2) | BT < BB A > e PR o g ) e

) | BUAAS VR IN_OUT Sl HI“STRING™ ##ii 268,  Jr LA L5 5 Ll i tH B X
S
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PrEIRAT GIEMA = HAMEHISH)

210

/0 & X et ERIME | KA | O&M
"name" BOEE H A REAL 0.0 I +
"name"_Al M EMEA REAL 0.0 | -
"name"_AO S R i REAL 00 |O [+
"name"_B B IRER 1D DINT 0 | +
"name"_BAI BATCH i PR i A DINT 0 | +
"name"_BAO BATCH il P2 {E 4 th DINT 0 o |+
"name"_BOP  |BATCH #fF Fifii A DINT 0 o |+
"name"_BOPP | #i41) BATCH #1F il DINT 0 10 |+
"name"_BQ BATCH ¥ {H DINT 0 o) +
"name" BQP | #E4%[) BATCH #fsE i DINT 0 o |+
"name"_CS 25 T SR WS A3l i S« DWORD 01)2) |10 |+
55 0..31 47 = #H6I5%mg 1..32
"name"_ENOP | 15 & {1 #:F DA 42 il 1) 4 e i BOOL 1 10 |+
"name"_ENOPP | #4158 I AE i ¥l e | BOOL 1 10 |+
ity

"name"_ERR BOE H AR 1R BOOL 0 o)
"name"_HL B E LR REAL 100.0 |l +
"name"_LL WEE N REAL 0.0 I +
"name"_M “WRl e fH STRING[16] |" ' +
"name"_MAI “Wrkl i PR N STRING[16] |" | +
"name"_MAO | “WrRl" il FE{H iy STRING[16] |" o |+
"name"_MOP | “MJkP#lE R STRING[16] |" o |+
"name"_MOPP | #E# [{)“Yrkl 4 /E B4 STRING[16] |" o |+
"name"_MQ “WPRE B A STRING[16] |" o |+
"name"_MQP | #E& 1 PRl B STRING[16] |" o |+
"name"_OP BEE (L BRAE DL REAL 0.0 10 |+
"name"_OPP | ¥E& B (IR A REAL 0.0 0 |+
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I/O HX HyERE BRI 2K | O&M
"name"_Q B REAL 0.0 ) +
"name"_QP 2% 1) 15 (B % L REAL 0.0 ) +

1) | B TR 4 s A (47 SR
2) | WUk T <uoE (> @ R o)

‘POHHERA G = F= 6. B MANR&RSED

/0 & X HRA | BME KA | 0&M
"name" BOEH H B REAL 0.0 I +
"name"_Al SURELIEE PN REAL 0.0 | +
"name"_AO TR AR REAL 0.0 o |+
"name"_B BOE(HIER ID DINT 0 | +
"name"_BAl BATCH i R KA DINT 0 I +
"name"_BAO BATCH it #2184 DINT 0 O +
"name"_BOP BATCH #4F i A\ DINT 0 10 +
"name"_BOPP | #E#(¥) BATCH #:/E i\ |DINT 0 o |+
"name"_BQ BATCH % & fE DINT 0 O +
"name"_BQP #E£5 1Y) BATCH el DINT 0 0] +
"name"_CS 125 T SR AL i i DWORD 01)2) |0 |+
55 0..31 fi= 5% 1..32
"name"_ENOP | 5@ fE #AF 03 4 il (1) 4 g i BOOL 1 10 +
"name"_ENOPP | #4510 E B A 5 | BOOL 1 0 |+
HE St

"name"_ERR WOEH T 1R BOOL 0 o)
"name"_LL BOEH B R REAL 0.0 I +
"name"_HL WOEE R REAL 100.0 I +
"name" M YR BEE A STRING[16] | " | +
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/0 & BOERRE  |BUAME | KE | 0&M
"name"_MAI E/LS SR ELEE PN STRING[16] |" ' +
"name"_MAO | “¥pkP ik Ffeidn STRING[16] |" o |+
"name"_MOP | “Ypkl"#/E BN STRING[16] |" o |+
"name"_MOPP | #E& Pkl 4 LA STRING[16] |" o |+
"name"_MQ YRl e STRING[16] |" o |+
"name"_MQP | #E& 1 PR B E A STRING[16] |" o |+
"name"_OP BOEAERAE A REAL 0.0 0 |+
"name"_OPP HEA B0 E (L ERAE BN REAL 0.0 0 |+
"name"_Q WEE {4 REAL 0.0 o |+
"name"_QP THE 2 110 e (L B REAL 0.0 o +
B
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“TKEY"$i35K R
I/0 & X FERAE | BRAE KA | 0&M
"name" BOEAE H 3 DINT 0 I +
"name"_Al U EE TN DINT 0 | +
"name"_AO AR DINT 0 o |+
"name"_CS 5 o SRS Al R i DWORD 01)2) o |+
55 0..31 i = 435l sk
1..32
"name"_ENOP | & (EH#AF R HInfaE | BOOL 1 0 |+
iy
"name"_ENOPP | #E & I3 e (H M #4F i ds | BOOL 1 0 |+
AL R
"name"_ERR WOE(HHT 1R BOOL 0 o}
"name"_LL WEE MR DINT 0 I +
"name"_HL BEE PR DINT DINT: 100, || +
SOURCE.
DEST.
VIA:
2147483647
"name"_OP BOEAERAE A DINT 0 0 |+
"name"_OPP HE& IV e AR LN | DINT 0 0 |+
"name"_Q WO B DINT 0 o |+
"name"_QP £ TR TR0 R A Y DINT 0 o |+
"name"_ID “f1% 1D” A BN STRING[16] |" | +
"name"_IDAI “f3% ID"IEFR(E TN STRING[16] |" | +
"name"_IDAO | “f¢i% D"t Fi e 4 STRING[16] |" o |+
"name"_IDQ “fe 1% D" BEE H i STRINGI[16] |" o |+
"name"_IDQP | “fLi% IDMERINBE S | STRING[16] | " o |+
th
"name"_IDOP | %iE (1t i STRING[16] |" o |+
"name"_IDOPP | Y& I BEEIRIE S | STRING[16] | " o |+
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12.2 SFC X9 briEE ]

/0 X HamRA BRINE %A | O&M

"name"_C “f3% COUNTER”Hzh%i |DINT 0 | +
N

"name"_CAl “f£i% COUNTER' I FE{H | DINT 0 | +
LTPN

"name"_CAO |“/.i% COUNTER’IIFi{H |DINT 0 o |+
i

"name"_CQ “fi% COUNTER’#{7E{ |DINT 0 O |+
i

"name"_CQP “fi% COUNTER MES ) | DINT 0 o) +
aELIER T

"name"_COP | BE {HiR/E LA DINT 0 0 |+

"name"_COPP | ME& B EHE/E iif A | DINT 0 0 |+

B
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12.2 SFC ZE7H bR 1T

12.2.6.3 BEMERE XAEH

pa kNG
DU RS T T BOE A, R AR T, A f ol thas th T AN
WEE

MR ER A TR T Rsebrid e, RRE T LUKk B R Bt S e R
TG A A A A

HIERE |10 & X
TP
A .. Al SEBRE A
PI ..._BAI FRIEE 1D SERREAA
PI e MAL | PRLSE RN
TKEY .._IDAI | f£3% ID SEFRMEHIA
TKEY . CAl [ EIETH R S PR EA A
g
A .._AO S B R
PI ...BAO | EE 1D SEFR{H it
PI .. MAO | VKSR {H i
TKEY .._IDAO | f£1% ID SZhr{f
TKEY ...CAO | LI THE 2% Sz br i i th
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12.2 SFC ZEZH 1 bpifEfE 17
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HESHI B E

T AT A N BOEER AL, HE T NP R 3h SFC LB IRAE AT 17
n LAfE SFC [ 1 “#E % {5"(Prepared Values) #LIE 1 4 Fah AT HLSH. #Ew (A

B RR 110 X
TN
Eaetl BOEE B3N
el OPP BT (HARAE DU A ME &
Pl. PO ..._BOPP PRER 1D BOEAAERAE DL N
Pl. PO B PRER 1D e H B 3N
Pl. PO M YIRS E(E A B
Pl. PO ..._.MOPP YIRS E (EHERAE 5 A HE 5
TKEY _ID 3% 1D BEAH H 3hi A
TKEY ..._IDOPP 143% |\D BOEMBRAE DL TR
TKEY C AL TR BOE M H B
TKEY ..._COPP F i TH B B (PR DU A HERS
it
el ._QP A BEHHER
Pl. PO ._BQP PRER 1D A 3B e HAE %
Pl. PO ._MQP PIRHT ROBE (R e %
TKEY ..._IDQP 143% 1D 7308 (HHE
TKEY ._CQP Pk VB A BT (A%
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12.2 SFC ZE7H bR 1T

¥ 7 BV B % s
P S B NY HE R T A2 TF o s e E A e ERZET, @8m
# TAKESP i
BATE F BT LAAE SFC AR 1“4 HI{H”(Current Values) #LE #7244k, 4
B A3 B
BERR I/0 X
TP
A WOEE A3
ey .._OP BOEHERAE N
Pl. PO .._B PRI 1D BEAH H 3l
Pl. PO ..._BOP PRER 1D BOEEERAE N
Pl. PO .. M Ykl e A A
Pl. PO ..._.MOP YIRHOEAE A DU
TKEY .._ID 3% 1D 1 E(E B 3l
TKEY ..._IDOP 1% 1D BE (IR S
TKEY .. C PR VRS vOE fH A SN
TKEY ..._COP AL THHE B (H B A DN
Efin
A .._Q MHTE
Pl. PO .._BQ PRER 1D AT E(E
Pl. PO ...MQ YR 4T OE (A
TKEY ..._IDQ fE1%5 1D T BOE(E
TKEY .._CQ PR VRS T e (H

SIMATIC S7 1] SFC
A FERVETET, 03/2009, A5E02113388-01 217



BrERE TR /O
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BAERAERE (T3 B EKEEAEEO

RABE T RN RAERE, A ReAE ol M s R Biois e (-

BERR I/0 & X
PN

BOOL ..._ENOOP BT 0" B AT 53y A\ IR A8 R
BOOL . EN1OP | B (1 E A E DA % A\ 1) A i o
BOOL ..._ENOOPP | B {H O #A1 b i N VHE 46 RO fik i
BOOL ._EN1OPP | B0 fH 1 B A D N TR 46 1) A e i
¥ BOOL 41t | ..._ENOP BEE (EARAE DL\ 1R A e i
AR

¥ BOOL #h i |..._ENOPP | B&E (EERA: b 5 A HE % 1048 B
AR
A R E

B ELAE 5 SR BEE A BRFIVE FE N, B S BRI A RER FH R84 0 ar ) o 2R
SUFARIIE, WAE <sw>_ERR i th Ao A Az S FRAME A 12, 110 52 5% 00 1) il 75 4%

TRFEAAR,
BERR I/0 X

TN
% BOOL. STRING #MUFT |..._LL TRR
AR
% BOOL. STRING 4MffT |..._HL BR
AR

far
¥ BOOL. STRING #Mffff |..._ERR B 5 A 1R
AR

A ) S 2 S

<sp>_CS i NAL HIEAELE SC T 70 Mo g BUAT 42 B SRS O BOE B TR AR ¥ e 11 BE

B RA L 48 SFC TR LA NV 24 i e 6 47l SREmes

S BCHAR L . AEBCEME NS

J& 7" (Object Properties) X iFHEH A4 A\ <sw>_CS 7S 40,

SIMATIC S7 1) SFC
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12.2.6.4 “SEREESHE

12.2 SFC ZEZH bt 17

110 =P BhEkA | BRAE | KR | 0&M
"name" TFERT A BOOL 0 I
INT 0
DINT 0
REAL 0.0
STRING |"
HREPEANZHIPH, 1§55 BN ERS X (0T 189)i 4
12.2.6.5 “IEHUEFE
“PEHIE AT
110 X ¥ERA | BRAE | KR | 0&M
"name" EANHIRER Ay BOOL 0 o]
INT 0
DINT 0
REAL 0.0
STRING |"

AREPEANFHUY, HSH REAERS X (0T 189)#E7)
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12.2 SFC ZEZH 1 bpifEfE 17

12.2.6.6 “SEFHE

I/O HX HEERE | EBIME | KA | O&M
"name" ZHE N BOOL 0 I

INT 0

DINT 0

REAL 0.0

STRING

AREPEANFHV, HSH RBEAERES X (0T 189)#E7)

12.2.6.7 “DLAFRERERFIE

/0 aX KRR | BRME | KA 0&M
"name" frfrfifids (FF& VAR X0 BOOL 0

INT

DINT

REAL 0.0

STRING
B

RAFft s e WA R, I DAOEAME AT 11O WondEse i e ITlA, ik Ad ) an
0" (Browse) X T HE B 1 94 43 55 T BUE D IR SR ML R i A A& 258 A
SR ARLAFAH AR /O FAFR.
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12.2 SFC ZEZH bt 17

12.2.6.8 “SENT"FE

/0 X KRR | BAE | RE | 0&M
SAMPLE_T DA Ay BT (R AT 55 KA N T REAL 0.0 |

CRRARRD AR e TS e ok AH DG T

IEEALSED)
"name"_MODE | #4FAx INT 2

0: Jashfkh I E I #5“Pulse”
1. 330y R Rk I e i 35 “ExtP”
2:  JHBhLIE GEIR A g ) 2

“OnDel”

3:  JABh ORI A ) I IR Y SE I

#+“RetOn-D”

4:  JAZh KW EIR A E I 2% Off-D”
"name"_TIMEO | IfIH{E, HA7F0 REAL 1.0 10
"name"_RESET | &1 BOOL 0 10
"name"_I0 LPANG oL BOOL 0 10
"name"_QERR | % BOOL 0 o]
"name"_QO0 iyt P BOOL 0 o}
"name"_PTIME | FlR IS TEE, 4780 REAL 0.0 (0]

ARBHEAFHIUN], 35S R AR X (0T 189)f 7>

12.2.6.9  “BRfih j5 AT

FSAE R, AT 225 Bl (5 115)7#69)
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12.3 #2117 2619 SFC Fp A /Hi it

123  #HH®B3EH SFC fAf
12.3.1  BEB (SFC #As)
BRI SFC S /H
1 RER ALK H U, 155% RN X (T 189)H4

I/0 X PomRR | BRUME | KA | O&M
ENAUT “DIH B A B A R v BOOL |0 |
QENAUT “DIH 3| H 2y (A% B ity BOOL 0 o
AUT DI H 2 GO BOOL |0 |
A OB R A B | A D ) [ st GO
2
ENMAN “DI4 3 TF )" 14 R i BOOL |0 I
QENMAN “DIH 2 T30 (A8 BE i BOOL 0 o
MAN DB T2 GRAE AP b)) BOOL |0 |
FAE R RN T [ A DI 2 F At (B s il 2O
2y
QAUTMAN AFHRAERGC: 0 T3, 1. [ BOOL 0%) o
QFORCEMAN e RS 5 I O0 T e 2 T30 (A4 | BOOL 0 @)

FanflTFah, Fg 1 ARYD
B

*) HY ye T-“SFC J@ :/CPU 1847 S8/ A Efi
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12.3 15115 779519 SFC I A /% i}

TEHE O I AR
R J=JiiE= B3 VIE: ] TR
0=F% > Fzh->Hzh |0=Fzh
1= B3 1= H7)
QAUTMAN ENMAN | QENMAN |ENAUT |QENAUT |MAN AUT QAUTMAN
0 X X 0<->1 |0<->1 0 0 0
0 X X 0 0 0 1 0
0 X X 1 1 0 1 0->1
1 0<>1 |0<->1 X X 0 0 1
1 0 0 X X 1 0 1
1 1 1 X X 1 0 1->0
TR R AR R ERR (SFC WABR/SFC ATRLAL)
LR JaFEFEhE3h Ik T— Ak
> F3h -> B3

B B+ FEhH ghd | BT

“Lock™ &4l
T3 Kb+ il KW Hih wHEs i R | 8
T3 $TIF + M F . if; %) T
EE) Kol + il Hih Wi rFaEsEL R | 8]
[z $TIF + M Bk Wi T3 B

SIMATIC S7 ) SFC

“padlock”ff fit i 41 i4 27k QENMAN 1 QENAUT (PR %S .

IR BAT R AL RE S, WA B SR FEh DI fe b, R E A A

QFORCEMAN #itt .

g FERIHEEVETIE, 03/2009, ASE02113388-01

223



BrERE TR /O

12.3 #5018 702517 SFC g A /4yt

12.3.2

& FERAEIRES K SFC F A/t

FAREPEAFH U], HS

“BE” (ERE. frd s FERERE

S FERIMERE (SFC BANAHD

2 RN AR S (0T 189)#4>

I/O HX BHEEA (BRAE B
ENSTART “ et Bl ) R it BOOL 1 Q
ENASTART “TBAT I A Bl R4 e i BOOL 0 Q
QDIS_START | LiE“Bs8h” BOOL 0
(flf1, LI ERR. OP_ERR...)
START H a4 A 8" BOOL 0 Q
“Jet B Fahr A )8 a4l
VTN
R4y
INTSTART P 2 E B BOOL 0
STARTING BEERS B ) 8 BOOL 0
€:322/N
RUN RS BT BOOL 0
(FE“IEAE A8 2 )5)
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“EE (fERE. 4 FERAERE

12.3 15115 779519 SFC I A /% i}

110 X BympRm | BIAE | KR
ENHOLD BT A5 P A FE i BOOL 1 I
HOLD H a8l 2 g e BOOL 0 |
B Fah a2 B 5 424l
IRTIN
oy
INTHOLD P R i 2 {5 BOOL 0 10
LOCKHOLD AN LB BOOL 0 I
HOLDING A EIRES B BOOL 0 o)
(IR
HELD HHRERAS B BOOL 0 (@]
CEE“TEAER " 2 05D
“REIEAT (ffRE. W4)
110 X Bampr | BRAE | KR
ENRESUME WA IE AT IR A e i BOOL 1 |
RESUME H 8 2 Ik Zis17” BOOL 0 |
‘Wiz T | Faha 2 Ik & as AT e
FE IR
Hiig
INTRESUME Wi 2k R IEAT BOOL 0 10
“BEERERS THREIZIT (FrfERD
I/O X HyEpm | BIAE | KA
RESUMING RS AR R BOOL 0 (0]
(FERIRZS)
RUN RS BT BOOL 0 (0]
(FEIEEW R 2 )5)
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‘BEE R "BERETRREBT GrgfBRE

“ub” (fERE. Ard s FERIEPIRE

“SER (fERE. A FERAEPRE)

226

I/O EHX BHERA | BNE | R

RESU_ERROR | Btk BOOL 0 0
“TEAEWE (HAS 7 GEIEPRAD

RUN R R (N e BOOL 0 0
FE“IEAEIRE (D "2 5)

I/O EHX BHERA | BRNE | R

ENABORT “HR R4 RE g BOOL 1 |

ABORT H sl & k" BOOL 0 |

“ep Falhar A e b el

TN

Ty

INTABORT Pl A B BOOL 0 10

LOCKABORT A R e o BOOL 0 |

ABORTING RS B R BOOL 0 0
(FERIRZED

ABORTED PrEreRAs eI BOOL 0 0
FE“TEAETR IR 2 J5)D

I/O HX BHERA | BNE | KRR

ENCOMPLETE SR A BE bty BOOL 1 |

COMPLETE H a8l 2“5 1% BOOL 0 I

“SERC Tl A 1“8 1 F L

TN

TRy

INTCOMPLETE P iy 2 “5E il BOOL 0 10

SIMATIC S7 ) SFC

TR FIHRAVET N, 03/2009, ASE02113388-01



BrERE T RIEZ /O

12.3 15115 779519 SFC I A /% i}

I/O EHX BAERAE | BRNE | KB
LOCKCOMPLETE | 4B H. 81458 BOOL 0 I
SELFCOMP SFC AN IZAT P2 IEAESE” | BOOL 1 I
COMPLETING BRSBTS (FBIRE BOOL 0 0
COMPLETED HHEAEIRAS B e (FEIFEAESE "2 | BOOL 0 o)
J&)
YR (fERE. . FrERERS)
I/O X BAERA | BRINE | KB
ENSTOP “fo 1B A A BE g BOOL 1 I
STOP H 3l 2“5 11 BOOL 0 I
“f 1B Fahar A 45 k"4l
FAIRTIN
i
INTSTOP A i A 158 1k BOOL 0 [}
LOCKSTOP AN EA A5 1 BOOL 0 I
STOPPING RS IEAE A 1 BOOL 0 0
(IR
STOPPED BRSO IR BOOL 0 0
(FE“IEAEAF IR 2 J5)
“BR3N" (EFE. e FEfERES
I/O X BHERA | BRNE | KA
ENRESTART “HL A7 IS BE g BOOL 1 I
RESTART Hahan 2 E ) 8" BOOL 0 I
“HL A 8 FEhanA A s 14
RPN
a3
INTRESTART A i 2 EL i ) BOOL 0 10
SIMATIC S7 ') SFC
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12.3 #2117 2619 SFC Fp A /Hi it

I/O X BAERAE | ERNE | R

STARTING HEEIRAS B A 8 BOOL 0 @)
(RS

RUN FEREPIREEAT (B 2 8 s BOOL 0 o)
(A "2

“BA (fERE. rd. FiEfERES

I/O X BAERAE | BN | SRR

ENRESET “I2 AL B A BE it BOOL 1 I

RESET H s 2“2 A" BOOL 0 |

U TEhm A M R AL

VTN

R4y

INTRESET W a2 A" BOOL 0 10

SELFRESET SFC Az B se/eib/efs k)4 | BOOL 0 |
BN NAETFah )

IDLE HHEER S S N BOOL 0 0)

“HE” (fFRE. 4

I/O X BHAERAE | BRNME | RH

“HABE 92 1 FHm 2 AL

RN

Hh4y

INTERROR R iy 4 BOOL 0 10

LOCKERROR | #lB A 4 BOOL 0 |

228

SIMATIC S7 ) SFC

TR FIHRAVET N, 03/2009, ASE02113388-01



BrERE T RIEZ /O

12.3 15115 779519 SFC I A /% i}

FFEETRRIERE T R B GREIERE

110 X HEAR | BIME | KR
ERROR FHHEAEIRES B (FBIR) BOOL 0 0]
HELD_ERROR | B fERaS s (HEs) 7 (FE“HEE” | BOOL 0 0]
2 J5)
“IEEESERBERES TR HE" (FrRfERE)
110 X HEAR | BIME | KR
ERROR_ RS BOOL 0 O
COMPLETING “HEF QEESERD " CERBIR
)
COMPLETING “HEF QEESERD "EHEfE | BOOL 0 (®)
RSB (AR
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12.3 15115 779511 SFC I A /% it

A L A BRAEIREZRAC KRR
LEFEHIR /s 34338 1 H LRI )7 SFC_CONTROL 4t A\ “Start,..” T34, I HAER

1Rt LR AL
XA 23 TR SFC_STATE R (M EN.. I RERS DL FR/ERE=CR
S (RINY

o TEHZNT, T A LA .
o AETHHEN, RIRERENRIIRIITOL, AhE 5 T 2R X 2 iy & 2

EASBERT, AR ENSTART, ... BT S0P A &M A START, ..."o {4 X )
BRAEARAS Yo BT A VFIAT X 28 Ry &«

ARIEEBEZER, 2% BAIRE (5 279)# 7).

AEAEREAS ST, AEASIM T T A LOCK fir % MRAE T (AR UE
T VAT IX i %

AERERERS LT, A2 AT BRI 2RI INT drd. AL TR a2,
PATSEREE R AL, MRS 1 (ARG e 2 5 R VFIATIX i %

e E R g I ERR 7S S AR

QDIS_START

K QDIS_START BE Ny O A RTLAEAT RZ” (AW “B117. "B’ B
IERAEHD .

ARUETEHEZHEL, HS% RBRAEH (7T 240)787)

ENASTART

£ RUN BT, AR ENASTART BCE 0l 1 Il 2 T A0, AT LR 3h"
Azt CONT =1 (4450 H

READY_TC =1 (RUN W52 7 CL 48 58 1

WAEBE“READY_TC:=1"2 J=)

ARETENEZFEL, H2%
SFC (BZRusEfil) {)a 825K (0L 299) 7

SIMATIC S7 [t SFC
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12.3 15115 779519 SFC I A /% i}

FEER INT @54 ([UHF SFC B%)

I/O X BympRm | BIAE | KR
INTONOFF W EB 2 “F1 1% A SFC”, BOOL 0 10
1: %T}:I:’ 0: %lﬂ—‘l

fEfEbdn 224 T 5 SFC V5.2 (<SFCname>.EN) 3t %%, &2 H T2 8hEr.

i 8
7E V6.1 DL R AT, 1/0 INTONOFF A2 n ] SFC KA, i ks Hkoh %
(IORESO0). HAZEMI%F INTONOFF [#yijs i) L2 3 4 by SUA H %

J& F SFC (INTONOFF=1)

/O X BAEARR | BOME | KA

ENSTART i )" ) e i BOOL 1 |

STARTING BB IEAE A 3 BOOL 0 O
CHR IR

RUN Hrigfeikas a1 BOOL 0 O
E"IEAEJR B )

#:H SFC (INTONOFF=0)

I/0 X HERA | BOAME | KA

ENABORT “rf BT R A i i BOOL 1 |

ABORTING HERAEIRE IEAE T R BOOL 0 o}
(IR

ABORTED FrERE Ol BOOL 0 o}
(FE“TEAE "2 J5)
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READY_TC

BUSY

232

/0 X BymRA | BME | KA
READY_TC | ‘W& 5e iR BOOL |0 0
BUSY R BOOL |0 o)

(= FRZW Do Tk,
AR EHID

i AR ¥EEE 11 READY_TC (ME# 580 #inili, SFC {E SFC Ml L2 ¥l #s 2 e fit 1
— AT RS IME S, SN BAT B IEAE e B . WIS AT CPAT o8,
SEUL, AW FR 7 (1) )8 2 4 AR B JE B RE P O 58 2404 T, SFC &%
READY_TC &A1 AE KA, ] D& 0k & READY_TC. iXFfRI
AR AR, FRRSEPr SFC Tk, (4 E T READY_TC Hithi, FE#EHIgA4
] SFC K&t e i 4 -

WMHRH TS EERE (. mFesgp. “gs s e . WEE READY_TC =
0. Wi SFC CVE T8 5 R )G N 4ksl, W READY_TC A& A AL BIZERIE, M
JETREF N 0, BIoh SFC AN F 4k s & 75 )RR 2 READY_TC = 1 4. 7EiX
PG OCTE, TH TR 1% 47 7 IEA AL B READY_TC.

BUSY =1 45/~ SFC [E“>”, W& )55, %G5 T SFC V5.2 A HAR A b H T4
1% <SFCname.EN> 155,

WRA A4 (. S-Rar RG22 RN HERAERE, W 25 Bos B,
(LILERR=1), RZ¥ASPATLEMS, BHENPITH L.

St
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G B AR E AR s

I/0 & X HOERR | BRIME | RA
ENTARGETSTEP | “¥x & HAr L1 GE i BOOL 1 |
TARGETSEQ T3 B H bR b IR R G BYTE 0 10
TARGETSTEP T BB H bbb g WORD |0 [e]

{fH ENTARGETSTEP, W UUIEFA0 T H e H 22 Hbn b Fah it s (5IHER
“EN..AHE, INVEFEER TS o« ENTARGETSTEP X2 211 H bx 25 B 520

{iH TARGETSEQ F1 TARGETSTEP, 7E/if=fe)rN Hagk &N Hirb. B4R EN
Hbr ¥ = AT .

W
=

Z A i 2 HERARF AT A (T 301)

SIMATIC S7 1] SFC
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12.3 15115 779511 SFC I A /% it

12.3.3  PUTEIN (SFC I A/EmH)

PATIEDI SFC N/

AREPEANFHV, HSH REAERS X (0T 189)#E 7>

I/O EHX BHEE | BRAE | RE
i
CYCLEXEC TR ERE (X EB) BOOL [02) I
DEAERE B IR EAE (XFaR) 02)
SRy
RUNCOUNT “DEI A I8 AT IR B INT 0 0
INSTROUT & (XA T BOOL |[13) I
“Er ARSI | ET: A 13)
SRy UNFHE T
TIMEMON I AL (A E B0 ) BOOL |04) I
USR] W R R | R ISR AR 04)
BoRE UNF )
SCT KR Dy IR DA R BOOL |[16) I
UNAE H BT )
SCT_TAC KR TG 5 R AE BN 2E (S | BOOL |0 6) I
UNHE BT )

SOPRHIREH | MANUAL:
B ™05 T: SRR Sy HI S R T 6)

Tk O: RAFEBEREE RN

T5H O: RAFEBMEAE QD HI

AL AlfE

O: KAHEAE Rl LAl

TIT 5 O: RMEBFDR e 8E il

I DA R
QScc K EAE AT e BOOL |0 o)
QSCT KR LA BOOL |0 o)
QSCT_TAC KR R0 52 BOERE BUA R 2B e |BOOL |0 0

234
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12.3 15115 779519 SFC I A /% i}

I/O HX HyEEr | BRIAME | RA
i
QSCTAC K H R FAEEAE B R0 |BOOL |0 o
Hb
QSCTOC KR BERAE A HIe 20 [BOOL |0 0]
Hb
RUNHOLD RUN 42 B2 7 0 8 452 iy 2 1R W) J0 BOOL |0 I
0: F{EMifsfee, 1. bR e
SELFCOMP SFC BN “EA7 V) B IE1E 58 BOOL |1 |
SELFRESET SFC Haj\“Cse/ b ib/efEiE"Y)# | BOOL |0 |
" NAETF- 80T
B
2) | By T“SFC J@TH/AS 21T S HUMER EAE”
3) | T“SFC JETH/AS 2175 8am Ak
4) | B T“SFC JEME/IAS 1217 S 8/ 18] WAL
6) | BT “SFC J&PE/IAS 1725 D iR
SIMATIC S7 1] SFC
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12.3 15115 779511 SFC I A /% it

12.3.4

HERMARMIN (SFCRA/HIHD

H BRMARIAK SFC A
ARBPSAFH U], 555 R AR (0 189)#7)

236

I/0 T FIERA | BRME | KR

S_ERRCA HIAFTA (204 R BOOL |0 |
UXAE H BT

S_ERRG Y R BOOL |0 o)

T_OPRQCA A ITAT (A B 4o BOOL |0 |
UXAE AT

T_OPRQG TN BOOL |0 o)
BRI IR A AR

“BABTA bR | A S A BT D R R BT A A

BRIy AR

SIMATIC S7 1) SFC
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12.3 15115 779519 SFC I A /% i}

12.3.5 SAEMIEETFRZHEYE (SFC IA/AH)

e A2 ) IRFEAR PP A0 IR0 I SFC B\ i
ARBHEAFZHIUN], 55 % R AR X (0 189)i7)

110 & X PR RR | BME | KA | O&M
CUSEQ MR ) g0 5 BYTE |0 o |+
CUSTEP BT BAIE TR WORD (0 o]
CUSTEPACTSTATE P IR BOOL |0 ¢}
CUSTEPCOUNT W A i B BYTE |0 0
CUSTEPERRSTATE G R OIRES BOOL |0 ¢}
CUSTEPHELDSTATE R R IRES BOOL |0 o)
CUSTEPMAXRT D 1) KB AT I TR TIME 0 o}
CUSTEPMINRT T IR s/ NBAT I ] TIME |0 o)
CUSTEPRT MR I ATIN ) TIME |0 o)
CUTRANS TS S WORD [0 o)
CUTRANSCOUNT WOE e B BYTE |0 0
CUTRANSRESULT C i S 2 INERP S BOOL |0 o)
HELDSEQ OB {52 s P 5 [ G BYTE |0 o |+
HELDSTEP CEE 2 9 WORD |0 o)
HELDSTEPCOUNT CE = B BYTE |0 o
HELDSTEPERRSTATE | /55 (KA IR BOOL |0 o)
HELDSTEPHELDSTATE | &L {55 (IR BOOL |0 ¢}
HELDSTEPRT VB 15 20 IR AT I (1] TIME |0 o)
HELDTRANS WE R AIUE RS WORD |0 o)
HELDTRANSCOUNT VB 5 B 1 4 BYTE |0 0
HELDTRANSRESULT | &—ANCE S H B4R BOOL |0 o)
LASTSEQ S5 WO TR 2 A 1 () G BYTE |0 0
LASTSTEP I JE TS TR A0 B e WORD |0 o)

SIMATIC S7 1] SFC
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12.3 #1387

12.3.6

B9 SFC Hi A /it

BATCH &% (SFC #jA\/&H)

BATCH Z4i) SFC A\ /41t

238

FAREPEAFH U], HS

2 RN AR S (0T 189)#4>

/O X BRRE  (BOME KRB 0&M
BA_CONTROL |BATCH ##7 DWORD 0 10 +
*) (NHBE D)
BA_EN BATCH: f#fu BOOL 1 | +
BA_ID BATCH: &EZ:AltE/~%'5 | DWORD 0 | +
BA_NA BATCH: it/ STRING[32] |" | +
BA_STATE BATCH JRA&F DWORD 0 o) +
OCCUPIED BATCH: “/ FI"bRiRFF BOOL 0 1 *) +
10..**)

QBA_EN BATCH: {fifiEi BOOL 0 o
QBA_ID BATCH: #4:Alt4:/~%* | DWORD 0 o)
QBA_NA BATCH: kA= 4%k STRINGI[32] |" o)
QOCCUPIED  |BATCH: “& I"bRiR4F BOOL 0 0
QREFRESH *) |BATCH: fHABERBEEM/AS |BOOL 0 0]

FRAH
QSTEP_NO BATCH: 45 DWORD 0 o)
QSTEP_T *) BATCH: Mibig T [s] | DINT 0 o) +
REFRESH *)  |BATCH: - /isi i E{t/it | BOOL 0 [o)

FRAH
STEP_NO BATCH: l4i's DWORD 0 | +
STEP_T*) BATCH: I K Bia 4TI [s] | DINT 0 | +
BEA
*) & T SFC 287
**) & T SFC K%

SIMATIC S7 ) SFC
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FrREBE LRI Z /O
12.3 15115 779519 SFC I A /% i}

12.3.7 &K (SFC HANMEH)

HEEEBEK K SFC #E#
ARBHEAFZHIUN], 55 % R AR X (0 189)i7)

I/0 X PomRR | BME | KRR
CONT LR BOOL |0 |
CONT_T*) LRI B RIB AT I ] [s] DINT 0 |
QCONT *) SR BOOL 0 o
QCONT_T *) LRI Y T AT I ] [s] DINT 0 0]
QCONT_T_ERR *) | 8 H XA A 1) 5 KIS AT I (1] BOOL 0 0
ENASTART “IEATIR A B A R BOOL |0 |

*) & T SFC %A

ARSI SFC Z MK MERI U], 2%
AR (T 286) 177

SIMATIC S7 1] SFC
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12.3 #2117 2619 SFC Fp A /Hi it

12.3.8 4R (SFC #AEH)

FRALFER) SFC S/

AREPEANFHV, HSH REAERS X (0T 189)#E 7>

I/O X Famrm | BRAE | R

ERRG iR BOOL 0 0]
(EXT_ERR | OP_ERR | LI_ERR | S_ERRG)

EXEC_ERR BATHESR, B, DR BOOL 0 0

EXT_ERR AR AR BOOL 0 |

LI_ERR S A BOOL 0 0]
(. ToRIEI AL S

OP_ERR Ak AR BOOL 0 0]

QEXT_ERR SR (= EXT_ERR) BOOL 0 o)

QDIS_START JeE B & BOOL 0 0]
(#fltn, LI_ERR. OP_ERR ...

240
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12.3 15115 779519 SFC I A /% i}

& LI_ERR #1 LI_ERR_STATE
H3)

I gms (fX SFC 2:#1)
QPARAM = 1 [ 48 A 15 1] S s -

A7 0 — 2 Al 7 i S PR (CS > CS_HL)
A7 0 — A i S PR (CS < CS_LL)
£ 0 — A EFE TS (CS_LL > 0) Jf HAE# £ 5ng (CS) A5 H (SELCS)

BEf (X SFC 2841
QPARAM = 1 I A5 75 15 e {1 :

71— R e LR (<setpoint> > <setpoint>_HL)
71— A EE N (<setpoint> < <setpoint>_LL)
71— REREME LR < TR (<setpoint>_HL < <setpoint>_LL)
H 34

fi7 2 — [FIWA Z A4 (Flan: START #1 HOLD %)

£ 3 — RN DI T2 A A 2 (MAN =1 AT AUT = 1)
PATIE I :

{74 —SCT =0 1 SCT_TAC=0

{74 —SCT =1 F1 SCT_TAC =1

MANUAL

SIMATIC S7 ) SFC

AT IR

fi7. 5 - SELFRESET = 1 FI“fEIA VB 42 HIAN o34
(BEA#AT SELFRESET, WAFATIHHERIE

P By 40 B8 L4

i 6 — [ARAHZ A WG4 (Bilin: INTABORT A1 INTCOMPLETE) (1 AN&E#D
P17 — [ Z AN AL (Blln: LOCKABORT A1 LOCKCOMPLETE)

17 8 - [FI A A s iy A AR EL 4 (INT...+LOCK...) (1 D

iR /E T, 03/2009, ASE02113388-01 241



FrEBE LRI Z /O
12.3 141877268117 SFC $ A\ /%t

A2 PATAT LI_ERR
iR LILERR BEN 1, WARAT Foir2:
AUTO
e START (JjiZ . QDIS_START) . COMPLETE. HOLD. RESUME. RESET
AUTO + MANUAL
® INTCOMPLETE. INTHOLD. INTRESUME. INTRESET. INTSTART
®* LOCKCOMPLETE. LOCKHOLD
W LI_LERR BEE A 1, WIEHAT F A1 64
AUTO + MANUAL
® INTERROR. INTSTOP. INTABORT
® LOCKERROR. LOCKSTOP. LOCKABORT

% OP_ERR 1 OP_ERR_STATE ({X SFC %)
F AN LL IR 2R 33 OP_ERR G F—A> AS AT -
o I
B 0 — A IS B (CSP_OP > CS_HL) (1 AME#D
A1 0 — 2o H 5 s TR (CSP_OP < CS_LL) (1 AN D

P70 — JEEAFAERE HI S (CS_LL > 0) Jf HUE# H#H) 5 mg (CSP_OP) MiA i H
(SELCS)

o WEMH
71— R EEM ER (<setpoint>_OP > <setpoint>_HL) (1 />
i1 — B S N (<setpoint>_OP < <setpoint>_LL) (1 AN&E#)
71— BEREM LR < TR (<setpoint>_HL < <setpoint>_LL)

SIMATIC S7 fJ SFC
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12.3 15115 779519 SFC I A /% i}

1% QDIS_START #1 DIS_START_STATE
AUTO

£70: (AU SFC AL Pl Sems A B e (i MR TR & (QPARAM = 0) B0 A7 i%

P FEBAT R, RIEISITI A 2T RE (ENASTART = 0) Fl/SAR 1 B % 4L
5 (QCONT = 0)

MANUAL

7 2: FEBATRACE, RBCESITI A3 iTEE (ENASTART = 0)
’fj 3: ﬁ?ﬂé#/l\ OP_ERR

AUTO + MANUAL

SIMATIC S7 ) SFC

7 4:A474F—A LI_LERR
fr 5: JG*JEBN"EfRE (ENSTART = 0)

7 6: {FAEAMT H AT (LOCKERROR. LOCKHOLD. LOCKABORT.
LOCKCOMPLETE. LOCKSTOP)

7 7: AA{ENTBm 4 INTERROR

fi7 8:  (fL SFC KAL) &M AR, (HABRA Rt kg (QCSP
= 0)

fir9: BT STARTING fI%£5S
210 RIRIRAT T EIBHFEh DI (1 Aol )

iR /E T, 03/2009, ASE02113388-01 243
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12.3 #1387

12.3.9

B9 SFC Hi A /it

HE (SFC fA/HH)

T BB SFC iy \ /it

244

FAREPEAFH U], HS

2 RN AR S (0T 189)#4>

110 & X PomRR | BUAME | 2RE | O&M
AUX_PR04..10*) | SCIBAE 4..10 ANY 0 10
MSG_ACK *) ffiih i & (ALARM_8P) WORD 0 o)
MSG_ERR *) I EAE % (ALARM_8P) BOOL 0 o)
MSG_EVID MBS (ALARM_8P) DWORD 0 |
MSG_LOCK BiE & BOOL 0 | +

0: HEARBE

1. HECHE
MSG_STAT HEARZE (ALARM_8P) WORD 0 0
MSG_SUP I E 3 (ALARM_8P) BOOL 0 o |+
NMSG_EVID **) HEHS (NOTIFY) DWORD 0 |
NMSG_EVID1*) |45 1 (NOTIFY_8P) |DWORD 0 |
NMSG_EVID2*)  |i§E4%*5 2 (NOTIFY_8P) |DWORD 0 |
NMSG_STAT1*) | EUR4& 1 (NOTIFY_8P) |WORD 0 o]
NMSG_STAT2*) |5 Ek% 2 (NOTIFY_8P) |WORD 0 o]
NSIG_12..16 *) AR 12,16 BOOL 0 10

(NOTIFY_8P)
RUNUPCYC *) & B JA £ INT 3 |
SIG_2..8 "R L 2.8 (ALARM_SP) | BOOL 0 fe)
BA_ID KIRAH 1 DWORD 0 | +

(ALARM_8P. NOTIFY,
NOTIFY_8P)

SIMATIC S7 ) SFC
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BrERE T RIEZ /O

12.3 15115 779519 SFC I A /% i}

/O aX FaEXA | BOME | KE | 0&M
BA_NA RIAH 2 STRING[32] |" | +
(ALARM_8P. NOTIFY,
NOTIFY_8P)
STEP_NO HRIAA 3 DWORD |0 +
(ALARM_8P. NOTIFY.
NOTIFY_8P)
ER
%) & T SFC K
) & T SFC K%

12.3.10 ##HIF (SFC BAN/HH)

B4 E Y SFC BA/HiH
ARRPHASK I, 5% RIS X (51894

I/0 & X A | BOME | KR | O&M

BA_CONTROL *) |BATCH ##l7 DWORD |0 o |+
(B D

SFC_CONTROL |SFC #il7 DWORD |0 10 +
(B D

BER

Y |[AUEH T SFC Y

A5 F S NS4 B
e SIMATIC BATCH fi#i [ BA_CONTROL ¥4 k%% SFC (fF HEMEX )
e jHit SFC_CONTROL, #=HIF1E N0 ka4 k%S SFC (EFHEAT) .

SIMATIC S7 () SFC
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12.3.11 REF (SFC @A/HH)

SFC A/ FREF
ARBPSAFH U], 555 R AR (0 189)#7)

110 & X PomRR  |[BOME | RA | O&M
BA_ADDSTATE | Fff/inf¥) BATCH k&7 DWORD |0 o)
BA_STATE BATCH RA&T DWORD |0 o |+
SFC_STATE SFC R&TF DWORD |0 o |+
USTATUS *) VSTATUS WIfPIRAT (HF' | WORD 0 |

AR T EEEAT B D
VSTATUS *) RET DWORD |0 o |+
B

Y |[(GEM T SFC %

BA_ADDSTATE

fir | &X VA

0 ‘A 8B RRRST SELFCOMP
1 “H AR IRTE SELFRESET
2 “TEAT I R B AL e ENASTART
3 R B Ak P R A

SIMATIC S7 {1 SFC
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12.3 #4177 2519 SFC g A\ /4t

BA_STATE
0 AR W IDLE
1 AR AT RUN / HELD_ERROR) **)
2 BARRE DB COMPLETED
3 | BERETEE HELD
4 BAERE C ABORTED
5 | “MERTEHMRA READY_TC
6 | BAERE T STOPPED
7 R -
8*) | IR LI R "4R 14T | QCONT_T_ERR
9 BAERE AR 37 STARTING
10 | BRAEIRE EAERE" RESUMING / RESU_ERROR **)
11 | BAEIRA EAE R COMPLETING / ERROR_COMPLETING **)
12 | BRAPIRE B 5 HOLDING
13 | BAERAEET IR ABORTING
14 | BRAPIRES EAR 1L STOPPING
15 | fRE, HT S88“IETE {5 -
16 | BUA T3/ B 3 SFC JEEIAS 84T S5/ B
17 | FEAZEL QAUTMAN
18 |BATCH: i BA_EN/QBA_EN
19 *) | BATCH: “EHzATI "7 1357 | QSTEP_T > STEP_T
20 | 4 SEORERAE BRI RS T_OPRQG
21*) |BATCH: i efi/idf? | REFRESH/QREFRESH
18
22 |“AhBE IR QDIS_START
23 | IDMIESEEEAT CGELD CONT & RUN & READY_TC
24 |BATCH: “§HI"briR%F OCCUPIED/QOCCUPIED
25 | BRI ERROR/ERROR_COMPLETING **)

SIMATIC S7 ) SFC
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12.3 15115 779511 SFC I A /% it

248

26 | “BUTHT EXEC_ERR

27 | AR s ATIN ) S_ERRG

28 | “SHUIIL R R LI_ERR

29 | “BRAEOUEONER OP_ERR

30 |“AMEBTEEDR EXT_ERR/QEXT_ERR
31 |BATCH: #l4%i% Bit25-30 ORed

BEA

*) | DUEH] T SFC A

**) |38 WoRTE ARSI A B IRES .

SIMATIC S7 1) SFC
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SFC_STATE

SIMATIC S7 ) SFC

12.3 15115 779519 SFC I A /% i}

br [ & X VES
0-4 |#ABIRENM 0-4 CREZ0F| 4 15 0: IDLE
SFC V5.2 1) g AH ) 1. RUN
2: COMPLETED
3: HELD
4: ABORTED
5: STARTING
6: COMPLETING
7: ERROR_ COMPLETING
8: HOLDING
9: RESUMING
10: ERROR
11: HELD_ERROR
12: RESU_ERROR
13: ABORTING
14: STOPPING
15: STOPPED
16-31: 5%
5 LR IRES CONT & RUN & READY_TC
6 U ST R READY_TC
7 H 8/ T- s ik QAUTMAN (0=F3)j, 1=A3»
8 N OP_ERR
9 HIE/ZH I LI_ERR
10 [“HI Ak R AERE ENAUT/QENAUT
11 | “Fahlae ENMAN/QENMAN
12 | AR AR ENSTARTS& *)
13 | “SECERAE AL RE ENCOMPLETES&. *)
14 | “RHFERAE SULRE ENHOLD& *)
15 | “IREIEAT AR A RS ENRESUMES *)

g FERIHEEVETIE, 03/2009, ASE02113388-01
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12.3 #1176 SFC F A /Hirii
16 | ‘bR AT RE ENABORT& *)
17 | B ERAE SRR ENSTOPS& *)
18 | “HJH SRR B f e ENRESTARTS&. *)
19 | R ERAE BT RE ENRESET& *)
20 | “HETEAE R ATRE *)
21 | SFC Jaghi R ERINZIT S5 SFC J&1E/IAS iz17 3%/
“f BN AT S L.
22 | AR AR T_OPRQG
23 | AR R S_ERRG
24-26 | AL 0.2 0: QSCT
1: QSCTOC
2: QSCTAC
3: QScC
4: QSCT_TAC
27  |{E SFC #ufif CPU 1L ek E )5 | CPU-RESTART (—Efiid)
28 | {EBLHUbERIAN, CPU fF1F/EH#)H | CPU-RESTART CA—Zdi)
gl
29 | A Faly: FEHIRR RS
“ir A
AUTO: INSTROUT
30 | fEFRERAE Faly: BRI R
DGR AR
AUTO: CYCLEXEC
31 i 1] i 4R Faly: PR R oY
“IIF 17 A
AUTO: TIMEMON
BT EEIRS GES I SFC MR MIRAZH (SFC-OSL) (1T 280))
SIMATIC S7 It SFC
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USTATUS ({X SFC k4)

12.3 #4177 2519 SFC g A\ /4t

(A & X
0-15 P E e
VSTATUS ({X SFC K#!)

0 BARIRE N IDLE

1 BARIRE EAE A 8hs 1T RUN/STARTING/RESU_ERROR

2 AR IEAE 58 1 C 58 B COMPLETED/COMPLETING/
ERROR_COMPETING

3 BfRE S S HELD/HOLDING/ERROR/HELD_ERROR

4 BERES ABORTED/ABORTING

5 AR R 8 READY_TC

6 BAERA T STOPPED/STOPPING

7 TR B -

8 BAEIRS A ERROR/ERROR_COMPETING

9 HARA AT “...ING’’ERROR

10 FEh A ZE QAUTMAN (0= F3, 1= A3

11 IDHEEEAEA" GELL) CONT & RUN & READY_TC

12 SFC #4 ERRG

13 2% -

14 il -

15 7% -

16-31 |USTATUS fi 0-15 -

SIMATIC S7 ) SFC
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12.3 #2117 2619 SFC Fp A /Hi it

12.3.12 ARAES¥ (SFC @ A/HH)
RS SFC SNHH

HRFP KU, 55 % RN AR X (T 189)# 4
“H

252

I/0 X BaERA | BME | RB
MODE D AR 2 BOOL 0 |

0: FEfRIAHINT OB WG AL 2

1. {EJ%h OB ALFE K
SFC_INIT | ¥I4ftk SFC BOOL 0 [0

* MODE 24 SFC U4 iasHsL b &, HT-#Em2h OB sifif¥hH il OB HifiA

SFC Sfil. AERHABHOEAT I

o I H PR SFC_INIT 28] T #14htk SFC Sifi, AR zZHN FIHE H .

SIMATIC S7 [ SFC
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12.3.13 £ (SFC #yA/f&H)

{R¥3 i SFC #y /%
RESHE R T RSB, PR AT, rbh— e A XS4 !
HREFSANLEWUH, ES% BN ERS X (11 189)i 4

SIMATIC S7 ) SFC

12.3 15115 779519 SFC I A /% i}

g FERIHEEVETIE, 03/2009, ASE02113388-01

I/0 & X FHERR | BME | KA | BN | O&M
SFC %
IORES1..6 | {REA LN FRAL BOOL 0 10
IRES1..5 O B A3t P A P BOOL 0 |
ORES_BY | f&E ity A ] BYTE 0 o)
ORES1..15 | {8 fit Py 4t ] BOOL |0 o)
SFC 7
IORES_BY DR B Ay A BYTE 0 10
IORES1..7 O B AL A FR A BOOL 0 10
IRES1..3 TR Pty A BOOL 0 |
ORES_BY1..3 | { it A 4 BYTE 0 0
ORES1..24 DR BB BB AL BOOL 0 o}
253
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SIMATIC S7 fJ SFC
254 TR FIHRAVET N, 03/2009, ASE02113388-01



“m% SFC EIRA SFC KA 1 3

13.1

9

SIMATIC S7 ) SFC

BR REMLBI G F L

G GuHl: #BATH) , RG24 EEER RN TG % . SFC 28A1H1 SFC 5
BHR L IR, ARERMT e, W C&eXt SFC B3, SFC 2KAak SFC sLfilfiy T
Bk, AT LERE X g i T Ut 2%

TEGRPEIN, EEmIPEITAT ) SFC KA, RGBT A SFC S, BES M m
SFC K%, )%k CFC K5,

H E—&kgitz 5, HA7E SFC RS FEAT T 9 RAH G IR BE UM 4 4 3 SFC 282,
A5 TR 2 2 A A P vho SCH 1O IR D e DS LT o iy 46 11 1) SFC KRB A pl. 18
A SFC BRI [N A4 sl 7 FC R #% FC.

GRS, REAZIPIT B A . LR A e, #nrf i Skaa4 SFC
>“—F K A" (Check Consistency) K i L6 25 .

FE—BPEAS B DL O PR R N 338 A H & . nTLLYE SIMATIC Manager 148 H S
i 2 “1E " (Options) >“El&"(Charts) >H&..."(Logs...) & A XL HE, A7 SFC
CFC i ] 3 iy A “3E 75" (Options) >“H &..."(Logs...) fr& X H &,

FEGR A, PTLURE I P RE Y R8I H AR R SE, AR5 BEAT BRI

A FERVETET, 03/2009, A5E02113388-01 255



Hit¥ SFC K71 SFC 8%

13.1 4. FEXRISL D)9 iFE s

CPU L%

EZER

256

UERABAE 32 AT L Ao S S I TRV, WIS i 4 CPU >*EE 4" (Compare) .
BRI 23T IF—AXUEHE,  Z10H R 51 S Sy AT I )

o - kE NEANICHIE

o k%

o CURHRPIG I

BRSO 1 B S IR TRI R LY 2 8 e R P B O I TRV L, U A
S CPU HHRRFP AT . JE/HT FE N 37

QSR B TR AR I TR P B G B SE SO I TR A 22 IH I A 2 20 196 1 3 O L
WU EE CPU , DUMERFEA AR L ILAC .

D SR LN ARE P P 20 1 PO I )38 B T B I TGS L, A 20K FE P RE P A PC
g s FEE CPU H, DIE(EAS ST TAH UL A -

AJDALE R 155 53 H 380 5 22 G PR AH DGR 15 B
i PRI R (W 257)

L 4 2% (5T 258)

2 PRI ZE A BT R (T 259)
—BPERE (1 262)

75 (7T 333)

SIMATIC S7 1) SFC
Y FEFIHRETH, 03/2009, ASE02113388-01



H4i1¥E SFC K H1 SFC K%Y

13.2 4 1%/ F#CHT i% B

13.2 WEITERARE

HITRE

R P LAy AR TN (Options) >“H 52 X”(Customize) >“%i %/ T
#...”(Compile/Download...).

AT IF—ADXHEAE, A& L g BTG I BRI -

SIMATIC S7 ) SFC

A LAHE S IR ey R, DUSEAE S 2802 AR e n] BEA AR R SE o

A LA S FE G 19 24 1T P R SO S T Wi L8 B N AR RF AN

A XA RERA B, B, WeREERR M R o gfe (B,

STL. LAD = SCL #£/7) Kk B eSS, DL EHIA I ThEE (FC) stk
(DB) >k B I R R K B BERIN

AP AT ARSI E, XESE R BsaT I T4 si (DB, FCO MR B
A BB K

AT DLFR GE J& 15 28 UM B P I W AG AREAT LU AL Rk G B XML SR, JF20 i
AR, FIATEUEE R SCOR, AT LU E A K S A ORI R AR N
B T8 ) 72 52

BiA
W RAERE P AR CFC R SFC, AT LA B SCBR DA IR G 1E 1
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Hit¥ SFC K71 SFC 8%

13.3 2117 %4 1%

13.3  WfH4miF

G T PR S R

BEMITEHE

258

1. EPFSE a4 SFC >“4qi%...”(Compile...).
FEATTTF—ADREHE, WIE P e B OC I et ,  DUFR 2 g R MR (A6
G B E SN A (NP B B e T SO 5 .

BERI AT TF—AN 1 AE, F T AR IR RE .

2. DEPEAE G R RN PR e S T A

3. ik WS H A g R R T DA R, A A s R DK S R (Generate
Module Driver) EiEHE, IbAE AN SL IR R PR FE A 2, B IR G B 4 T 3T
TR EAE .

4. k. WEREAEFR T RSN DO SL R AR s HERR SCL AR s, WS
“!f il SCL ¥ 314" (Generate SCL Source) & iEHE.

SAE P ICRGERERS, A4 248 SCL WA I IRAFAEI SR N o G PERE I e
PRI SCAE

UEAE I A SR ME DO — IR G B R AT G N IR BRI BT A L BRI
5. HLliffiE”(OK), XHHERH BRI 5C I TF A5 1% -

Jokr M ATRE Y (BRI hIEERK— 8t RadHrgiE. SR aErmEEs
ANBIH S WA A B AN, U AT DUE I X 3 B kA B SFC.

FEGPEIIE], 2> o — AN RE B SR IXRAHE . AT Bl f o HH” (Cancel) 45 14 Rl .

IEPESE LA 2“1 I (Options) >“Hi&k..."(Logs...) K& F FIHT B — B4 A 5 31T S .

Ui B

AT UARAT g B an — B8R A . ik, RS R4 SFC >“RE—3
#..."(Check Consistency...).

ARG R, 2% B E (0L 262).

SIMATIC S7 1) SFC
Y FEFIHRETH, 03/2009, ASE02113388-01



H4i1¥E SFC K H1 SFC K%Y

13.4 G iE 0] A1 1T DT B2

13.4 S PR 18] A2 B R R A i

i
PR T 7000 & Bh T H P 4l CPU B i A A o
iR
M 7E SFC WALAR gk 2] S7 X Ihhed. Thag (FC) ffidisth (DB). H& L
YRR SR N A EIER (CFC AT SFC) .
YR IIE], BRSO 25N SFC #2851 77 xRk T i
SFC K% 1 /M55t DB + n MiifE#E DB + 2 /> FC
SFC 257 1/ FB+24 FC
SFC 524 1A BB R + n A R S s B

SIMATIC S7 1] SFC
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Hit¥ SFC K71 SFC 8%

13.4 G iE 0] A1k 1T DT B2

N THE AS AT SFC KEIZR/ISFC 5], HacftJe W Mz ds R otk (e AL

VIDNE

PUE 3 5 HFEZx (C) aX

Z4 24 KA (T)

FB245 |@SFC_BZL C/T BRI

FB246 |@SFC_ESM C/T G Pt s AT

FB 300 @SFC_RTS P (V6.0 LIS | IB1T RS

JRAD

FB 300 |@SFC_INTP P (&% V5.x) |I81T&YE

FC240 |@SFC_OPI T FIT INT B0 {8 14l Bk

FC 241 @SFC_OPDI T FHT DINT ¥ (B 4l Bk

FC242 |@SFC_OPR T T REAL % & {EIf 4l BB

FC243 |@SFC_OPB T FI-T BOOL & fE 1%l B Bk

FC244 |@SFC_OPS T FHF STRING % 5& 18 (114l Bh bk

FC250 |@SFC_INDCALL |C FH T F 4 B B

SFB35 |ALARM_8P C/T 8 AR 5y IR B

SFB36 |NOTIFY C AR R

SFB31 |NOTIFY_8P T 8 B M55 AN o H A

SIMATIC S7 It SFC

260 S FE A4 T, 03/2009, ASE02113388-01




H4i1¥E SFC K H1 SFC K%Y

13.4 G iE 0] A1 1T DT B2

USRAE (I IR, W5 21

FB5 TIMER_P T Jhk A A

T SFC %

SIMATIC S7 ) SFC

B SFC K3 ek SFC 2R, A48 A H L MBI RIS N . X T
SFC MY, L@l FB 247 K EIA (FB %5 88— AN MEH IS 5, 140,
FB 1025) .

BeAh, b TAREEALAS IS AT FHAE CFC W ARER I E, FHEMINM FC, @ F FiR:
o fEAMIEHIN) OB FHE A FC

o AT FHE A FC

CFC [ ~ L€ L H] DB:

o R FPHRM AN AL (FB) @M 5t DB.

o filln, @ DBk, M A4k FC N ME R, AR E—4 DB . ik
Pl KK (K71 Ja, @l —4> DB.

AT FC A1 DB %K CPU M. 2T IRE HEAT 73 I -
o HKAIN FC

e ffi/il STL. LAD HI SCL %if&if 5 €I I 45 44 #) FC Al DB

o LCgifEI& M FC A1 DB

SFC Bk A+ A v E = I /B & — A~ Excel CfF“SFC resources”, 1w LIMEH
SOV AT N ) R S Bt oK o
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Hit¥ SFC K71 SFC 8%

13.6 —# k&
13.5 —HHRE
o 25 B 7

FESCBRgR 2T, ARG HZPATL T — Stk &

o A LU E R BRI 5 AN B] CFC Hh I BRR A JE A L
WERAERE R 3N F] CFC w2 Jim Sk slE MR 7 R e P (RS, U)o
A2

o KA DARE R SR TR A T = b A5 5
R MARAERT SRAPBAMICEH, B0 O iR, W2 A — 5

o kA LUE T RE Y O A AR TLE M s B (DB)
U R RS S G IR TR A s B, e AN B

o KLU BAE U I N S B A “ANY” . “STRING”. “DATE_AND_TIME” =%,
“POINTER"ZE Ay Hedy H R AH (R HZE)
K A DL 2 BT nl kP SFC A 1 4Rt kA7 U5 1) OB 2 75 A7 AE

WA AAT — S B AN R, B0, SR B A g 1 I A S A e A

i

1. PR i 2B R"(Chart) >“k & —3(14"(Check Consistency).
RESKII A RN T ER . REERG, 45545NR7EHE" (Logs) X i
FEH

2. W] AE LU B 1T B H &

3. £ SFC v/, EFE3EH 4“1 I0"(Options) >*H&..."(Logs...), H ¥ 1E SIMATIC
Manager 7% £ 25 1y 2“1 " (Options) >“EX”"(Chart) >“H &..."(Logs...)-

AFRAE [HAR (A 333) R BB 2 AHCME R

SIMATIC S7 1) SFC
262 Y FEFIHRETH, 03/2009, ASE02113388-01



T#EZ2] AS

14

14.1 el T AR

fai 4

B HS

TEHERK

SIMATIC S7 ) SFC

N TEREAS CPU I L 7 sUAE B BRI, e A e R, AR A RO T
BRI HE RGP, ERPCNEE] CPU th, % CPU 4 A7 & 24 17 B R S It P
¥

Vi BA

1] SFC G2 (IRLFF IR N SFC 5 CFC F# %] CPU, P K AT Xl i ThAg 4 it
fAF A SR 5 CPU $di— 8. W HiAE SIMATIC Manager Hiik #3% fy 4 PLC >4
PR F &4} %:..."(Compile and Download Objects...), W4 FH AL T 2 5hAg .

O, ANSCVFAN B ERHRSCIE SR N I, SRR R i AN R LR B ER

w5 SIMATIC Logon Service %3¢ H30E 1 U5 AR A Mol sk DhRg, W42 CPU
CHEMRRB T TSR XF S7 M5 Wt IL e n 551, #d X MIhEE,

W ES HASHAE 1 24 B SCrEk, WA, Ex T SIMATIC Manager )5 & H
&b, BATLAE ES HAAP A ES HP 3R EM RIEK. X A IEXITHERES H
&"(ES Log) LE Tl i 16 € 1 B 2R STk

AR TEAE L, 155% CFC The CFC AL Wb s H s R A A

FE N, LA AL BA T EEK

o AJIHE CPU S%ife i srok PC Z [l v 4%
o BEIYHHEIA.

o FEfFC&HmiIE.
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F# 7 AS

14.1 W1 F # 7

7

1. MEP“4niB”(Edit) >“%F 5 )8 ¥E...”(Object Properties...) 54 .
BT IF R %7 (Download) XJ 4G HE .

2. JEFE R, SRERR AR IR DR A R RS CPU . BRTBAAET T
BRI CPUTINEFEBENTRFY

3. i (OK), THEAEF?.

WER EL AR REAT TN BRI S, (R ESURRA %, W MR, Rk
FERHAT O WG R AE RTCHS, WIES o8 ia B 3T an FE.

THRENMERF
FESEAFEF PR, R HATEL T DR
o ARG CPU &'E 4 “STOP”,
o JiER CPU ¥ T H,
o 5T I ETATIEIR R R CPU

TEBA R R RF M
o GNIFHAFEFIA - EEWAE B N BN . WEARRR ARG LT O 4 N R
CPU 1, ] AR 2 # 40
o WURBGH EA TG Msga FEGERZRTA S PR ESAN . BN 75 FRZ
Bl RGECZMIBR T CPU HE,

TREKL

FE N A R AR, Y CPU A T“RUN-PP BT, AT LUORE 2 A8 ) B 2 25 R 3
F| AS, ML # CPU V2] STOP #Bix. (FHXFN FAESA, N P Lk FaUaEE
177 HSI N A

SIMATIC S7 1) SFC
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F#EAS

14.1 4117 F #FE /7

KT T EERABTRERFH

WIRAE SFC KIFR/SFC KM LA B 00 T W RE P s A i (lan: s m. kR
2l el T B, SEBE HARCAERD , I HAEEGT ISR E AS
PR BOEARAS, W T EAE X L ] R sl A T S oA e i
R AR R LA BRI R IR AR B R AR R e . I, TR ek
1k,

Wi i SIMATIC Manager YjRg“4i: A1 20%) %" (Compile and Download Objects)
PAT T E, WA BEEEN SFCo fERXMIHIL T, REMASPAT N, I
BRI —SHTRIE B

X SFC AL B ek L RIAR X 5 SFC sLfil.  Shitt, AZieE NI EEA SFC
e, AE CPU HE (S AT IXEE S Rl e NG, N T AE T Ak
LUK R 30 YR AR e R 3R PR e . I, R 3ok ks

X E ) SFC BIERERRYSLH] CUIEAEI) SFC JE L. MR EIE. X% R
PEY o RO RE R SN AT G MRS PR oE a . A U 1K) SFC RI
PRSP A R R AE T RUNRS ) CPU HR

WERBAT S SFC AL, HURHE T VRIS (Bl fF5RP IS, 1817
. O, WAE N EESNEZ AT L4 SFC.

EFETERARZ G, AAZEZIH & Autostart:  on” @ PEIZEHI ) SFC, 145
FRXH#ERAE B (T3 sE M AMEALIEISFC 526 (B3 IR 3h.

RN SFC INPRASHAKIE B, W22 (AL T B S /28 1 SFC ™ A=K [
(1L 268)

H CPU KB

SIMATIC S7 ) SFC

H CPU 4t T HpLBi, R4 CPU Lk IF Hok A 7 CPU R, ik
SR BEATAE LT ) RGN RIS A, MRGESATIT - DNIEFXTERE . 7EIEXT
TEHETR, ATRLERETT ) CPU.  TURBL A IR R AE .

WG FR P S O A 2 R BRI SR LR AR CPU SRS H] CPU >“#fEE
R...."(Operating Mode...) > i 204708 FZ S0US AL 21T D15 (switchover with
modified configuration), <KX e, iy H X AE T EEENRET .

ARFERE: EURBA T N ERXRMEDL T, AU R ER U R o, B
R ERGE R
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F# 7 AS
14.1 W1 F # 7

F ARTEEHEI
PROEHBSOEN F AR, RETEEAF 04 WERBATIRR, Fa&
Hik.

TEEXA AN HE P HER
“[A IR AT P Bl B (Also download user data blocks) 33 N BRIABEE, 105 R
WA, TEEEANFN, WMESTEAY, LR sk,

WRAE N A AR R T R REHE, XS ANAE SFC XK Es e AT LA g
o RN TRIERAS A BE AN T AE B, R R A R L R B
o R S7 R AMFAERX LA E L, WFE CPU rh 2k HIER o
DRR A AN BOE O I S T Bl e, MRS BRI R HE . Itk DU JA 2R
o WERFEANH S BARPAAET ST FEfrrh, (AfE CPU AEAE, WARZCR L FEUF H.
BRI R
o {ERAELL NI ] AN
- M EHERAFAE T CPU TEEATFAE T ST FEfr it
— 24 S7 PP Hdls e s CPU i L Kl BRAN ]I
VUL dy P 453 S AR R AT ) R
B
VER, £ FEESNAR, JoiEdgon fRiE CPU A& Pl#s] STOP K,
HEZHMRIEE, 2% CFC U it %380 CPU STOP I RG34 -

BB E T R EIM CPU
EFHEIR CPU AR "R, LUK sGL roRE s F SR [ i CPU
o PLCSIM BT, [R5 4R Al 04 58 ke 9 2 F 21546 CPU o,
BEAFER FAREIIA CPU (5 PLCSIMD o1, 3 AL F5k Fabfilis, tRasstL
BT N ES B s,
#% R CPU VLIS B, T2 CFC R4 By (0% 0 Bt (R e F 300
i CPU.

SIMATIC S7 [t SFC
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F#HFAS
14.1 4117 F #FE /7

1222357 Version Cross Manager (VXM) Bt b6 H AR il & F 30 P O meg g, “ &8
7N HE 2" (Show Changes) Lhfig A4 nl A

BT AR FIBRE

B8 Gk T “Giik/ T 31 ¥ B (Settings for Compilation/Download) % iFAE H 1“5 ki
NI T T L4 (Generate image of downloaded program for comparison), ]
ERRIh e 2 5, RO AE R XML SCRR %, 305 L Be s %R

LR

AR T O R PO, WIHESERR R 3 i ST T 4K7(S7 Download) X i HE
H ) R " (Show Changes), BAXH XML 305 H 28 M R P b A7 L

WG VXM AT BB Gl bR, S mT LA T A ATDRE T 5B A N 3 AE e, TR EE
LT, RIEERPE R T PR A .

SIMATIC S7 1] SFC
A FERVETET, 03/2009, A5E02113388-01 267



F# 7 AS

14.2 (R F 02 FIZENT] SFC P19 K h7

14.2 INAE T EE R RIZER SFC B =41 R MY

SFC ZH R FIREH

IHRZS #IE HARZ

IEAER 3N SR EABAT R RE 7 IEAEH L
IEAEIEAT " "
IEFESE K

i QEAESSH0O
B8
IEFEH 5
EACEES
IEAERE

H

cErfs CHEAD
IEAERE CHHED

IEAEfEIE

E,’f'fj?"ﬂ: " "

IEAEH L S BN FE 7 58 B EEI
OB IEABAT IR ! )

=N PR IEAEEAT KB R gl

B8 " CRT LA 2N 28R )

B1$Jj: "

ek

SIMATIC S7 {1 SFC
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F#EAS

14.2 (X7 F#E XL FIZEN SFC Jrr= 19 [ b7

LA 1
Iz A e AR R IR ASIEAT , NAZ N Bt i Ry o
B3 LU Iy 4T
IR BrE FRE
A oy b IEAEIEAT I I R EAEF Ik
IEAEH Ik S BN R P 58 1% ok
(AP IEIEAEBAT IR )
ik Sk IEAEISAT B R N
TN ok IEAEIEAT I R A
CAy RLIn #2808 )
5 2

MR P A IEAE R I EIRAIEAT, NAZ NS REY o
K% LU N AT -

IHRZS Bk HIRZS
IEAEH L S BN RE 7> 58 B ek
(AR TEEIZAT FBEERE D
gk xR IEAEIEAT R R Y ]
N IR IEAEEAT KB Ry W
CRT LU 28R )
]
W7 Ry LE LA IEAE FP R IRAIEAT, W R A E A I P b AT P Bk, N2
FEFFJC i 1A

SIMATIC S7 1] SFC
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F# 7 AS

14.2 K7 F# L Z FisEl SFC Jr L by

SEf) 3
B FE A 1E LLS IR SIZAT, WAz 5 .
P2 LR PR AT -

IFARZS Btk HORZS
&l SR IEAEIEAT R R N
CR] LIR30 n 280857

A RBEIG SFC KRB L2 E R, W ZH LT /MY
SFC AT HIZHA S (U1 90)

SIMATIC S7 {1 SFC
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AS FRFIE I R GERIAT A 1 5

15.1 AS H PR R St

R
o i/l SFC Zwifasld /) SFC A HA %I
— RS OR S A AT MITRAL PR J5 AR P S FO A%y 4 4b
- DA
- HeRBI AT
- B1T)E L
o REFUgnit, JEHRFIRCA NEE AS .

B SO PR R G HRFS

FRere MR AS 25, WP EHIARGAE T MEEEIRE . (EH] SFC gafHatii € itk e
W& GERABCE: “EW™ .« BB R sh SRR B 41, W fE AS il
AR SFC ARSHAT AR FF1 .

AN B S SOEATAT N

o TLUEH] SFC %idE s mift OS _F B iz AT 2 8 ASEAT MGl AT i 1o
el WHR (T) B DI A S A (O) At

ﬁ
o HERHLI L DI TP

w2 T HAFITH IR, AT ML 41 D3R A ) iy & 08 R Py I P ) i & R
iy SFC.

SIMATIC S7 1] SFC
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AS PP EE R HI T

15.1 AS THINI/TFEE ) 7 45

E5EAX AL

272

AS I R S AR T A AR RS Th e S5 B A E S AR ORI A S 8%l kT A
SE 5 G NS

KA SFC B BCA S E IsATAT . A AL (WFE(L T CFC BRFH Y 1isfr
iThv e SFC BRIIZATAT WA AR W LUl 7E CFC B s E > SFC 3%
ISR ERRT e T FRE, W DUE R CFC B3RP ki SFC 5241,
IBAT RGN SR ALY R GERBEEA B S AL IR aE s LIS (0 R84, DRIERRAR 1 )4
Widk. AR, WTLLs SFC fliA It i, IR n] DA T AN R R 4 /IS LE 3R AW R o

SIMATIC S7 1) SFC
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AS PP EE IR LRI

15.2 1517175

15.2 B EBITITA

15.21  FEHIRAREITIT N

BATAT A R 2R AR
G425 i R 4 AT R BRT TAESEC AR R R R 4R A o DA S AT 3%
Tl
ANRRAR 2 #F E OS I (SFC widifh) wLLgE TIESE. ish: HasdeErkxt
IHHEFFAAS T 4E S0 (AS Operating Parameters) 23 1 ) SFC &% . SFC 25,
SFC sl & A3 H 3" S48

TAESH BN BB LT

“BRINEH

AR T e GIRERE))
BAFRL T3 A SR
it ot

TR ERAT PS

I 1) A P

‘B BRI

H 2l 8l (Autostart) x

SFC JA 3 FHERN TAES 4L (Use default | ¢

operating parameters when SFC starts)

£ CPU JaahJa i B UL R AR

Gl (5 Autostart = off)
EFER 3l (tn 3 Autostart = on)

ARAZNTAVMTENE L, WIS HLUR S BRAERT (T 274)

SIMATIC S7 1] SFC
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AS PP EE R HI T

16.2 15517174

15.2.2  #BAEHEK

SFC e
PR Ao TRET RIS AT 22 B ERE Rk 2 i AS #2173 shil .
SFC I N o AER .
o M3 GHFiE=)
PAT Lt AS FEEEs .
FERAEHI7E CFC K rhig 5 (19 SFC K AN E L I Bk SFC S ¥ & h I S 5040 i
FE N A ATH2
o T (BfERBD
AT I PR B DA A 2 B S AT 160 iR R SFV) Skedasib.
EMRAE R . SFC nl L P i Z e (HMBALIED B SFC Szl e mirh, nl s id 48
E BN SE N T-3h 3 A 3 H 3h B T-3h P03 ENAUT FI ENMAN iz B
It H T AL

ARBMANEH R EZEL, 2%
SFC it N/ i R AE R (0T 222) #7) «

SIMATIC S7 1) SFC
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AS FIFEEH R HIT
15.2 1561717

15.2.3  SEHIER

R
N ) G Ak D AR s s, S Rb R T B g SFC AT A .
] AE T BARRE RSO HIR. AR E R, SFC YU N oD
A
pZaE B 77K
ARG
T ¥
T O FE RSB A A A A
THO FEAS I iR A A BT IA
o) HI A DL A
TT5O AR E B AR BN
HHEHIREK
T
Hit%:
AR HI R G A IR ) CHENIEAT) o il LA A AEIT, 30k 24 A Al e R e
J kAL kAl s
AR T T R AR s A QIR .
T O
FERS B DL

T PR el A PRI R S IEAT . D R R SR B B B R A AR,
IFAESE R AN G IR N — A WERAESRAR DU AT L B 25, MR —
&, e AR A CABD .

APEHIRET 2 O™ AT T Faniial (eff bt
TEO

FeRE RAERAR BLHA -
H AN ERAE O3 Rl IR B R GEIE AT i s D 05 S B 4 AE i,
BeAf P, HIREsE A AN e A B — A2

AT 5 OB T Tahisl GRAE SR .

SIMATIC S7 1] SFC
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AS PP EE R HI T

16.2 15517174

276

0]
SR X CERETIN
HAEHAE R EHIF S RE BT TRl BA L. NG A G 8
B B PR, JEEEE NG RN —A 0.
APEHIBOM T T F il N G E D
TT5O
AR E AR LA
R e AR |, B8 P (Properties) 1% HE b 4 & 5 52 “#f5 1A ”(Confirmation)
2. 3 H R G E T HIB g7
o X FARM“HAEIN” (confirmation) BT K5 K HI T FEIE AR
ANHF AR VAR IR0 2 S5 A T I e B AE A s s iy, FROC TR R AE A7 (A4
T
o X T\ (Confirmation) I (1) K I #R4E R dIki .
Hrffiih”(Confirmation) 30 TG 542 Ky BN, RGUEIRREAE Ul R —42 2, 4R
Ja AR EPATILERE Y (S TT 5 07 &

FETAR AR SR slA AR G Farblisfr PRI TT 5 07,

L
FESPFERIBGO"AN T 8L O, W] il B s P R /NS AT I AL

SIMATIC S7 1) SFC
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AS PP EE IR LRI

15.2 1517175

15.2.4 AT EEIH

R
i FPAT IE TR 2 3 35 B R AT Mo ol DAL AN AT LTI
A LLAEJE M (Properties) XTURHEIK“AS T4 240" (AS Operating Parameters) i1 H %
BIATIET . fE S a4 SFC >*J@...”(Properties...) 11 T %6 AE .

SFC H#ATIER

o 4% (Command output)

WARWE T it 77, WIS BEEGE D ERAE: s T i e X,
DUIAN KL O 25 FRIHRAE

FE YR B A I, s S e S S @ IR ("CrL T 50 CYD AR Y
PR E TWEIRE, AN R 3 e i o

— WA A, WD KR NEAT I Ta AR .

- HSa AR R T — LR A TG AR ik, EAPIT DA R, A
— M RAEEA AT

o {EIRERE (Cyclic operation)
WERBEE TMIR e 7, WIEC IR S RS RYE 4 H 8 DL AR A s IR 4k

HEPATIERE.
LEDRIABRAE IR, B O o IR AR A F % B e ST BN UGB Y . AN PR S 325
g dib,

= QR TARET A P IF HAE SFC S A/ 3 EA IR, WIAEAR A A I
Jive & SELFRESET = 0.

- WURTARE AZET, W28 E PARAM = 1 (it ] DL E A 345 1)
QDIS_START =0) .

WERBCE TR K, IR RS R s IRES
WERBATIR RS K2, WRZOR A2 WAL B 2 58 IR E

AT N IE AT A A e i iy 2 1B H R .
%

ARBAREHEL, T2%
SFC IR A2 4E (SFC-OSL) (1t 280) #B4>

SIMATIC S7 1] SFC
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AS PP EE R HI T

16.2 15517174
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s} 8] AR (Time monitoring)

R BCE TR 77, RS R, AT (CCYHTIZ AT ) K AN
Mo b5 MR TR) B RS AT I )™ HEAT ERA, RN TRl Y, AR D A R

W BEE TR 8, AN DA B 1) R R ]
H3h/33h (Autostart)

Wk SFC HA“AzhfEsh: A Ett, WfE CPU thEFiH3N G, LFHAERAN,
SFC LRI N“IEE B8 IRE . NECEMN AR, ASKAABIES) (CPU At
A STOP RAE) o 2l th#AF B WL B (B, M CFC [AMBALE ) FoHr
JA%h SFC.

WRBE TSFC JH s BN TAESE: 77, WI{E SFC BIZRH8hn, Frafeis
AT IE M T B BB AL (AR NSO B FRIRAERL.

H et SFC >“J& " (Properties) >AS T 1/EZ#("(Operating Parameters AS) X ififE
HET L E B A BT R

SFC B 3hti FI BN TYES % (Use default operating parameters when SFC starts)

AR E TSFC AN BN TS5 I, W SFC Rahit, BriafEiztr)s
PEPBCE I ERAEAEI (CAENRBIT EB0 Fa k.

SIMATIC S7 1) SFC
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AS PP EE IR LRI

15.2 1517175

15.25 #BIERE

15251 #BIERSES

W PP R R VPR TS

BIERTZE

SIMATIC S7 ) SFC

WGP 1 28 GE B A RS T T I PATIRES AU ATAT oo B, )7 aT DUl o 2 15 7
SRAT DT P LA BEA T JE SR AT BRI LU I L iy 2 D)3 21 E AR 313

AR O G R AR
o ZEBRAE SR (T3 MEAINAEH SFC AL i fir 2
o 7EMFEEI CH3D MMEMY SFC EERMAMTIK s L SFC Sl i k.

SFC (MR A& 8 (SFC OSL) #iik T LU R N %
e SFC EFak SFC Sl i) nl BEIR A

o WREAERFREIRE MM INE R

o GLEAREZAC K FIT

T SFC OSL 24b, AT Hph (i S ) H (O BR AT IR 24, BT T4E SFC LS IR T
PP OSL.  "EfiliiR T R A1 4

o JFERE I T RERES

o WREAERF IR T IR

o SRR HAT

H T RERETE SFC OSL MREANRAS AT SFC —A (EE A iy, W4T
SFC OSL Hliifx#2 /7 OSL Z [A] X Fl ¢ 5

RBARPRES TSR, IS HLLU N

SFC IR AR IZAR (W 280)Mitsx Fe 3 [ #RA IR A4, (0T 289) i 2 (UL 297)
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AS PP EE R HI T

16.2 15517174

15.25.2 SFC H#/ERZ&E (SFC OSL)
ERHRERE
AFLLH I N AR 2 SFC OSL 1) AR 2
o “FIE AN B T (B B WEIET. B
o SMBfET (Fln. SFC A B YR A 54 SFC %)
o WIfET (ASMHERFFf4, KEMAEA D SFC r#) .
o [T
biipus
SFC OSL [P ASH K (51 287)5E X SFC HIHAFIR 251845 .
R i B I
TR S IHIH A TE, SFC OSL 8 17— LER B T RIS, XERAEE K
R IR B TR,
B T 45 o 5 MRS PR IRAE, 5 LW F R s,
#1ERE (SFC OSL)
W5 | RE P
1 &l WILARIRAS: A B2 .
2 IEAEJR3) FER R Bl 2 e AT JE sh A #E
3 817 Ja B R T R ) AL B
4 TEAE T8 56 I 2 B B o8 e 5 ) 58 A #E .
5 WAL (IEAESERD | S8 A BRI ] (R 4 R Ab PE
6 W75 SERGERAC R SEAF AL R A B A
7 IEAER 15 R A R AL B
8 T TP O SE MG S I B AT 2.
9 IEAEW R R I8 AT i 2 Ja W s AT A P
10 | HHEs A S R R AR P
SIMATIC S7 It SFC
280 Y FE A EAE T, 03/2009, ASE02113388-01




AS FIFEEH R HIT
15.2 1517175

5 | RFE &
1M1 | 2EE GhED HHR B RE O Te ik, AHAAERR, Sk Ristr i
é\o

12 | IEERE G | RIREIEAT a2 e B IsA T A 2

13 | IEfEHIE S 2 A R AR EE

14 |2k AP SE R  IEAESE A BB R B 2
15 | IEAEfE I R I 5 A5 LR AR

16 | CfFik PR BE O SR R A 2.

NRHE T AFRES PUIRSSTHERRE S 2 18] e & R 2 F
X = mHEk A Z MRS

5 A & AT IR ¥ (SFC OSL)

B/ ik X
H 5 MANUAL
(AUTO)
X/2 START T 5 ey “IEAE )R SRS,
fil & JE s AL EE
3/4 COMPLETE | il i #5 # hy“ IFAE 58 IR A
fi 2 5 R AL B
2/7 HOLD T O EAE IR
3/7 find 2 B 7 A B
8/9 RESUME TR O AR B IEAE R (A IR,
11/12 fih Kz 2k 8z b
X/10 ERROR Tt ey AR B A CGEESERD TIRE,
4/5 il & AR A FE
X/13 ABORT T B A E AR ETIRES,
fid & Fp 1 AR
X/15 STOP T I 4 A IE A 1EIRES,
il & 457 11 A FE
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AS PP EE R HI T

15.2 156517712
W/ e X
EF7y MANUAL
(AUTO)

X/2 RESTART |l id# e 0 “IEAE B IR,
fil K e ShALFE

X/ RESET ka3 N
RS

£ MRS 5 AT IR S e (SFC OSL)
SRRSO SFC AN, XA (fildn, BAHY BeassEm OSL AR W KFe

o

SR, AMEAE SR OSL I IRBIEH AT 2. DAL, ARSI R rp 41 RS e ot
E, A REBEATIRAS e e

P/ SNERIES X
EF73
3/4 LOCKCOMPLETE | il il #3 y “ IEAESE e RAS,  fih ok 58 A B
2/7 LOCKHOLD TR WO AR IRAS, fd ok B st A B
3/7
X/10 LOCKERROR T O AR e A QEAESERD IR, il kA
4/5 L3
AN BT E o, RSB ROy e/ E (R
) 7 WEREEANERR AR R, PRAS & 37 R AL m]“ S
X/13 LOCKABORT T O IEAE S I EIRAS, il o b A3
X/15 LOCKSTOP T EE WO IEAEAS IEIRAS,  fil 5 (E AP
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AS FIFERRHITT Y

it F W ERE S AT IRSFE B (SFC OSL)

WS 52 SFC A Elar <, 0 PHMTBEE DUk SFC HPIRPIRAS . OSL frfrixX
Lo T, IXEE SRS R Hsh &AL,

WA 5 AAE OSL I MMEVE I N AR, TRIL, 2RS4 R HUIR S He bl €

15.2 1517175

A REA TR e

95/ ik X

H 5

X/2 INTSTART T I 4t A “TEAE A AIRES
i A A B AL PR

3/4 INTCOMPLETE | il ik B3 4 “ IEAE 58 IR AR,
fid Kz 5¢ AL B

2/7 INTHOLD T I 4 A IEAE RTINS

3/7 fid A BT 455 A B

8/9 INTRESUME TR A O IEAE R B

11/12 “GEAERE CHAD IR,
fih i 4k 4 b

X/10 INTERROR T Ik S 4 g A B

4/5 “HAEF QEEZERD MRE,
finh 2 S R A

X/13 INTABORT T B A E AR ERES,
fid % Fh L AR

X/15 INTSTOP T B A E AR RS
il & 457 11 A FE

X/2 INTRESTART TH B A EAE A SRS
fih % ) B AL EE

X/1 INTRESET B0 Ay A A

SIMATIC S7 ) SFC
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AS FIFER R
15.2 HTE 117

KR &E ¥ (SFC OSL)

RS EAEEZ S IEAEZER “IEAER . “IEAEW ", “HAD . IR A GRAD 7.
EAEH A IEAEAE I POIRES . FESEAIAT T RIS (R, AN AL A
NGUFERE e ) R B 45 AT B B IR Y D& 58 AT RS OSL i I
JaBPRA (RATESD .

R E T SFC fii A SELFCOMP=1 (EERAMSEBKBERINBCED , BB s RS
ARPERZS . AW, B8 i 4 i OB I8 AT IR 2

i
HEEIBAT RS E RS AR BTSSR, M SELFCOMP=0 31
SELFCOMP=1 A& %% .

AR, AT HE H A ) A A AT L A A, R EOIRAS . AERXFRE LR
PATHAR BT, R

W/ SFCRE |&X

Ep7n

2/3 RO | Bl O e o i
SE R

3/4 R R E | IEF B Coe i, Vs L og ik
56 % (HT$e: 455 SELFCOMP=1)

4/6 I FERE O | SE A HE O e g, ey Do i
SE R

7/8 I FERE O | A B Coe i, o O s
SEIK

x/3 I FERE O | AR O e i, g st
SEIK

13/14 R E | IR E e R Feoh el
SEIK

15/16 R (IR B SE R o el
SEIK
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AS FIFEEH R HIT
15.2 1561717

it/ SFC A/ i AT RS2 (SFC OSL)

SELFCOMP. SELFRESET. RUNHOLD #1 CONT & SFC (4l , I Higm
OSL 414

SELFCOMP 7t -3 fi* A 8" X~ 125

W[k X

HiF |55

3/4 SELFCOMP | SELFCOMP=1 (SFC HZEHD) :
ERASSERT, SFC KM E P RA SN E (5
AR

SELFCOMP=0 (SFC A& H5E M) -

SFC B IRFFE 21T IRES, HBEIRHB 9S4, WHRAEAE
FH“TE B i 2 SRR e 4, HLIE W R AR B R 56 B
WIS L T TR AR B

SELFRESET {1 “ T3l 0 F A 2%

&I SRS X

SR

XN SELFRESET |SELFRESET=1: {E“Cl5Ep. “CH "M S IR RET,
SFC LRV H B4 A A W IRAS . S5 R MR (e Lk
& MAsIF HALEI ik

SELFRESET=0: WR O£ 7 esemik”s “cHik”
O IEmRE, W) SFC A IRFFHNIREH R RAE KT
ek a8 4 o 1k (FECAE I I AN 3 807 .

W ERIR AR, V)2) s SELFRESET =1. SIK S
#H 4 (LI_LERR).
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AS PP EE R HI T

16.2 15517174

RUNHOLD 7E“ T3l B 8 80N 7 2%

P/ AEE S X

RS

3/7 RUNHOLD RUNHOLD=1: M“B17 84 o  IEAE B IR, Kk
6 W I R 3 h 3 (R R o
RUNHOLD=0: M“E17 4 IEAE RN, KEE
SRR RER, SR I5 8 S P R o

CONT

ﬁa% CONT 2R, WiZ
VELERL (UL 286) 7>

15.2.5.3 HELHR

CONT R7&HR S

286

FE R, AT B kS HRE (CONT 4 A F1 QCONT 4\ ) LA VF I 7 il
A4 (8 SIMATIC BATCH) 5 SFC Z[HME. XFELF LM SFC, Rl f I H 5
3. SFC ) OSL f##F847IR&HAE RUN = 1 LIz READY_TC =1 i ¥ & fiy
QCONT =1. % %E QCONT =1, N<# & QCONT_T_ERR =0.

MIMAFE AT 2ZARESIRL, #S AT A&

BE READY_TC =1 I H )3 SFC. XH5 i1 SFC E B T IR FALRE T 2 A B i
PP RAARP G AT BCE . AR E R s IE T A SFC, W& EBRAHrE QCONT
=0,

WIRAEHASHINSTE (CONT_T# 0s) WA H SFC, N4 ik &a AT H QCONT_T_ERR
=1, ZHH RV BIAE O

ARELEBAWEZEL, T5%
SFC a4k (7T 299)

AR (SFC A | (1T 239)
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AS PP EE IR LRI

2z

15.2 1561717
15.2.5.4 SFC OSL HIREZALE
SFC OSL HpPR&ZR
izh
2 o — - — — - — — — - — — — — — — — —
A ]
- EAEEE
] ] |
[ i
| + f 24 CONT = 1 BfJE3)
| 8
| BAT
| _ SELFCOMP=0 .
| SELFCOMP=1 e e .
| \J
| 4
| EOEEH -
A
| P
IZE) 5
B U CGEZESE D)
————— 6
Else ik
N— —

MPTA IR C“2R”

AR (4 AN AGARN

“IEEEPJL” N “EEPJL ” “IEEf%Jt” L« E%.;.__’
” BRAD 1E” BR4b
| |
HUH fik
13 15

IEZEHIE IEZEfFIE

14

gk
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AS PP EE R HI T

16.2 1B 1717
g3
OO S o RS
100 B IR R R IR
O] R T SFC V5.x () OSL (ks
— Ny ¥ S o
— P
~ > R F SFC V5. [1 OSL [145 4.
—» FET IR R P £ B 5 A A R R, A SFC il
RIS .
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AS FIFERRHITT Y

15.2 1517175

15.2.5.5 iR (ORERERF OSL) K#/EREESE
/3%
IR > OSL 48 thil W42 F2 J7 Fy Ab B I 2
I RE 7 A E RS 12 8 il =27 OSL ARSI K] (1T 291) & X .
AR NFEFE P, SRR OSL TS SFC-OSL Bk, IXRINZIMFEFETIREA
7 7% SFC R4 . 11, SFC OSL IMRA I LU IEZEEI 5, TR OSL (1R
BRIEAT CHT MR P HAT B R R o Ry OSL ¥ ib#E %2 SFC OSL
[P . XK~ SFC OSL PRI H 255 il 7 OSL HPRASAZA. .
JGEFRF OSL HIRA
45 | RE & X
1 25 I IR SR B 4
2 AT TEH AL BR
3 I8 JIS P GBS SO S b i R
4 O SRR I A
5 ok SRR B 2
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AS PP EE R HI T

15.2 HTE 117

i Ay EEBeRE

(JiZEfERF OSL)

HF iR OSL [Hr 4 A SFC 12817 RGN il dr 2o

NERRR T AR QERS S HAPRE S

) AR A S EL R A o

W @ & X

B #5

X2 | R IR TR,
o RN R AT

24 |4t I DR,
B AT

42 |WOSTEAT R OEONETRE,
PRSI AT

a2 RS | EROEAETRE,
T SR AT

x5 |m LY E o IR,
LI R AT

X = "HEK A Z MRS

RURERA OR#ERFF OSL)

e MRS . BT ATIRES, H H AR ORI R A
SEEE, EJEEDle«{j(*f)Hﬁ%jj EIERIRE

EATIRES

AR, o r] DUEE A s i IR B A TR . AERXRME DL RIS e 4 i
RIMEAR s AR IXF A .
I TSR PR X
EEA
2/3 EIE K M2 R 7 R T 56 B
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AS PP EE IR LRI

15.2.5.6 JHEREF OSL KRS LE

JEHEFRF OSL KRS

15.2 1517175

JA 3l
5 FI_I”‘ 2 %1@ 4
el ) IEAEIZAT gree | OV
A T \
A
(RETID" V=]
3
CLE
-
B,
O FH T AT A 1 7T B (RS
—> B AR R i 4
—» SFC fiil % ka4

SIMATIC S7 ) SFC
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AS PP EE R HI T

15.3 11: AS 147 SFC

15.3

15.3.1

i

TARREE

SFC RA&ERKZ

292

7E AS H 47 SFC

4t ¥ SFC

MR T SFC AR AEA RS, FRE % SFC & JLANH ™ FUE XA 3l AF
IR FEFY o

WHE SFC 1 AR BRI ANAF 5 SFC IR KAAT SFC. 1ERHHEA BT
T TR ARG G, WRKE T Autostart =1, TFTH ) SFC B4 T MR AS
HCEAE BN IRAS . R R A B A0

o AR, A LURAMBE S NG S . AWIARIER AL S iiE SFC NRH]
IRV

o AR I R B A AR BT Pl R 2O, B 52 4 EEAE PRI
FEFF o

Wk SFCAREREA, WHATIHBN &AM CWAL, HALR ST S T A Ry
PGt F I RE . WERAFAE LA R B CiAL, (BRSSO R, W3k
G 4l s PRI A T B S MR A RE Y CRBITE R SCIIHATIR 0L o R B H AT A
B AE PR RS P S AR R TG A BRI R e AN R, 2 OB SR R 1y, JF HOR
BT IR Y o

RE R IR . (IR, RS A — S .
SR AT LI 9 LI B0 PP B RO PP AR T, s A TR 1L 5 50
FERUFR AL TR LR TR , HIS OESFEFR it 22— ELA RS

(EEIR MRS (BRI (BRI, TR, B GHED L s
s (4 SELFCOMP=0) F, & FIALLIUEAERY, IS fr &I H%RA N 1.
PR, A R 3026 P 2 LA (5 AL B 2, OGS TSP (%
Vo TR BLEHMIL, A LU — SRR 046 P IR (0 4 R 15
fo 0K S BORRRIF SRS INHL", JF HLUAT ST fr &5 4 20
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AS FIFERRHITT Y

SFC R&EEH

REZVI

SIMATIC S7 ) SFC

15.3 11 AS 11407 SFC

R SFC AR T, W SFC MR L 28 Az IR 2R B SSe b B S 1ir R AR Py s FA) IR 42
FEfF:

ORI IBAT O IEAE I, R s b S s sh IR R e (e T
RUNHOLD) Jf i gl I Mia A2 e o

WERSCHT MR CARBE e B, RSN IEAE MR B IEAE KR () " ia
1770 B RE P AR N IEAE R R RS P2 e RS AT 8l R 3l (T

RUNHOLD) , " IEAERE (i) PR IEZ G A3 .

WERAAERS ORI, WS AE 20— AN I EOIRAS IR e C 2 A 2 5 B 1My 28 1A T )
o WERBA PSS MIHERE R, WIS BT B U1 BR800 R R o

MFIE S, SMBEA R T SR APRE DI, WERSEHT S RE e M R A B 5 e,
W 2 37 R B ISR e O SR (K R Y o

o WUREHSFMUEREFE, WAEABMY BUG & L H S IEAEIEAT 20 . DU B IE ] T2k 4k
PATIZM FE P -

— WEORBEEHB M, WELH B B AT
— WERANH LR AT, WA I A B B R B P 2P T

o R LN, RO ARSI, R FHATATAOE . AR AN e
Bad 2 A LA IR e A BEEE A0
o UIfff SFC KW FahdrS, WrJLIfE SFC b B v, #lln, 7E“ SRS

N H A B AR IR 30 4 2100 A2 BOE AL R B A H RS TR I
FEFPI, )8 T IXA L.
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AS PP EE R HI T

15.3 11: AS 147 SFC

PHRNREERR A H AR5

T LA DA R8s R R P 10 3 s, 7 Ve 78 s F2 1 (1) 20 s vh e i —
AT IR 710 H b5 (i, <SFCName>.TARGETSEQ:=2;
<SFCName>.TARGETSTEP:=5) . XAH4 Tl alAn iRl m Fshic & Hhsb; A
i, IXRRE L XONLE TR A e sl (ST & ) gEr.
KEWRA, T LLBE I 45 52 22 E 2 R R e BT e R 4R 0

PATRRZIMEE, & E TARGETSEQ =0.

R, EIT P AR E bR .

Sl k% E <SFCName>.TARGETSEQ:=2 L) 2 <SFCName>.TARGETSTEP:=0,
PRG54 2 IR AT HAs 2

MR A BBk BTN, I H AR, RIS AT ER .

DA g 5 B AT A H bl — R E R T SFC AT 6 S, T LART DAZERE RS A h 2 if)
I S AN IS RE e A b Je — NG 1128 (1 l: <SFCName>.LASTSEQ:=3;
<SFCName>.LASTSTEP:=2) , VIRHE A WSS BB E AR Hirp.

FRA R S o 5 AT RN 1K G S RoR AR B 1" (Properties) XiEHES, FEATH T
AR HBRD,

#lE RS SIMATIC BATCH 5 SFC 2[RIt E
It SIMATIC BATCH IEAEAE I 3EAS SFC SEfl, Kk A UF b B
e SIMATIC BATCH # &%\ OCCUPIED = 1.
e SFC i & QOCCUPIED = 1 L J& BA_STATE [f) /i AR (35 24 f1) .

e it SFC =0 ¥ % OCCUPIED Fil QOCCUPIED #4781 AR K™ .
W SIMATIC BATCH ATl OCCUPIED, 444 ¥ &t QPARAM = 0. X Ik
H, AR BRI R BOEE, A BIRET% (LI_LERR = 0).

SIMATIC S7 fJ SFC
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AS PP EE IR LRI

15.3 11: AS 147 SFC

16.3.2  f£ CPU {#EME )3 543 SFC

JB BFAL

ENEIEIpT

SIMATIC S7 ) SFC

Y CPU ¥ 245 IEARASHT,  IEAEISAT ISR P oo 1k T YRk B 2P . #)5 CPU

B, Ssia SFC, T HAF Ik R AR A 8 s 20k SFC M@ 1A BRUVIRES .

WA B AE CPU H g I SFC fRFEFIDIRAS, WIFRZAH N8 AS 12T 250 BAE
(“KE3R"(Chart) >“/B " (Properties) >i£TiF: “AS i24T75%("(AS Operating Parameters)

>“‘CPU EJ3 583} SFC"(SFC Startup after CPU Restart) >i%£Ti: “f&fF SFC R

Z(Retain SFC state)) .

EeAE AT LARYE SFC A AR Y SFC M A 4k 84T, W RETT 22 H sh A1)

FIFHhA.

FAEE B ZE L CPU & 7EHu A B W) A J& A B8 i 150 1o S 5 — PG

O, MBI A B &5 R W ST LT PR

EOR: SFC AT MRES, BB AR 2 WMRAS N A s R .

CPU eSS MR IE CHOBA—E0
4 g3
534 SFC fkUEAN TR BAE IR, AT BT AT TR B I 1.

CPU AFESALHH ] (5 11 (Bl —F0

4 igs

Wistr SFC ZREL4b T M1k
Sl SFC #/i OSL Hik

fE ik SFC f&/it OSL {1k

ANEA 2 BAPIRS IR A SCVFRA T W IIBAT A%, 10 Hh k" i & At b i & AR HE AT
# SFC OSL (T 280) MPHRZAAALI; A AT -

FEPAT IR — A4 (kEastr. by ik 800 281, S —HERRSH S, IR
H"CPU_RESTART #iith

|

"

G
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AS PP EE R HI T

15.3 11: AS 147 SFC

AIERX NAE CPU 5 fE $AT I RE - 169 )3 8h 4 2F4d ] TRIG_CPU_RESTART #iit! .
e At RSV TCE, 1 L A0E N CHSKEREM T AL (W, ek
TRIG_CPU_RESTART=0) .

VL
CPU /)5, A4F ENRESUME. ENABORT. ENSTOP F1 ENRESET #i A $4c4H "Ik
PR Y N L N & | =X (VAN

AT B
FEMNABIR, oA AR IR i CPU 5 1LIf2P L& CPU HE S 120

CPU f21I- @
B —3%) CPU 5 Fil SFC 113
BiE A —5 ) CPU &3 fl SFC K

“Hdfs — B0 CPU HJF M SFCAF 5 KL Hidls A — 2 CPU R Al SFCFF 5 2 o
FERAT L PEHIA o 0 o

P2

EZ P

ARETEREZHEL, HS LR
R HPRAS (W 820)

FEMARIC T W (0T 316)

SIMATIC S7 [t SFC
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AS TP HEH R AR T
15.3 11 AS 114t # SFC

16.3.3 W%

fai g
X BB A a2, Tl B A& 5 T B3 B ar S A BT A A

AT FhmEfame
T AT, WTLE SFC MIAR Fak SFC Tﬁ%*ﬁiﬁﬁﬁ'd’lﬁi T A 2 B B B
EEERAERE (TLAE FIi“SFC T3 &A% th Hk BIH (5 B P (BAY Sk

A RHE T HOR T AR i S AERE“EN..... 7

AT B3 = fa<

AT, WG AEEN...”, W) ESEEk &R L2 ashisfleg, HHR
MM N“START, ...." K H 4

TR w4

RGP A AR W f, LB “LOCKCOMPLETE, ...." SN, & H HA Ay
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WIRTE <setpoint>_Q #i it I (QCS = QCSP, "sw"_Q ="sw"_QP).

SIMATIC S7 ) SFC
308 TR FIHRAVET N, 03/2009, ASE02113388-01



AS PP EE IR LRI

WE

SIMATIC S7 ) SFC

15.4 T T HIRME B GE (H

2. Eihe s, FFHESLEIMAIXSE R
XAHHLHIASRE T T 50 ez i s
fEEERT, 1T YD BRIEAT Al

0P TAKESP S A/, O I FROE (IO <BOE(> IRETL, 6 LBR
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16.4 #E1FIRE K bR
e R 4 X
3 ek fEerh 16 4 AT I A B
= Bk U A0 L5 s S S A R B 4
- BAT 45 A TE AR B IRAS T [ A B 5 HEAT 1) b
i,
1 BEE “E%@”#‘(*TE’JEX?%’&L@E%EE: AR S 4k
EPJJ: —JZA {’?JJ: [i]5) 7
L EELYC HUVR A e, B U R e R, AR
CHUED “deg . e
il A L5 i A S AT IR AL
i EAESER AT SE A 4 i
W o 58 B HEAT I A B8
v TSER SEFESERRORA IR Cse ik, IEESS45
YA = P KNI B s A T o0
25 HIHEIRZS FIOALEL,  TF AR5 A5 1 3 i &
B i PATHE 152 i & TS HEAT TR AL B
B 4 LETEAESE I IR A F AT fr & TS AT 1 A
CGEAESERD H,
=S IEAE AT i & Ak B0 1 37 TS AT I AL FL
L. R PAT fir A B B0 St 5 5 HEAT [ 40 B
CHUED
= ERAl “TEAEEE R A F AL EL EL 58 1 AR 1
By EATE A
[> EAEE 3 AT A A 3 BT S AT M AL HE
o At R AT 1 i A JE AT AL EL
U LR B SR () B VR A5 A3 T s A
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W R M 1) RS

16.5 J il )26 19 1% 11

16.5 WA FAE 2 1B T

“JE P UEAE R TR
S JE T (Properties) XTGHEML S 7 N ET4 -

322

“H#"(General) T &
“ZFR"(Name) AR AU St T 28 BPIRAS HANWTE 3. I th B e #8511
ERNEY (0T 73)FAs
WA A" (Confirmation) SEHE, A4 THOETE T /T Al C MR (st i
WP R e PG IAR L. HAT/E SFC BB S, T 6 R 4217
¥
— XA TN (Confirmation) 3EI7 125 K F T FEBRE
BEA T\ (Confirmation) eI K25 )4 — A58 UK 5 S R B0 T R — P i e o
BAERTI O RFT™D .
— XFHFRIL (Confirmation) 3371 20K F # 4k R HIB
A “i A" (Confirmation) LI AGHOT AL N ELI, RGBS BAR SO T — A,
SRJG AR PAT IR (AR TT 5 0™
WA H AP (Target step) SLIEHE, WIoHs T2 ik HARA (FEMUEFR T il
o PSR D . REER SFC I SFC LB ML I, RA IR
s T RS T AR K.
BE AR R
= NP E AR ORISR, e ITEE H AP R i A R IR P R )
— WA B AL S AR AT I, DRI R A H AR ARSI
H AP bid (O Ja S s gk 4 dn 2. i sedr S PAT I B CPU FS I, Bk H
bR hRIC .
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Wi AT O P RS
16.5 Jid A1) 25 119 1 1

ATLAREPES MRy FRRAE . P ST LI 407 S o, T A B BELJE R
W5F.  SUCATISCHL A B, 120 R SFC (51 292)

e

WL R

o S GE FRREE", TSR H AU A SRR A

o IHEFEDBR, LM T R R I bR

o HEEMEE T ENTARGETSTEP =1 WA R Rtk B8R H AR .

TESAT I )" (Run times) X, wJ B SFC B4R 11 e/ ME” (Minimum) Fl“f K
fH"(Maximum) 24, W PGgAERHE, WIS 54T TF— S RHEHE, AT 7ESL 4 A8 1
fiE] . i e (OK) J&, BT s A2 ES AR #d, 76 AS [ F— M4k
JAMAERL

AL 4R {E”(Current) . “f /M (Minimum) F1 5 AR (Maximum) HE S iz 47 i
[A]

WRBA N IBATIN AL AR R = 0D, IAHEI &Rt - -7
“VERE”(Comment) HEHUIE B 2D HIVERE .

ZEH S 7 (Acknowledgement information) HEFR, 1] DL A BAE D KR E A AL
(TIT 5 O) "BLF LME R J7 X B n 25454 U SUA

A5 B AN T BiAE SFC AT AL H BLAEAR N (A% L o SO B T
MR fEEAE, HEE 5088 S R R EROIR S .

o “WIHHik (Initialization). “4bF”"(Processing). “# iE"(Termination) #EIf &
FEEEIT E M hk (HE s B Rk BT E . A 0T A AN bk P E H A T R )
AME AT SFC B Wl s seHE, K47 JF“ 8 20{E”(Change Value) 1%
HE, AR TR
KHIRHEHE S, ESUES N ES HIREH (& CPU) W, JEAE FANCFE I A%

o R‘OS IR (Wisi) . (bED . (#b)

FERXESL K P BRI AP . H SRR I
e’ (Initialization). “4tFE"(Processing) AI*#¢ 11:"(Termination) JEI K HOFE & - FLIE
. MR BRTALA OS VERE. FIAT LS A5 .
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W R M 1) RS
16.5 J il )26 19 1% 11

sl
B S T P R A T A i EL oz A7 i e i (B e momte
B ] - T s e e

i
RGBT AR, A0S RIG, PRR IR DO AERTRRES (e 30 = "4
=PI

A LMEH SFC B i Bk 21" (Go To) #4124 i b AE Bk S 2 LA o5, flan. BkEe 3
CFC K £ Heal k¥4 3] HW Config #1f) 1/0 Huht CRIEH T SFC 261D .
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Wi AT O P RS
16.6 JiA K F B9 15 11

16.6  WRIHRIEBKE

“J& "X UEHE AR T R
HR 1) @ Ik (Properties) i i HE AL PYANE I«

o “General’(##1)
“ZFR"(Name) HEHTATIHE, LU SHR PRSI, IF HEOLEARRE B .
A B AR5 T BRIAETE (T 73)#% A&

o “YAFPRZE"(Current Cond.)

[ T USRI N

® “OS i:#"(0OS Comment)
ZIEI R s YR E AR E IRES, WS EPIRA"(Current Cond.) & IR s
Ak 5 4R (Current Cond.) IR AN ] 2 Ak 2 A9 5 OS VER #1141
Tl &AEA . BT LT TEAE B

e “|F—ijRZ&"(Last Cond.)
IR TR B R T — A A 3 A A R

o “HiEIIRZ"(Cond. after Error)
IR R s PR A A EPIRAS

A HLhE 24 B ROHE S A T 28— AN MU bk (9 223 R0 28 — ANk 4id . 78 SFC B,
A LA X A HEI N 2 ORSE R T SFC SE6) o s e Heorp—ANHE,  JURKR T T80
MfE"(Change Value) XEHE, 7EILH 4 A ST hb{E .

KUDAGHESS, SESUES AN ES Bl B (& CPUD v, JFAE FAMEH AL .
FA AT /R E AR I8 S 45 R AAS R 40 R R (0 R 2 R

o IR IE R IR AL

LIRS & N ST

o AR RS
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W R M 1) RS

16.6 Qi A1 Fe £ 1 1% 11

“E—RFA AR KRR R

XL IR ) A ANRE A BB DI EATHE N 88 (Update) #4H.  EILA A A2 1)
R, RSN Z B ST I PRSI . 8 o 508" (Update),  mIEK AFTITIY
XPTEHER R A EPRAS . (AN REEE .

%4
DR MR RE e vh 0 7s 3 AL S (4R B deos, JF BAE RS 55 o a“;‘?’fﬂ, UIpoRF
HE PS5 ﬂ o IXPEREAE AT AR IZA A Ao A1 B3 P os HEAT RN
A LAER] SFC BB 21"(Go To) #2l A\  Airt HEME R, B AL 0, it Bl 21
CFC IR Pealib¥: 2 HW Config i) I/O Ml (AEHIT SFC 524D .
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Wi AT O P RS

16.7 I il A Wi FE 7211 5

16.7 WA RE 8

“J& "X UEHE AR T R
IG5 A 1R 8 1k (Properties) G iEHEAL & 7 kI

SIMATIC S7 ) SFC

“General”"(# #)
“HHR(Name) HEMF AT IUME, JLEUE 58 FPIRASANT N, I LA R E .
A L ER A T BRAETE (L 73) k% .

R (Comment) HE i 7 by G RA R 20 25 RV RS

FE G2 (Priority) HEFR AT LUE SR RE P IIUL G 22 AR P[] I 5 A2 ) 21
FATI, ARG g R AW — R 5l

“fa 544" (Start Condition)

FATARE — AN B T LM 16 45t b 2 4145 5 N 4PRES— AN 0T
by A 2 4185 3 AR AN e w] DU R s s — AN AL Sk
BB — AN .

HE AT I =2 R RO 7 306 T 28— AN bk Y 2 a0 R 8 ANl L. KAl SFC
KR A OX 2811

“OS R (B3h%&H:) "(0OS Comments (Start Condition))
5*JH 31" (Start Condition) LI KA A ) 2 4b 2 b ab ] OS RSB T A H A
AR P s AR B IIAH TR

“¥ii sb B (Preprocessing)
I TP A S A B (O PAL BB . AT SFC B R B MU 261y .

—ATRE—AER . WP ik 50 4N AR AT DUBEE B FA I R s 4%
IR

5 4 A — A . — B SRR A AT

AT LI 2 (RO 7 3 A T 28— AN bk 8 230 A5 AN A . 2R el
—/MHE, UK S (B (Change Value) X GHE, 7EH I A B bk . OCH]
XRHESS, SRR SN CPU JFE T IME BRI ER . [, A7 bk P iR
HAE5 N ES BT,

“OS R (Fikk#E) "(0OS Comments (Preprocessing))
5*JH 341" (Start Condition) LI R IA R 2 4b 2 b ab ] OS HERFIFR T &H A
WA, B FeE TS RIS A .
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W R M 1) RS
16.7 Jid Al Wi FE 721 5

o “JG4bFE"(Postprocessing)
kIR AL S AT R 05 A B R . HT o SFC RS U el . kIR
[ 45 7 5 “TRAL HE” (Preprocessing) 3£ -RAH A (S AR

e “OSHE (Bah%&) "(OS Comments (Start Condition))

5*JA 8l 411 (Start Condition) ZEI-RAH S, tEZEI-RH] OS iR A T & 2L
KIS, P E VRS B
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171 1w SFC

734
SFC IR/ SRR LR A 2%
o KRR SFC 4T BNt
o YN
o JEk
o RS HEHE

F& %€ T A7 JR)
WA, L LU A A S

1. PR a4 SFC > H & E..."(Page Setup...).
KT I —AKHEHE

2. fE N AIRAEPIERE IS S0 (e “A4”L A4 A TELEE") .

PHILAT BN

1. P4 SFC >“FTENF . .."(Print Preview...)
0 L S s T BN DT

2. KA e
MBI AT S FT B4

SIMATIC S7 1] SFC
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1RFESF

17.1 id# SFC

#TED SFC

1. B T HES Bl bRk
EPR i 4 SFC >“4TEN..."(Print...).
FEFTTF—AKGHE o

2. fEIL, WHHTENEERAG R AT B
ITEIN 2
- @k
- H A
— ML (SFC ¥R skt (SFC 2RI/
SRR 2
- &tk
- IEH KA
— B GERIER RN B, EAT AL .
- DIFRE AT
B U IEH RN
— EFEI SIS TF
— WERESCR
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IARFEST

17.2 #7108

17.2 KRS HEdE

BN AR

BR5| H

SIMATIC S7 ) SFC

1. P A A% IR (Options) >“Bl#% 5] FH%435...”(Chart Reference Data...)
st L25] g p
BT TR 51 A Je— A28 1.

2. 7ELET (View) S, ERAASE BRI B I H R B T A A Y. B A
BT IS 5 B 5% .

WERAREAE SFC R ARSERAT AR, R CHIER S I B & 1. #£ SFC A 4kEes A1
Al o] A R AR

A AT R S 5 ] A -

— g

“IBATIFF"(Run Sequence)

K BTR N CPU [HIEANIEAT T o

“2% X 5| H El# 7T & (Cross-References Chart Element) ->“H#ihi-"(Address)
AN R IUH BT T B A 35 ikl vy T X 2e bk e 3R

“A¢ X 5| ] SFC”(Cross-References SFC) -“E %t %&"(Chart Element)

AR Wonn] N SFC EIEXT CFC B To 3 (M A\ i i HEAT IR TG B U )

“ X 5| FEIF 6 & " (Cross-References Chart Element) >“iz4741”(Runtime Group)
ZHNR Eox CFC Fl SFC B2 5| FlIg AT 4l i s

“Hi 5 3%”(Block Interconnections)

AR SR I H i T P E

“SFC K& 1135 H]”(Accesses in SFC Types)

%FER Won SFC RN A RS i ).

“HeJs 7" (Block Types)

AR s BT A F I B AR P EREAL ¥ i (CFC BIER)

“S7 R EALE"(S7 Resource Allocation)

ZHNFK s CFC AN G ST BHY Z A ELE .

“AHF 5" (Local Data)

ZAN K LR FEP TS OB FIiE A AR LR, DA 25 2R AL A RN AR 2 SRR A7 AE TR 2%
ARG A B KN
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1RFESF

17.2 #7108

“Heifl il 24" (Block Call Hierarchy)
R B TR A B T E

“XC A H %" (Textual Interconnections)
YR R H A R AR R B R TC R A SO HIE (B EE HAR #4251

D

“Gi i+ B”(Statistics)

ZER SR FTHE I CFC I SFC X4 e S7 WIRIIA R, 4w R I i T B AN 300 H (13
FExt %o

A RIVR A TEANHGR R 5 K55 3, W] 2% CFC FE4ea B B 5| -8 h X
s B G B oy

FH

W P 4 45| I B3R (Reference Data) >*“fll# 5 i 30 f4..."(Create Export
File...), PI¥AERSIR 53474 CSV MMt (filan: Al ] Microsoft EXCEL 7
) .

SIMATIC S7 {1 SFC
332 i AR5 T, 03/2009, ASE02113388-01



IARFEST

173 HE
BRAFAHTENH &

SIMATIC S7 ) SFC

17.3 Hi&

KHL 2 T (Options) >*H i&..."(Logs... )T T MXFEHE, @i 2 gk, K
ATAE LRI 8 AT IS AN B D0, TR A W] ]

X H SR ORAFRIET BD AR 28 5 24T T (KRB TR AR O

“41%"(Compile) &I &

S B IR RN FIER (R TERD + Bln, T AL SRR H AN Bl (R 1
Wo WHESE: “ESFEFARSEY PRI CPU. "(The program is not assigned to an
actual CPU.)

“Ky 25— 31" (Check Consistency) 3£
A A — R A ) I 9 B AR

“F#"(Download) &3
NI AR, B, N WESER]: “RIL 0 MR, 0 MEETO
errors and 0 warnings found).

“ES H#&"(ES Log) £ &
A SR ERAER H S CREG MNABIAD o i BRAE SR 223 SIMATIC ¥ Iy

“4 kb #”(Step Processing) &3 &

I FH 2 iy A “1E T (Options) >“K 2525 b 3" (Check Step Processing) 7 SFC 21717
N HIETRFRE A AR R0 GO R RN — 20 (AT 4 e 5 Ak B 48 44w ek ) — b
BkiE . HEWEROKET 204 SFC B, RINZ DAV M ICHE L KIS RETH
KAL) SFC KI5

“BEH(Convert Format) £ F

¥ BRI IH AR 2] VB SRR TS , AT H & AR IR ok () B e e b b o o )
an, XL ERAAFELE IH A BA &M HE %" (scan rate) 1“4 %% " (phase offset)
(f) SFC . IXELfE HALFRIEA S (FE55) FIREASSZ 5200 (1) &1 22 3133 S FIAT T (i 7
PIE -

Sefil: “SFCA: T4 OB32 H4ili & 4 M hifs 2

“BEAT A H %" (Make Textual Interconnections) 35+

SE LA A TR (Options) >“B#4T 3 A H 3% (Make Textual Interconnections) 1142 il 24 i
B e CV L TR HOEAK PRI T SCAR B3 . SR IR iR AR R SO B3 2%
VRN B — R 2R, $8H i TR R PR AN e AR O SCAR % .
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1RFESF

17.4 &= X W

17.4 & TR

ik

8 TR

PRI ) SR B

334

i SFC >*TUM..."(Footers...) S HL A &R FT T AXTUHE, R 7RO TR AE g A\ 2R AE
ANITENTT I SO s R SOA

ff/l DOCPRO Ik At vy AT Bt A7 GBI ESd 19 SFC BRI . X 10, 42 Ja 8k
SR e HdE R AAR.

Al {# ] DOCPRO £k SIMATIC Manager 43l H i A\ 42 st s s e Hdfs 25 ] SFC
SR asi N . TEERD RPE B SRk SFC A R BRI .

R A5 2% DOCPRO B IR - o e i Nk e ot . T Se ORI sesidls, 72
DOCPRO wJ H F4T Bk 2 Jim 4T B L8 55 .

FIAEBOE IR IR 25 1 2" (Part 1) 2“4 4 #7)"(Part 4) DLW 15K (Available Fields)
T A SFC g (1 U . DU A SRS G HE. SO S . S H IR
H HISCA

AR R DU P R AN OGHE 7, XL SCHE FoREAE ST BVt I T T SO . U Py
LIPS S E S

K RS X DOCPRO
A
$SCNS$S 2% (Name) 5575 J@ 1t v 1 A4 FR A ] $54
$$CC3$ 1B (Comment) S @R N R SCAA | $60
[ o
$SASS 1% (Author) ST @ T rh i N A4 FRAR T $55
$SDCS$ Gl H Y (Date 575 @ 1 v A H AR TR $56
created)
$SDMS$S$ BB a] (Last | 5576 @ 1 i A H AR T . $57
modified)

SIMATIC S7 [ SFC
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1 RFESF

17.4 ;& XTI
K< KR5 HX DOCPRO
iz
$SCHSS Thi H 415 526 J@VE P N 1 s A2 A )
$SPPSS$ T H A7t & TH BB, e RPN
AT o
{fiF) DOCPRO {5

SIMATIC S7 ) SFC

WA H] DOCPRO V5.1 Glgd# i H, n Ff DOCPRO i SO IXEMAE A
WAE SFC BT A A KRB 7 ABANSCRAZARAE . AERARTIR H A5 i A S8 7

iR

WARATEN SFC i il 7508 I e & (. STL Bk DOCPRO H %) , WITEN%m
i ORI B A S AN OBARSCA . i Af /1] DOCPRO X5, L3k fi) s
AL

1 /§ DOCPRO ftfigist, 45 8 %t DOCPRO FRAEAT J&y. AT LLZE“IE 2 A Jsi”(Modify
Layout) X TFHE & TR HBOA U . HI5R(E B, 7122 DOCPRO 743 Bk

(DOCPRO Tfiff: KIEFRUESIEESCRY) (DOCPRO manual: Creating Documentation in
Conformance with Standards) .

H P 0 i A R I A ) S B A XK DOCPRO AR (RS IR I 8
950 s D AR ST HTIX P A KB 7
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1RFESF

17.4 &= X W
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A& R 1 8

=

18.1 SH

S H=

PRI 52 RIS R GEAN, e T IR E i R A S 8. S Has e AR S5
(RIMEE ZR G o

XA B SRR IR (e B T YmvEn . BT RAA L T SR — N
4, W, “RecParDB”.

P B B ) AR e A AL A W) 3 BE 45 B A F S AL K 2 B B fe

ARSHPERINEZER, HS%
T Z5ia AT A 40 (W 338)

AR ZH E RIIAT I OO (00 340)
W Bs P (U1 342)

SIMATIC S7 1] SFC
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HESHE
18.2 WA T 24

18.2 I HSEBIT RS

WK

ATLMEH SFC iR s A HIEHINIZIT RSt BAE SRR KRG M &L 1
“N % & PE"(Object Properties) X uliEH, KEHC 77 Edin B i BUE 7 g 254 F sh ik 1 2
.

£ HEP
1E )0 % & 1" (Object Properties) XFi&AEH, K Bl /7 Zdk e (71 342)“RecParDB” ) T
TR AN BIEA A B (52D

ctrlir_1.w := "RecParDB".etmp

ctrlir_4.w := "RecParDB".itmp

2. HEER
TEHFE 1N % JE £ (Object Properties) X HEH, # AL 7 2548 & BHAT HIIEFE 5 7
(I R«

ﬁ ™
E:jTZ E:jTB E:jT4

S2 S3 S4

iTS i]TG iT7

[
S5

=—

L]

et AT Hodh

SIMATIC S7 ) SFC
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18.2 U&7 24

T

T2 T4 "RezParDB".altzwg =1
T3 At "RezParDB".altzwg =2
T4 TP 44T "RezParDB".altzwg =3

SIMATIC S7 1] SFC
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HEZHIEH
18.3 NAZH B NIAAT I

18.3 AFSE & B RIPRATE R

7£ OS E#ATH3)
R T Oy BRI A g, s e T LA A R S 8dEkIe T, fE OS BRI
ZH

Sl

IR S 2 T AT AR S SO B B R R LR AN R

o ] LCRFAC s Bt bR A B AT B R AL AT OS M RE M, ARG AR B 24
HIZ HTAE OS _Efi € AR 1 i A -

o {E AS AHES RIS, BT 5 O8O BN, W B P 7y 250
SR IEFETE A ] U B IR S

1

S1

4
?_
4

Par1 Par2 Par3

U
L
1

S5

o

Ae R A A RIAGE R R C 5 Kot 1R A

SIMATIC S7 1) SFC

340 g R AERAE T, 03/2009, ASE02113388-01



BEBIAH

NUISE

18.3 A Z 4 EHIATT I

Par1 1[5 1]

"RezParDB".chbez

"RezParDB1".chbez

"RezParDB".ansmng

"RezParDB1".ansmng

Par2 " ik

"RezParDB".chbez

"RezParDB2".chbez

"RezParDB".ansmng

"RezParDB2".ansmng

Par3 i B

"RezParDB".chbez

"RezParDB3".chbez

"RezParDB".ansmng

"RezParDB3".ansmng

o 7t OS fimfit, CafE 7 AMESrR EHLR D B, S

HIAIER R, A8 SOE 77 #s B RecParDB i 1 S 4 2 5 Rt A = AH VT ..

Ll

ANW

—
=

—
m—

e A i

A WaEA B, AU

WUISE

ANW H g 5 1

ANW.EN

SIMATIC S7 ) SFC
g FERIHEEVETIE, 03/2009, ASE02113388-01
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18.4 F 1 5 e s

18.4 He 7 B B sL

fic 5 H“RecParDB”

Fert b5 —“RecParDB At J5 B 5241

BRI RE fEL K5
STRUCT
Bantam STRINGI[8] 'ch_4711" Az = 24
vol INT 2000 AT
reapr INT 3 SNVHER ), H47 bar
etmp INT 90 HMERIRSE, A7 deg. C
itmp INT 125 WL, 147 deg. C
tott INT 110 o SN ], B D gy
stvol INT 1000 PR, AR AT
altseq INT 3 RN
END_STRUCT

342
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RRETT 1 9

19.1 HA& SFCAA

£5%
A LAEH] SFC AT R 4TS -
o 4IA)g SFC EIFRIHH
il
* {EAZMLARZGHMAE L E SFC K%

HEREK SFC BREH

1%/ 57 UfE SFC Wi R 4 &2 2 SFC KR (“SFC Coord” K& ¥ 14F“SFC
Slave1”f1“SFC Slave2”) :

o AT —HHIH— R (/1] SFC Slave1 W3] SFC Coord; Ell: 41 SFC
Slave1 {/5%kiz47, W SFC Coord 43245 SFC Slave1 4 11) .
FEAZFERS 1) 8 1" (Properties) X% HE Fp iy N 46 1F
SFC Slave1.BUSY = OFF

o ZIAWE SFC Slavel [t
ez JEYE" (Properties) XTUEAHERH, T “WI4aiL”(Initialization) &I~ N A5 H) -
SFC Slave1.INTONOFF := ON

o Y& LERINEER (ffi] SFC Slave! 11 SFC Coord, Bl SFC Coord 4454
SFC Slave1 #&11) .
TEIZIEF 10 )& 1 (Properties) W HAE F i A 5644
SFC Slave1.BUSY = OFF

SFC Slave2 Bi7EH15Z SFC Coord # i,
JeFEXT SFC Slave1 f11 SFC Slave2 #ATHIRA A .

il SFC EBl*

i JI7E SFC Chart1 CLHiiff)) HBCE KR HIC Cnfifftds, Bdloott) vl
% 1 SFC K3 (SFC Chart1 fil SFC Chart2) , {7t SFC Chart2 Helg bz ACUS R
—F B .
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1ENG 1T

19.2 #H/HIH

19.2 ¥ IHE

fEF BT SFC BT R%

SFC 45k

PENT UM SFC 84T RAMBTINAEZ BT, HCHRAE 2o S IRA T F 07750 i I
Wi, Jf LAERPASEARIE B4k FB 300 SFC i517 K%

P I B A e S N s A

1. PSR4 SFC >“4ii%...”(Compile...).
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